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About This Guide

The Micro Focus Vibe 4 Installation Guide covers the installation and configuration of Micro Focus
Vibe. The guide is divided into the following sections:

¢ Partl, “What Is Micro Focus Vibe?,” on page 13

¢ Part I, “System Requirements and Support,” on page 21

+ Part lll, “Basic Installation,” on page 33

+ Part IV, “Advanced Installation and Reconfiguration,” on page 93
¢ PartV, “Multi-Server Configurations and Clustering,” on page 127
+ Part VI, “Upgrade,” on page 169

+ Part VII, “Migrate,” on page 207

¢ Part VIII, “Appendixes,” on page 219

Audience

This guide is intended for Micro Focus Vibe administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the comment on this topic feature at the bottom of each page
of the online documentation.

Documentation Updates

For the most recent version of this manual, visit the Micro Focus Vibe 4 Documentation website
(http://www.novell.com/documentation/vibe4).

Additional Documentation

You can find more information in the Micro Focus Vibe documentation, which is accessible from the
Micro Focus Vibe 4 Documentation website (http://www.novell.com/documentation/vibe4).

To access the Micro Focus Vibe User Guide from within Vibe, click the Settings icon, then click Help.

About This Guide 11
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What Is Micro Focus Vibe?

Micro Focus Vibe is an enterprise collaboration tool designed to increase individual productivity,
team effectiveness, and organizational success by providing the right set of tools to the right people.

¢ Chapter 1, “Vibe Capabilities,” on page 15
¢ Chapter 2, “Vibe Components,” on page 17
¢ Chapter 3, “Vibe Configurations,” on page 19

What Is Micro Focus Vibe? 13
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Vibe Capabilities

Micro Focus Vibe users fall into three basic groups:

Content Consumers

Content consumers use Micro Focus Vibe to work with important information that pertains to them.
Content consumers:

+ Maintain their personal workspaces, including setting up a personal Blog, Calendar, Files,
Guestbook, Photo Album, and Tasks folder

+ Participate in team workspaces set up for content providers, in order to better collaborate with
colleagues and facilitate their work assignments

+ Search the Vibe site for people, places, and other information that pertains to their personal
work assignments

+ |dentify subject-matter experts to assist them in their personal work assignments

The typical tasks performed by content consumers are covered in the Micro Focus Vibe 4.0.5 User
Guide.

In many cases, content consumers quickly become content providers.

Content Providers

Content providers use Micro Focus Vibe to create and manage teams, customize the Vibe
environment, and import data into the Vibe site for use by other Vibe users. Content providers:
¢ Create and manage team workspaces and folders
+ Control user access to their team workspaces

¢ Establish unique branding for workspaces and folders to clearly differentiate them from other
places on the Vibe site

¢ Create landing pages for workspaces that consolidate the most necessary workspace
information into a single page

+ Customize data entry forms for gathering information from users

+ Create workflows to automate otherwise time-consuming manual processes

The typical tasks performed by content providers are covered in the Micro Focus Vibe 4.0.5 User
Guide.

Administrators

A Micro Focus Vibe administrator is responsible for installing the Vibe software and setting up the
Vibe site. This Micro Focus Vibe Installation Guide provides instructions for Vibe software
installation. After installation, the Vibe site administrator can:

+ Set up user access to the Vibe site

Vibe Capabilities 15


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo

16

*

*

Create initial workspaces and populate them with information that is of interest to Vibe users
Control user access to workspaces and folders

Configure email integration, so that Vibe users can receive notifications of updated information
on the Vibe site and post to the Vibe site by using email messages

Set up mirrored folders to make large sets of data that are already available on disk more easily
available through the Vibe site

Set up software extensions (add-ons) that enhance the power and usefulness of the Vibe site

Set up remote applications that deliver data from a remote location, such as a remote database,
for easy access on your Vibe site

Manage users, workspaces, and folders as the Vibe site grows and evolves

Perform regular backups to safeguard the data stored in the Vibe site

The typical tasks performed by Vibe site administrators are covered in the Micro Focus Vibe 4.0.5
Administration Guide.

Vibe Capabilities
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Vibe Components

A Micro Focus Vibe site consists of four major components:

Vibe Software

The Vibe software is a customized version of Apache Tomcat. This software provides the web-based
functionality you use as you access the Vibe site through your web browser.

Vibe Database
The Vibe database is used for storing the following information about the Vibe site and its users:

+ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

+ |dentification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

+ User profile information (for example, full name, phone number, and email address)

The Vibe database disk space requirements are relatively modest, because the database is not used
for storing files.

Vibe File Repository

The Vibe file repository holds all files that are imported into Vibe, information related to the
imported files (such as thumbnails and HTML renderings), and the search engine index.

The Vibe file repository disk space requirements depend on the size of the Vibe site. For a large Vibe
site, disk space requirements can be substantial.

Lucene Index

The Lucene Index Server is a high-performance Java search engine. The Lucene index contains
pointers to the actual data stored in the Vibe file repository. The index enables the Lucene search
engine to perform very fast searches through large quantities of Vibe data.

Vibe Components 17
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Vibe Configurations

You can configure Micro Focus Vibe to run on a single server or multiple servers, depending on the
size and needs of your Vibe site.

Configuration

Description

Single Server

Remote Database
Server

Remote Lucene Index
Server

Multiple Vibe Servers

Multiple Remote
Lucene Servers

Multiple Remote
Database Servers

By default, the Vibe Installation program installs all Vibe components on the same
server.

For better performance and scalability, you can install the Vibe database on a remote
server.

For better performance and scalability, you can install the Lucene index on a remote
server.

By running Micro Focus Vibe on multiple servers, you can achieve high availability,
including failover and load balancing, depending on how you configure your servers.

Your Micro Focus Vibe site depends on the Lucene Index Server for full functionality.
Running multiple Lucene Index Servers provides high availability, so that if one
Lucene Index Server goes down, Vibe users can still access the Vibe site because
other Lucene Index Servers are still available.

Each of the three databases supported by Vibe has its own approach to clustering
the database server. Information about clustering database servers is available on
the Internet.

For more information about which configuration type will best achieve the needs of your

organization, see .

For more information about how to set up these configurations, see Part V, “Multi-Server
Configurations and Clustering,” on page 127.

Vibe Configurations
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I I System Requirements and Support

+ Chapter 4, “Vibe System Requirements,” on page 23
¢ Chapter 5, “Vibe User Platform Support,” on page 27

¢ Chapter 6, “Environment Support,” on page 31

System Requirements and Support 21
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Vibe System Requirements

You, as a Micro Focus Vibe site administrator, must ensure that your system meets Vibe system
requirements, so that your Vibe site can be set up successfully. After your Vibe site is set up, you
must ensure that users’ browsers and office applications meet Vibe user requirements, so that users
can access the Vibe site successfully.

+ “Server Hardware Requirements” on page 23

+ “Server Operating System Requirements” on page 23

+ “Database Server Requirements” on page 24

+ “Directory Service Requirements” on page 25

+ “Disk Space Requirements” on page 25

+ “Other Requirements” on page 26

Server Hardware Requirements

Your server hardware must meet the following requirements:

Item Requirement

Processor ¢ x64
¢ Minimum 2 GHz
¢ Multi-CPU systems preferred

Server Memory ¢ Atleast 4 GB RAM

See and.

Server Operating System Requirements

Your server must have one of the following operating systems installed and running.

Platform  Requirement

Linux ¢ Micro Focus Open Enterprise Server 2018, plus the latest Support Pack Recommended

# SUSE Linux Enterprise Server (SLES) 15, plus the latest Support Pack and
with TK-32bit and TCL-32bit packages installed.

# SUSE Linux Enterprise Server (SLES) 12 SP3 with latest kernel Supported

NOTE: On SLES, the X Window System is required by the GUI Vibe installation program. However,
it is not required for running Vibe after installation, or for text-based or silent installations.

Vibe System Requirements 23
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Platform  Requirement

Windows * Windows 2016, plus the latest Support Pack Recommended

+ Windows Server 2008 R2 SP1 (Hyper-V, Standard, Enterprise, Datacenter) Supported
¢ Windows Server 2012 R2 (Hyper-V, Enterprise, Datacenter)

See “Virtualization Support” on page 31 for information about support for running Vibe in a
virtualized environment.

Database Server Requirements

The Vibe server must have access to a database server listed below.

IMPORTANT: The database server must be online and accessible before you begin the Vibe
installation process.

Platform Requirement

SuSE Linux ¢ MariaDB 10 - server and client Recommended
¢ MySQL 5.5.3 or later - server and client

NOTE: MySQL 8 and later has password complexity enabled by default,
which Vibe doesn’t support. For help disabling password complexity and
setting a non-complex password, see .

¢ Oracle 12c

¢ PostgreSQL 9.6 or later

¢ Oracle11g Supported
¢ PostgreSQL 9.4.x

Windows * Microsoft SQL Server 2014 R2 on Windows Server 2012 R2 Recommended
* Microsoft SQL Server 2016 on Windows Server 2016
¢ Oracle 12c

¢ PostgreSQL 9.6

¢ MariaDB 5.5 or later server and tools Supported
¢ MySQL 5.5.3 or later server and tools

NOTE: MySQL 8 and later has password complexity enabled by default,
which Vibe doesn’t support. For help disabling password complexity and
setting a non-complex password, see .

* Microsoft SQL Server 2012 R2 on Windows Server 2012 R2
¢ Oracle 11g
¢ PostgreSQL 9.4.x

Vibe System Requirements



Directory Service Requirements

One of the following directory services:

Platform Requirement

GroupWise  * GroupWise 2018 Recommended
Linux * eDirectory 9 plus the latest patch for Linux Recommended
* eDirectory 8.8 plus the latest patch for Linux Supported
Windows ¢ Microsoft Active Directory on Windows Server 2016 Recommended
¢ eDirectory 9 with the latest patch for Windows
¢ Microsoft Active Directory on Windows Server 2012 R2 Supported

¢ Microsoft Active Directory on Windows Server 2012
¢ Microsoft Active Directory on Windows Server 2008 R2

+ eDirectory 8.8 with the latest patch for Windows

Disk Space Requirements

Item Requirement

Vibe software At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has free
disk space equal to the disk space currently in use, plus an additional 500

MB in the following area:

Linux: / var/ opt/ novel | / t eam ng

Windows: c:\Program Files\Novell\Teaming

Database server software At least 500 MB for a new installation

When you update an existing Vibe system, ensure that your server has free
disk space equal to the disk space currently in use, plus an additional 500

MB in the following area:

Linux: / var/ opt/ novel | / t eani ng

Windows: c:\Program Files\Novell\Teaming
Vibe file repository Depends on the anticipated size of the Vibe site

Database content Substantially less than the Vibe file repository

See “Planning the Vibe Database” on page 51 to plan for the disk space

needs of your Vibe site.
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Other Requirements

Requirement Additional Information

Tomcat 8 Tomcat 8 is included with Vibe on Linux and Windows.
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5 Vibe User Platform Support

+ “Browser Support” on page 27

+ “Office Application Support” on page 27

+ “Collaboration Client Support” on page 28

+ “Desktop Support” on page 28

+ “Mobile Support” on page 28

+ “File Viewer Support” on page 29

Browser Support

Platform Requirement
Linux ¢ Mozilla Firefox (latest version)
Windows ¢ Microsoft Internet Explorer 11 (latest version) (must not have the
Google Chrome Frame plug-in installed)
¢ Mozilla Firefox (latest version)
¢ Google Chrome (latest version)
¢ Microsoft Edge (latest version) (Windows 10 only)
Mac * Safari (latest version)

Office Application Support

Table 5-1 Desktop OS

Platform Requirement
Linux N/A
Windows * Microsoft Office 2013
* MS Office 2016 (not Office 365)
Mac N/A

Vibe User Platform Support
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Table 5-2 Workstation OS

Platform Requirement

Linux ¢ LibreOffice (latest version)
¢ MS (latest version)
Windows * Microsoft Office 2010
* MS Office 2013
* MS Office 2016 (not Office 365)
¢ LibreOffice (latest version)

* Windows 10 Drive Mapping via WebDAV Permalink

Mac ¢ MS Office 2016 for Mac

Collaboration Client Support

Vibe is integrated with GroupWise 2018.

Desktop Support

You can download Windows and Mac desktop applications that let you work with Vibe files directly
from the file system on your computer. The following operating systems are supported:

Platform Requirement
Windows Windows 8.1, and 10
Mac Mac OSX 10.11 and later

Mobile Support

You can download a native application for your iPhone, iPad, Android, or BlackBerry device. These
applications have a more polished user interface and don’t require you to sign in each time you
access Vibe. However, the mobile app for Vibe does not store information on your device;
information can be viewed only when you have an Internet connection.

Other devices can access the Vibe mobile interface by using a mobile browser that meets the
requirements listed in “Browser Requirements” on page 29.

+ “App Availability” on page 29

+ “Browser Requirements” on page 29
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App Availability
Micro Focus Vibe mobile apps are available for the following mobile operating systems:

+ iOS (native application is available for both the iPhone and iPad for a free download in the Apple
App Store for iOS 7 or later)

+ Android (native application is available for a free download in the Google Play App Store for
Android 2.3 or later)

+ Kindle Fire (native application is available for a free download in the Amazon Appstore for
Android)

+ BlackBerry Z10 and PlayBook (native application is available for a free download in the
BlackBerry World store)

Your device’s browser must also meet the requirements that are discussed in Browser
Requirements.

Browser Requirements

To access Vibe from a browser on a mobile device, your device’s browser must support the
following:

¢ HTML4

¢ JavaScript

File Viewer Support

In Micro Focus Vibe, file viewing capabilities are provided by Micro Focus KeyView technology. For a
list of supported file formats and background information on Micro Focus KeyView, see the “Micro
Focus KeyView Filter SDK C Programming Guide.”

The file viewers also support data indexing by the Lucene Index Server.
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6 Environment Support

+ “IPV6 Support” on page 31

¢ “Clustering Support” on page 31

+ “Virtualization Support” on page 31

+ “Single Sign-On Support” on page 31

¢ “Linux File System Support” on page 32

IPV6 Support

Micro Focus Vibe supports the IPV6 protocol when it is available on the server. If the protocol is
available, Vibe detects it and supports IPV6 by default, along with IPV4.

Clustering Support

You can install Vibe components on multiple servers to provide failover support, as described in
Part V, “Multi-Server Configurations and Clustering,” on page 127.

Virtualization Support

You can install Vibe in virtual environments where a software program enables one physical server
to function as if it were two or more physical servers.

Micro Focus tests the Vibe software on both Xen and VMware platforms. Vibe is supported on these
platforms, as well as other virtualization platforms, such as Microsoft Hyper-V. If you encounter an
issue that cannot be duplicated in a Micro Focus test environment, you may be responsible for
following up with the provider of your virtualization software.

For more information about virtualization support on SUSE Linux Enterprise Server, see the SLES
Documentation website (https://www.suse.com/documentation/sles11/#additional).

For more information about VMware virtualization support, see the VMWare website (http://
www.vmware.com).

Single Sign-On Support

Micro Focus Access Manager can be used to provide single sign-on capabilities for your Vibe site. For
setup instructions, see “Configuring Single Sign-On with Novell Access Manager” on page 103.
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Linux File System Support

The following file systems are supported for Vibe running on Linux:

+ ext3 (recommended in most cases)

NOTE: The maximum number of file entries in a Vibe File folder cannot exceed 31,998 when
using the ext3 file system.

+ NSS (recommended if you are running OES Linux and need the feature-rich environment of NSS)

¢ reiser3
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Basic Installation

+ Chapter 7, “Basic Installation Planning Worksheet,” on page 35

¢ Chapter 8, “Planning a Basic Vibe Installation,” on page 41

¢ Chapter 9, “Obtaining the Vibe Software,” on page 61

¢ Chapter 10, “Installing and Running the Database Server,” on page 63
¢ Chapter 11, “Installing and Setting Up a Basic Vibe Site,” on page 69
¢ Chapter 12, “Adding Users to Your Vibe Site,” on page 87

¢ Chapter 13, “Updating Your Vibe License,” on page 89

¢ Chapter 14, “Setting Up Vibe,” on page 91
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Basic Installation Planning Worksheet

We recommend that you print this section and record your planning decisions. You will then be able
to complete your Vibe installation process more efficiently, and you’ll have a record of your Vibe

installation for future reference.

Installation Program Field

Your Setting/Choice

Explanation

Vibe Server Platform:

¢ Windows

¢ Linux

See “Vibe Server Platform” on
page 42.

Server Memory:
¢ 4GB
¢ 8GB

¢ More

See “Server Memory” on
page 42.

Install Location:
* Software Location
Linux default:
[ opt/ novel | / t eam ng
Windows default:

c:\ Program
Fi I es\ Novel | \ Team ng

¢ Data Location
Linux default:
[var/opt/novel | /team ng
Windows default:
c:\ Novel I\ Teani ng

See “Install Location” on
page 43.
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Installation Program Field

Your Setting/Choice

Explanation

Default Locale:
Language (Country):

¢ Chinese (China) (Taiwan)

¢ Czech (Czech Republic)

¢ Danish (Denmark)

¢ Dutch (Belgium) (Netherlands)

¢ English (Australia) (Canada)
(India) (Ireland) (New Zealand)
(South Africa) (United States)

¢ Finnish (Finland)

¢ French (Belgium) (Canada)
(France) (Luxembourg)
(Switzerland)

¢ German (Austria) (Germany)
(Luxembourg) (Switzerland)

¢ Hungarian (Hungary)

¢ [talian (Italy) (Switzerland)
¢ Japanese (Japan)

¢ Polish (Poland)

¢ Portuguese (Brazil)

¢ Russian (Russia)

¢ Spanish (Argentina) (Bolivia)
(Chile) (Colombia) (Costa Rica)
(Dominican Republic) (Ecuador)
(El Salvador) (Guatemala)
(Honduras) (Mexico) (Nicaragua)
(Panama) (Paraguay) (Peru)
(Puerto Rico) (Spain) (Uruguay)
(Venezuela)

¢ Swedish (Sweden)
Logfile Timezone:
Country / Zone:

*

See “Planning the Default Locale
and Logging Time Zone” on
page 44.

User ID for Micro Focus Vibe:

¢ UserID:
¢ Group ID:

See “ldentifying Vibe’s Linux
User and Group” on page 45.
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Installation Program Field

Your Setting/Choice

Explanation

Network Information:

¢ Host:

¢ HTTP port: 8080

¢ Secure HTTP port: 8443
¢ Listen port: 8080

¢ Secure listen port: 8443
¢ Shutdown port:8005

¢ AJP port:8009

See “Gathering Network
Information for Your Vibe Site”
on page 46.

WebDAYV Authenticaiton Method:

See “Planning the WebDAV
Authentication Method” on

¢ basic page 49.
¢ digest
Database Type: See “Database Type” on

¢ MySQL/MariaDB
¢ Microsoft SQL
¢ Oracle

¢ PostgreSQL

page 51.

JDBC URL:

¢ Hostname:

¢ Port number:

See “Database Location” on
page 52.

Database Credentials:

¢ User name:

¢ Password:

See “Database Credentials” on
page 53.

Database Setup Method:

¢ Basic installation (same server as
Vibe software)

¢ Remote installation

See “Database Setup Method”
on page 52.

Database Encryption Algorithm:

¢ SHA-256

¢ PBEWITHSHA256AND128BITAES-
CBC-BC

See “Database Encryption
Algorithm” on page 54.

Java JDK Memory:

¢ JVM heap size:

See “Server Memory” on
page 42.
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Installation Program Field

Your Setting/Choice

Explanation

Outbound Email Protocol:

¢ SMTP
¢ SMTPS

See “Outbound Email Protocol”
on page 55.

Outbound Email Host:

¢ Hostname:
¢ SMTP port:
Default: 25
¢ Time zone
¢ Continent/region:
¢ Country/state:
¢ City:

See “Outbound Email Host” on
page 55.

Outbound Email Authentication:

¢ User name:

¢+ Password:

¢ Authentication required? No / Yes

See “Outbound Email
Authentication” on page 56.

Allow Sending Email to All Users

Yes / No

See “Outbound Email Send
Restriction” on page 56.

From email address override

¢ Email address for outbound email

Use this email address for all
outbound email

Yes / No

See “Outbound Email From
Address” on page 57.

Inbound Email Configuration

¢ Enable: No/ Yes
¢ SMTP bind address:
¢ SMTP port:

* Announce TLS: Yes / No

See “Planning to Enable
Inbound Email” on page 57.

Additional File Types for HTML
Conversions

¢ Added HTML Extensions:

See “Planning File Types for
HTML Conversions” on page 59

Basic Installation Planning Worksheet



Installation Program Field

Your Setting/Choice

Explanation

Built-in Administrator Name:
¢ Default-Administrator Name:

(Initial default is adm n. You
should secure it by changing the
name.)

¢ Default-Administrator Password:

(The initial password is the same
as the default-administrator name
that you enter [above]. You are
prompted to change this the first
time you log in.)

See “Planning a Secure
Administrator Name and
Password” on page 46.

LDAP Directory Service:
¢ eDirectory
¢ GroupWise

¢ Microsoft Active Directory

See “Synchronizing Users and
Groups from an LDAP Directory”
in the Micro Focus Vibe 4.0.5
Administration Guide.

J

LDAP Server:

¢ |DAP server URL:
¢ User DN:

¢ Password:

See “Server Information” in the
Micro Focus Vibe 4.0.5
Administration Guide.

GUID Attribute (to identify the user):

¢ For eDirectory, select GUID.

¢ For Active Directory, select
objectGUID.

¢ For GroupWise, select entryUUID.

See “Server Information” in the
Micro Focus Vibe 4.0.5
Administration Guide.

Vibe Account Name Attribute:

¢ LDAP Attribute that is used for
Vibe usernames.

See “Server Information” in the
Micro Focus Vibe 4.0.5
Administration Guide.

LDAP User Search Context:

¢ Base DNs:
*+ Additional filter attributes:

* Search subtree: Yes / No

See “Configuring User
Synchronization Options” in the
Micro Focus Vibe 4.0.5
Administration Guide.

LDAP Group Search Context:

¢ Base DNs:
¢ Additional filter attributes:

* Search Subtree: Yes / No

See “Configuring Group
Synchronization Options” in the
Micro Focus Vibe 4.0.5
Administration Guide.
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Installation Program Field

Your Setting/Choice

Explanation

LDAP Synchronization Schedule:

¢ Days
¢ Every day
* Weekly

Sun Mon Tue Wed Thu Fri
Sat

¢ Hours:
¢ Attime:

¢ Repeat every nn hours

See “Configuring the
Synchronization Schedule” in
the Micro Focus Vibe 4.0.5
Administration Guide.

LDAP User Options:

¢ Synchronize user profiles

¢ Register LDAP user profiles
automatically

¢ Delete users that are not in LDAP

¢ When deleting a user, delete
associated user workspaces and
content

¢ Time zone for new users

See “Configuring User
Synchronization Options” in the
Micro Focus Vibe 4.0.5
Administration Guide.

LDAP Group Options:

¢ Synchronize group profiles

¢ Register LDAP group profiles
automatically

¢ Synchronize group membership

¢ Delete local groups that are not in
LDAP

See “Configuring User
Synchronization Options” in the
Micro Focus Vibe 4.0.5
Administration Guide.
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8 Planning a Basic Vibe Installation

The installation program for Micro Focus Vibe helps you install the Vibe software and file repository
to the appropriate locations.

+ “What Is a Basic Vibe Installation?” on page 41

+ “Planning the Operating Environment of Your Vibe Server” on page 42

¢ “Planning the Default Locale and Logging Time Zone” on page 44

+ “Identifying Vibe's Linux User and Group” on page 45

¢ “Planning a Secure Administrator Name and Password” on page 46

+ “Gathering Network Information for Your Vibe Site” on page 46

+ “Planning the WebDAV Authentication Method” on page 49

¢ “Planning the Vibe Database” on page 51

+ “Planning for Outbound Email” on page 54

+ “Planning to Enable Inbound Email” on page 57

+ “Planning File Types for HTML Conversions” on page 59

+ “Gathering Directory Services Information” on page 59

What Is a Basic Vibe Installation?

The Micro Focus Vibe installation program provides two installation types: Basic and Advanced.
When you perform a Basic installation, the result is a fully functional Vibe site with all required
options configured and with typical defaults in use for optional settings.

If you are new to Vibe, the easiest way to get started is to perform a Basic installation first, with all
Vibe components installed on the same server. Then you can add advanced configuration options to
your Vibe site after the Basic installation has been successfully tested. However, experienced Vibe
administrators can choose to perform an Advanced installation immediately, which includes all
installation and configuration options, as described in Part 1V, “Advanced Installation and
Reconfiguration,” on page 93.

IMPORTANT: The following Vibe configurations require that you perform an Advanced installation as
your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See “Distributing Different Data Types to Different Locations” on
page 96 for Advanced installation instructions. You cannot move subdirectories within the Vibe
file repository after they have been created.

+ Installing the Vibe software on multiple servers to create a clustered environment. See
Chapter 21, “Running Vibe on Multiple Servers,” on page 141 for Advanced installation
instructions. The option to enable a clustered environment is available only during an Advanced
installation.
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This section helps you make informed decisions about the required options for a Basic installation:

+ Server platform (Linux or Windows)

+ Physical server memory requirements

¢ File locations (Vibe software and data)

+ Database type (MySQL/MariaDB, Microsoft SQL Server, or Oracle)

+ Database creation (during installation or before installation)

+ Database authentication (user name and password)

+ Network information (Vibe server hostname or fully qualified domain name, and ports)

¢ Outbound email configuration (SMTP vs. SMTPS, hostname, SMTP port, time zone,
authentication)

¢ Inbound email configuration (SMTP address, SMTP port, and TLS support)

+ User and group for running the Vibe software (Linux only)

Before performing a Basic installation, ensure that all system requirements are met, as listed in
Chapter 4, “Vibe System Requirements,” on page 23.

As you proceed with planning, you can use the Basic Installation Planning Worksheet to record your
decisions about the options you want to use.

Planning the Operating Environment of Your Vibe Server

+ “Vibe Server Platform” on page 42
+ “Server Memory” on page 42

¢ “Install Location” on page 43

Vibe Server Platform

Micro Focus Vibe can run on the versions of Linux and Windows listed in “Server Operating System
Requirements” on page 23.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Vibe Server Platform, mark your operating system of choice.

Server Memory

Vibe server memory usage is significantly affected by some factors and less affected by others:

+ Number of users logged in: No significant effect.
+ Number of concurrent active sessions: No significant effect.

+ Database server caches: Significant memory usage.

Planning a Basic Vibe Installation



When you follow the instructions for a Basic installation, the database is located on the same
server as the Vibe software. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its database on a remote server, so that the database uses separate
memory resources, as described in Chapter 19, “Creating the Vibe Database on a Remote
Server,” on page 129.

+ Vibe internal data caches: Significant memory usage.

When you follow the instructions for a Basic installation, the Vibe internal data caches are
subdirectories of the t eam ngdat a directory, described in “Install Location” on page 43. The
Vibe internal data caches are separate from any caching or memory usage by the database
server itself.

+ Lucene index cache: Significant memory usage.

The Lucene Index Server is a high-performance Java search engine. Large file repositories
(particularly with large files or a large number of files) can create a very large data index. When
you perform a Basic installation, the Lucene index is created on the same server where the Vibe
software is installed. After you have successfully tested your Basic installation, you can
reconfigure Vibe to have its Lucene index on a remote server, so that it uses separate memory
resources, as described in “Installing the Lucene Index Server on a Remote Server” on page 137.

¢ JVM: When you perform a Basic installation, the default amount of memory allocated to the
Java Virtual Machine (JVM) where the Vibe software runs is 1 GB. This memory allocation,
called the Java “heap size,” does not include memory used by your database server or by the
Lucene Index Server when these programs are running on the same server as the Vibe
software.

A general rule is that no more than 75% of the available physical memory should be allocated to
the JVM. Memory not allocated to the JVM must be sufficient to support the operating system,
the database server, and the Lucene Index Server if they are also running on the Vibe server,
and any other processes running on the Vibe server.

Although it is possible to run Vibe with less than 4 GB of memory for the JVM (the
recommended minimum), this applies only to very small test configurations, and is not suitable
for production systems. In a test configuration, 512 MB is the minimum amount of memory
required to produce a functioning Vibe installation.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Java JDK Memory, specify the amount of memory to allocate to the JVM where Vibe runs.

After you have considered all of the points above, you are ready to specify the

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Memory Requirements, specify the amount of physical memory you plan to have for your Vibe
server.

Install Location

Software Location: This varies by platform:
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Linux: [ opt/ novel | /t eam ng

Windows: c¢:\ Program Fil es\ Novel | \ Teani ng

Included under the main Vibe software directory are subdirectories for Tomcat and file viewer
software.

Data Location: This also varies by platform:

Linux: [ var/opt/novel | /team ng

Windows: c:\Novel |\ Team ng

IMPORTANT: On Windows, the Vibe installation program displays the Windows pathname with
forward slashes (/) rather than the traditional backslashes (\). This syntax is necessary in the
installation program.

The Vibe file repository holds all files that are imported into Vibe, information related to the
imported files, such as thumbnails and HTML renderings, and the search engine index.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Install Location, specify the directories where you want to install the Vibe software and data if
you prefer not to use the default locations.

A Basic installation lets you change the root directory for the Vibe software and the Vibe file
repository.

IMPORTANT: If you want to organize the Vibe file repository so that some file types are not under
the Vibe file repository root directory, you must perform an Advanced installation as your initial Vibe
installation. You cannot move directories out of the Vibe file repository root directory after the initial
installation has been performed. To perform an Advanced installation in order to organize the Vibe
file repository to meet your needs, complete the planning steps for a Basic installation and complete
the Basic Installation Planning Worksheet, then follow the additional instructions in “Distributing
Different Data Types to Different Locations” on page 96.

Planning the Default Locale and Logging Time Zone

Default Locale

The Micro Focus Vibe installation program runs in English only. When you install the Vibe software,
you can choose to have the primary language of the Vibe site be any of the languages listed on the
planning worksheet.

Some languages have an additional distinction by locale (the country where the language is spoken).
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The language you select during installation establishes the language of the global text that displays
in locations where all Vibe users see it, such as in the Workspace tree when you click the Workspace
treeicon  :

o

Horne Workspace Personal Workspace Guest (guest)

The language you select also establishes the default interface language and locale for creating new
workspaces.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Default Locale, mark the default language and locale for your Vibe site.

Additional language customization can be done after installation, as described in “Managing a
Multiple-Language Vibe Site” in “Site Setup” in the Micro Focus Vibe 4.0.5 Administration Guide.

Logfile Timezone

You also need to specify the time zone to be used for times recorded in Vibe log files.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Logfile Time Zone, mark the time zone where your Vibe site is located.

Identifying Vibe’s Linux User and Group

For optimum security, Vibe should not run as the Linux r oot user. For example, if an intruder
manages to assume the identity of the Vibe program, the intruder gains all the privileges of the
commandeered process. If the process is running with r oot user privileges, the intruder has r oot
access to your system. If the process is running as a user with minimal privileges, the intruder has
only restricted access to your system. Therefore, your system is more secure if the Vibe program
does not run as r oot . For example, you might want to create a user named vi beadm n for the Vibe
program to run as. Linux users require a full name and a password.

In addition to creating a Linux user for the Vibe program to run as, you can also create a Linux group
for that user to belong to. This enables the Vibe program to create directories and files with
consistent ownership and permissions. For example, you might want to create a group named

vi beadni n for the vi beadmi n user to belong to. Groups do not require passwords.

As an alternative to creating a custom Linux user name and group for Vibe, you can use the existing
WWwWr un user name and the www group. This account is typically used to start web server processes.
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under User ID for Micro Focus Vibe, specify the non-r oot Linux user name and group name to use for
running the Vibe program.

IMPORTANT: The non-r 00t Linux user and group must exist before you start the Vibe Installation
program. See “Performing Pre-Installation Tasks on Linux” on page 69.

Planning a Secure Administrator Name and Password

By default, the built-in default-administrator name and password are both set to adm n by the Vibe
installation program.

We strongly recommend that you change the name during the initial Vibe installation. The initial
password is then set to whatever name you specify.

We also recommend that you change the password when you log in for the first time after Vibe is
installed.

If you don’t change the password during the initial login, you can change it (and the Vibe default-
adminsitrator user name) at any time, as described in “Changing the Vibe Administrator User ID or
Password” in the Micro Focus Vibe 4.0.5 Administration Guide.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Built-in Administrator Name, specify a Default-Administrator Name different from admni n.

Also specify a password that you can enter and confirm the first time you log in as the Vibe site
administrator. (The initial password (for logging in the first time) is set to whatever you specify as the
administrator name.)

Gathering Network Information for Your Vibe Site

When you perform a Basic installation, the Micro Focus Vibe installation program needs hostname
and HTTP port information about the server where you are installing Vibe.

¢ “Host Identification” on page 46

¢ “Port Numbers” on page 47

Host Identification

When you install Vibe, the Vibe installation program needs to know the name of the server where
you are installing the Vibe software.

For use inside your firewall, you can use the DNS hostname of the Vibe server. However, if you want
your Vibe site to be accessible from the Internet, you must specify the fully qualified domain name
for the Vibe server in order to allow external access.

Do not use the default| ocal host

46 Planning a Basic Vibe Installation


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#b1dl09ko
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#b1dl09ko
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the hostname or fully qualified domain name to use for the Vibe
server.

Port Numbers

When you install Vibe, Tomcat is installed along with the Vibe software. Vibe uses Tomcat as a
standalone web server for delivering data to Vibe users in their web browsers. For more information
about Tomcat, see the Apache Tomcat website (http://tomcat.apache.org).

IMPORTANT: If the server where you want to install Vibe already has a web server running on it,
shut it down while you install and test Vibe. The instructions for a Basic Vibe installation assume that
no other web server is running on the Vibe server. If you want to maintain another web server on
the Vibe server, you are responsible for resolving any port conflicts that might arise.

On the command line, use the net st at command to see what ports are currently in use on the
server where you plan to install Vibe:

Linux: netstat -tan

Windows: netstat -a -n -p tcp

Ensure that the port numbers that you specify during Vibe installation do not conflict with ports that
are already in use on the server.

¢ “HTTP/HTTPS Ports” on page 47

¢ “HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe” on page 48

¢ “Shutdown Port” on page 49

+ “AJP Port” on page 49

HTTP/HTTPS Ports

By default, standard web servers such as Apache and Microsoft Internet Information Services (IIS)
use port 80 for non-secure HTTP (Hypertext Transfer Protocol) connections and port 443 for secure
HTTPS connections. HTTPS connections use SSL (Secure Sockets Layer) for added security. As a result,
web browsers default to port 80 when no port is specified in a non-secure HTTP URL and to port 443
when no port is specified in a secure HTTPS URL.

Tomcat defaults to port 8080 for non-secure HTTP connections and to port 8443 for secure HTTPS
connections, so that it does not conflict with the standard web server port numbers. If you configure
Vibe with the Tomcat default port numbers, users must include the appropriate port number when
providing the Vibe site URL. Typically, users prefer not to do this.
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Unfortunately, the situation is not as simple as just configuring Vibe to use the default port numbers
of 80 and 443. On Linux, non-r oot processes are not allowed access to port numbers lower than
1024 and you are counseled against running Vibe as r oot in “Identifying Vibe’s Linux User and
Group” on page 45. Also on Linux and Windows, the default Tomcat installation expects ports 8080
and 8443.

For a Basic installation, you can use the default port numbers as presented by the Vibe Installation
program:

HTTP port: 80

Secure HTTP port: 443
Listen port: 8080
Secure listen port: 8443

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server 2, port 80 is already in use
by iManager. In order for Vibe to listen on port 80 (which is the standard port), you need to change
iManager to listen on a non-standard port, such as 81.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, the default port numbers have been provided for you. You need to specify
different port numbers only if you anticipate port conflicts with other software on the Vibe server.
Resolving port conflicts is beyond the scope of this Vibe documentation.

After you install Vibe on Linux, you need to complete the steps in “Setting Up Port Forwarding” on
page 77 so that users are not required to include the port number in the Vibe URL.

If you want to use secure HTTPS connections for your Vibe site, you must obtain signed certificate
files as described in “Preparing for Secure HTTP Connections” in “Site Security” in the Micro Focus
Vibe 4.0.5 Administration Guide either before or after you install Vibe.

HTTP/HTTPS Ports When You Use Novell Access Manager with Vibe

If you are fronting Vibe with Novell Access Manager, ensure that you have configured the HTTP/
HTTPS ports as described in the following sections, depending on the operating system where Vibe is
running.

Configuring Vibe in this way configures Novell Access Manager to access Vibe over port 80, which is
the standard port.

+ “Windows Port Configuration” on page 48

¢ “Linux Port Configuration” on page 49

Windows Port Configuration

Use the following port configuration when Novell Access Manager is fronting your Vibe system on
Windows:

HTTP Port: 80

Secure HTTP Port: 443
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Listen Port: 80

Secure Listen Port: 443

Linux Port Configuration

Use the following port configuration when Novell Access Manager is fronting your Vibe system on
Linux:

HTTP Port: 80

Secure HTTP Port: 443
Listen Port: 8080
Secure Listen Port: 8443

With this suggested configuration on Linux, you also need to set up port forwarding, as described in
“Setting Up Port Forwarding” on page 77.

Shutdown Port

By default, Vibe uses 8005 as its shutdown port. For an explanation of the shutdown port, see
Tomcat - Shutdown Port (http://www.wellho.net/mouth/837_Tomcat-Shutdown-port.html).

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its shutdown port if the default
of 8005 is already in use on the Vibe server.

AJP Port

By default, Vibe uses 8009 as its AJP port. For an explanation of the Apache JServ Protocol port, see
The AJP Connector (http://tomcat.apache.org/tomcat-6.0-doc/config/ajp.html).

IMPORTANT: If you are installing Vibe on Novell Open Enterprise Server, port 8009 is already in use,
so you need to select a different port, such as 8010.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the port you want Vibe to use as its AJP port if the default of 8009
is already in use on the Vibe server.

Planning the WebDAV Authentication Method

¢ “Understanding WebDAV” on page 50
+ “Choosing the WebDAV Authentication Method” on page 50
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Understanding WebDAV

WebDAV is a standard collaborative editing and file management protocol. Micro Focus Vibe relies
on the WebDAV protocol for two key features:

+ Edit-in-Place for using tools such as LibreOffice and Microsoft Office, as described in “Editing
Files Accessed through a Web Browser” in the Micro Focus Vibe 4.0.5 User Guide.

+ Mapping Vibe folders as a web folder on the client computer, which allows access to Vibe files
from a WebDAV-compliant file navigation tool such as Windows Explorer or Nautilus, as
described in “Creating a Mapped Drive to the Vibe Folder” in the Micro Focus Vibe 4.0.5
Advanced User Guide.

Choosing the WebDAV Authentication Method

The WebDAV authentication method determines how user credentials are passed from Vibe to the
WebDAV server. Vibe 3 and later supports three types of WebDAV authentication methods:

¢ “Choosing Basic Authentication” on page 50

¢ “Choosing Digest Authentication” on page 50

¢ “Choosing Windows Authentication” on page 51

Choosing Basic Authentication

Basic authentication encodes the user name and password with the Base64 algorithm. The Base64-
encoded string is unsafe if transmitted over HTTP, and therefore should be combined with SSL/TLC
(HTTPS).

Select this type of authentication when you plan to use Novell Access Manager or Internet
Information Services (lIS) to authenticate users.

For more information about encryption algorithms, see “Database Encryption Algorithm” on
page 54.

Choosing Digest Authentication

Digest authentication applies MD5 cryptographic, one-way hashing with usage of nonce values to a
password before sending it over the network. This option is more safe than Basic Authentication
when used over HTTP.

Select this type of authentication when client users are using Windows 7 as their operating system
and Microsoft Office as their text editor.

For more information about encryption algorithms, see “Database Encryption Algorithm” on
page 54.
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Choosing Windows Authentication

Windows Authentication provides Windows users with a single sign-on experience, enabling users to
automatically authenticate to Vibe after they are logged in to their individual workstations. Internet
Information Services (I1S) provides this capability.

To configure Vibe to use Windows Authentication as the WebDAV authentication method, select
basic in the WebDAV authentication method field during the Vibe installation program, then
configure Windows Authentication as described in “Configuring Single Sign-On with Internet
Information Services for Windows” on page 104.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under WebDAV authentication method, specify the authentication method you want Vibe to use when
authenticating to WebDAV.

Planning the Vibe Database

Micro Focus Vibe database disk space requirements are relatively modest. Files that are imported
into Vibe are saved in the Vibe file repository, as described in “Install Location” on page 43.

The Vibe database is primarily used for storing the following information:

+ Structural information about workspaces, folders, and entries (for example, their location in the
workspace tree)

+ |dentification information about workspaces, folders, and entries (for example, titles,
descriptions, dates of creation/modification, and users associated with creation/modification)

+ User profile information (for example, full name, phone number, and email address)
You or your database administrator must make the following decisions about the Vibe database:

+ “Database Type” on page 51

+ “Database Setup Method” on page 52
+ “Database Location” on page 52

+ “Database Credentials” on page 53

+ “Database Encryption Algorithm” on page 54

Database Type

Vibe supports the following database types:
On Linux: MariaDB, MySQL, Oracle, and PostgreSQL

On Windows MariaDB, MySQL, Microsoft SQL, Oracle, and PostgreSQL

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Type, mark the type of database that you want to use with Vibe.
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Ensure that a supported version of the database server, as listed in “Database Server Requirements”
on page 24, is installed and running before you install Vibe.

Database Setup Method

You or your database administrator must manually create the Vibe database. This is a requirement,
regardless of which type of database you are using.

+ “Basic Setup” on page 52

+ “Remote Server Setup” on page 52

Basic Setup

If you plan to deploy the Vibe database as a basic installation, with the database running on the
same server as the Vibe software, you first install the Vibe software, and then create the database,
as described in Chapter 11, “Installing and Setting Up a Basic Vibe Site,” on page 69.

Remote Server Setup

If you plan to deploy the Vibe database on a remote server, follow the instructions in Chapter 19,
“Creating the Vibe Database on a Remote Server,” on page 129.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Setup Method, mark whether you are setting up the database as a basic installation
(with the database running on the same server as the Vibe software), or whether you are performing a
remote server setup, with the database server on a remote server.

Database Location

Creating the database on the same server where you install the Vibe software is the preferable
location for your Basic installation. The default database name is si t escape (a reference to the
company that previously developed the Vibe software).

You can have your database administrator create a database on a remote server later, after you have
successfully tested your Basic installation. See Chapter 19, “Creating the Vibe Database on a Remote
Server,” on page 129.

You must decide before installation whether you want the database on the Vibe server or on a
remote server. See Chapter 19, “Creating the Vibe Database on a Remote Server,” on page 129.

Vibe knows where to find its database from the JDBC (Java Database Connectivity) URL that you
provide during installation. For a database that is local to the Vibe software, the default JDBC URL
that provides | ocal host as the hostname of the Vibe server is appropriate. If the database ison a
remote server, the JDBC URL must provide the hostname of the remote database server.

The JDBC URL also includes the port number on which Vibe can communicate with the database
server. The default port number depends on the database server you are using:
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Database Server Default Port Number

MySQL/MariaDB 3306

Microsoft SQL 1433
Oracle 1521
PostgreSQL 5432

Use this port number unless it is already in use by another process on the database server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under JDBC URL, specify the appropriate hostname for the database server (| ocal host or the
hostname of a remote server) and the port number it will use to communicate with Vibe.

Database Credentials

When you have the Vibe Installation program create the database for you, it defaults to the
following administrator user names for the database server:

Database Default Administrative User Name
MysQL/ r oot
MariaDB

IMPORTANT: The database r 0ot user name is not the same as the Linux r oot user on a
Linux server.

Microsoft SQL  (no default) For a Microsoft SQL database, your database administrator establishes the
administrator user name and password for the database server.

Oracle (no default) For an Oracle database, your database administrator establishes the
administrator user name and password for the database server.

PostgreSQL postgres

For an Oracle database and Microsoft SQL database, your database administrator establishes the
administrator user name and password for the database server.

Check with your database administrator to see if the default administrator user name is still in use

for your database server, and obtain the administrator password for the database server before you

run the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials, specify the administrator user name and password for the database
server so that Vibe can access its database.
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Database Encryption Algorithm

Different encryption algorithms provide differing encryption strength. The supported algorithms for
encrypting the Vibe database password are listed below.

+ SHA-256
This is the only available option when you use Basic Authentication for WebDAV authentication,
as described in “Planning the WebDAV Authentication Method” on page 49.

¢+ PBEWITHSHA256AND128BITAES-CBC-BC

This is the only available option when you select Digest Authentication for WebDAV
authentication, as described in “Planning the WebDAV Authentication Method” on page 49.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Encryption Algorithm, mark the encryption algorithm you want to use for Vibe
passwords.

Planning for Outbound Email

Your Micro Focus Vibe site can be configured to send outbound email through an existing email
system. Email from the Vibe site is useful for the following activities:

+ Vibe users can subscribe to email notifications, so that they automatically receive a message
whenever content of interest changes. For more information, see “Subscribing to a Folder or
Entry” in “Getting Informed” in the Micro Focus Vibe 4.0.5 User Guide.

* From the Vibe site, users can send email messages to individual users or to teams. For more
information, see “Sending Email from within Vibe” in “Connecting With Your Co-Workers” in
the Micro Focus Vibe 4.0.5 User Guide.

In order for your Vibe site to communicate with your email system, you need to gather the following
information about your email system:

¢ “Outbound Email Protocol” on page 55
+ “Outbound Email Host” on page 55
+ “Outbound Email Authentication” on page 56
¢ “Outbound Email Send Restriction” on page 56
¢ “Outbound Email From Address” on page 57
After installation, outbound email can be disabled and enabled again on the Vibe site, as described

in “Configuring Email Integration” in “Site Setup” in the Micro Focus Vibe 4.0.5 Administration
Guide. However, you must configure outbound email in the Vibe installation program.
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Outbound Email Protocol

Email systems communicate by using SMTP (Simple Mail Transfer Protocol). You need to determine
whether the email system that you want your Vibe site to communicate with is using SMTP or
SMTPS (secure SMTP).

For GroupWise, you can check how the Internet Agent is configured:

1 In the GroupWise Admin Console, browse to Internet Agents > GWIA > Agent Settings.

2 The SMTP row, SSL column indicates which protocols can be used as follows:

SSL Setting Protocols Supported
Requi red SMTPS
Enabl ed SMTP or SMTPS
Di sabl ed SMTP
3 Click Close.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Protocol, mark SMTP or SMTPS to match the email system that you want Vibe
to communicate with.

4 If the email system requires SMTPS, see “Securing Email Transfer” in “Site Security” in the
Micro Focus Vibe 4.0.5 Administration Guide.

Outbound Email Host

In order to send messages to your email system, Vibe needs to know the hostname of your SMTP
mail server.

The default SMTP port of 25 is typically appropriate, unless the SMTP mail server requires port 465
or 587 for SMTPS connections.

For GroupWise, this is the hostname of a server where the Internet Agent is running. GroupWise
always uses port 25, even when SSL is enabled.

When the Vibe site sends email notifications for scheduled events, the messages are time-stamped
according to the time zone you specify here during installation. This setting allows you to use a time
zone for email notifications that is different from the time zone where the server is located. The time
zone list is grouped first by continent or region, optionally by country or state, and lastly by city.
Some common selections for United States time zones include the following:
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Time Zone Continent/City

Pacific Time America/Los Angeles
Mountain Time America/Denver
Central Time America/Chicago
Eastern Time America/New York

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Host, specify the name of the mail host, the SMTP port number it uses, and the
time zone for the time stamp you want on scheduled event notifications.

Outbound Email Authentication

Many SMTP mail hosts require a valid email address before they establish the SMTP connection.
Some email systems can construct a valid email address if you specify only a valid user name; other
email systems require that you specify the full email address for successful authentication. You
should provide a user name (email address) to ensure a successful connection. Email notifications
from the Vibe system are sent using this email address in the From field.

Some email systems also require a password. Some do not. If authentication is required, you should
also provide a password.

By default, the GroupWise Internet Agent does not require authentication in order to receive
inbound messages. However, the /forceinboundauth startup switch is available for use in the
Internet Agent startup file (gwi a. cf g), in order to configure the Internet Agent to refuse SMTP
connections where a valid email user name and password are not provided. The Internet Agent can
accept just the user name or the full email address.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Outbound Email Authentication, indicate whether or not authentication is required for the Vibe
site to communicate with your email system. If it is, specify the user name or email address, and if
necessary, the password for the email account.

Outbound Email Send Restriction

By default, the Vibe site allows Vibe users to send messages to all Vibe users by using the All Users
group on the Vibe site. On a very large Vibe site, this generates a very large number of email
messages. If desired, you can prevent messages from being sent to the All Users group.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Allow Sending Email to All Users, mark whether you want users to be able to send messages to the All
Users group.
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Outbound Email From Address

You can specify an email address to be used as the From address of emails sent from Vibe.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under From email address override, specify the email address to be used as the From address for emails
sent from Vibe.

Under Use this from email address for all outbound email, mark whether you want this address to be used
for all outbound email.

Planning to Enable Inbound Email

You can configure your Micro Focus Vibe site so that users can post comments by emailing them to
the folder where they want to post the comment. In order to receive email postings, folders must be
properly configured, as described in “Enabling Folders to Receive Entries through Email” in
“Managing Folders” in the Micro Focus Vibe 4.0.5 Advanced User Guide. Also, users must know the
email address of the folder where they want to post their comment.

¢ “Internal Mail Host for Inbound Email” on page 57
¢ “Inbound Email Port Number” on page 57
¢ “Inbound Email IP Address” on page 58

* “Inbound Email Security” on page 58

After installation, inbound email can be disabled and enabled again on the Vibe site, as described in
“Disabling/Enabling Inbound Email Postings” in “Site Setup” in the Micro Focus Vibe 4.0.5
Administration Guide. However, you must configure inbound email in the Vibe installation program.

Internal Mail Host for Inbound Email

Inbound email is disabled by default. When you enable it, the Vibe site starts an internal SMTP mail
host to receive incoming messages and post them to the folders associated with the email addresses
to which the messages are addressed. By default, the internal SMTP mail host uses port 2525, so that
it does not conflict with another mail host that might be running on the Vibe server.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, mark whether you want users to be able to post to the Vibe site from
their email clients.

Inbound Email Port Number

Selecting the port number for the Vibe internal SMTP mail host presents the same issue that needs
to be dealt with for the HTTP port numbers, as described in “HTTP/HTTPS Ports” on page 47. You
might want to configure the Vibe internal SMTP mail host to use the standard SMTP port of 25. How
you handle the issue depends on whether you are installing on Linux or on Windows.
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Linux: Keep the default port number (2525) in the Vibe Installation program, then complete the steps
in “Setting Up Port Forwarding” on page 77 so that requests incoming on port 25 are forwarded
to port 2525.

Windows:  Specify port 25 for incoming email in the Vibe Installation program.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, specify the port number for the Vibe internal SMTP host to listen on.

Inbound Email IP Address

If you want to install Vibe on a server where an SMTP mail host is already running, you can do so if
the server has multiple IP addresses. The existing SMTP mail host can use port 25 on one IP address
and Vibe can use port 25 on another IP address. During installation, you need to specify an IP
address only if the server has multiple IP addresses and you want Vibe to bind to a specific IP address
rather than all of them.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, specify the IP address for the Vibe internal SMTP host to listen on, if
you are installing Vibe on a server with multiple IP addresses and you want Vibe to bind to just one of them.

Inbound Email Security

You can choose whether the Vibe internal mail host uses TLS (Transport Layer Security) when it
communicates with other SMTP mail hosts. In order for TLS to function properly, you must have a
certificate on the Vibe server, as described in “Securing Email Transfer” in “Site Security” in the
Micro Focus Vibe 4.0.5 Administration Guide. When an SMTP mail host queries the Vibe mail host,
the Vibe mail host communicates its ability or inability to handle TLS. The other SMTP mail host then
communicates appropriately, taking into account how the Vibe internal mail host is configured. The
default is to use TLS, because this provides more secure communication between mail hosts.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Inbound Email Configuration, mark whether you want the Vibe server to announce that it can use
TLS.

You can install Vibe with Announce TLS selected, and then set up the certificate afterwards.
However, if you select Announce TLS, inbound email does not work until the certificate is available
on the Vibe server.
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Planning File Types for HTML Conversions

Many file formats in Micro Focus Vibe can be viewed as HTML by default, as described in “Viewing
the File in HTML Format” in the Micro Focus Vibe 4.0.5 User Guide. File formats that can be viewed
as HTML by default are: . 123, . bnp, . doc, . docx, . dotm . drw,. dxf,. htm.htnl,. [ wp,. odp,
.ods,.odt,.ppt,.pptx,.prz,.rtf,.shw,.sxw,.tif,.txt,.vsd,.wdd,.xls,.xlsx,.sxi.

Some file formats, such as . pdf files, cannot be viewed as HTML by default. This is because the
quality of these files is lessened when viewed as HTML. However, if you choose, you can enable non-
default file formats, such as . pdf files, to be viewed as HTML.

Not all file formats can be enabled to be viewed as HTML in Vibe, but many can be. If you are unsure
whether Vibe supports a particular file format to be viewed as HTML, try it and see.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Additional File Types for HTML Conversions, specify the file types (in addition to the default file
types) that you want users to be able to view as HTML.

Gathering Directory Services Information

Unless you are planning a very small Micro Focus Vibe site, the most efficient way to create Vibe
users is to synchronize initial user information from your network directory service (Novell
eDirectory, GroupWise, or Microsoft Active Directory directory service) after you have installed the
Vibe software. Over time, you can continue to synchronize user information from the LDAP directory
to your Vibe site.

“Synchronizing Users and Groups from an LDAP Directory” in the Micro Focus Vibe 4.0.5
Administration Guide provides instructions for synchronizing user information via LDAP. Use this
section when planning your LDAP configuration.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under the LDAP sections, mark the information specific for your environment.
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Obtaining the Vibe Software

+ Free Trial: After registering for a user account with Micro Focus, you can download a 60-day

free trial of Vibe software from the Micro Focus web site to share and evaluate with your team.

+ Purchase: If you want to deploy Vibe services as part of your regular production system, visit
the How to Buy link on the Vibe Trial Download page (linked above).

Obtaining the Vibe Software
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Installing and Running the Database Server

Vibe requires the creation of a Vibe database during installation. Therefore, a supported database
server must be installed and running before you install Vibe.

A Basic Installation assumes that the database service is running on the same server as Vibe.

If your Vibe server already has one of supported database servers installed and running, skip to
Chapter 11, “Installing and Setting Up a Basic Vibe Site,” on page 69.

To install an Oracle or Microsoft SQL server, see the documentation for those products.

If you want to deploy a MySQL, MariaDB, or PostgreSQL database server, the following sections are
provided for your convenience.

+ “MySQL (or MariaDB) on Linux” on page 63

+ “MySQL or MariaDB on Windows” on page 65
+ “PostgreSQL on Linux” on page 66

+ “PostgreSQL on Windows” on page 68

+ “Securing PostgreSQL and Vibe Communications” on page 68

MySQL (or MariaDB) on Linux

IMPORTANT: The steps in this section are optimized for installing MYSQL on SUSE Linux Enterprise
Server (SLES) 11.

For information regarding the installation of MySQL on other versions of SLES or other flavors of
Linux, see Installing and Upgrading MySQL (http://dev.mysql.com/doc/refman/5.1/en/
installing.html) in the MySQL documentation (http://dev.mysql.com/doc/).

In SLES 12, the default database changed from MySQL to MariaDB. Installation and management
procedures, etc. are basically unchanged. For information on installing SLES 12 and using MariaDB,
see the SLES 12 Documentation (https://www.suse.com/documentation/sles-12/) and MariaDB
(http://www.mariadb.com) web sites.

Depending on the options you select when installing Open Enterprise Server and SUSE Linux
Enterprise Server (SLES), the MySQL or MariaDB database server might be installed along with the
operating system. Check for the following directory:

[ usr/ bin/ nmysql
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If the / usr/ bi n/ nysql directory does not exist, you need to install the MySQL or MariaDB
database server. If MySQL or MariaDB is already installed, you still need to configure it for use with
Vibe.

+ “Installing MySQL/MariaDB” on page 64

+ “Configuring MySQL/MariaDB” on page 64

* “Learning More about MySQL/MariaDB” on page 65

Installing MySQL/MariaDB

Ensure you have access to your operating system installation media.
In YaST, click Software > Software Management.

In the Search field, type nmysql , then click Search.

Select mysql, then click Accept.

Click Continue to resolve dependencies.

A U A WN R

Click Continue to acknowledge package support status.
MySQL is then installed from the SLES media.
7 Continue with “Configuring MySQL/MariaDB” on page 64.

Configuring MySQL/MariaDB

When MySQL or MariaDB is initially installed, it is not configured with an administrator password,
nor is it configured to start automatically. Follow the steps below to set up the MySQL or MariaDB
database server for use with Vibe:

1 In YaST, click System > System Services.
Scroll to and select the service, then click Enable.
Click Continue to install dependencies, then click OK to close the status box.
Click OK > Yes to finish the installation, then exit YaST.

In a terminal window, become the r oot user.

D U A W N

To verify that the database server has started, use the following command:

ps -eaf | grep nysql

You should see the processes running.

7 IMPORTANT: If you are installing MySQL 8, you must disable password complexity before
setting the administrator password. Go to, complete the instructions there, then continue with
“Learning More about MySQL/MariaDB” on page 65.

Set the administrator password for the database server:
nysqgl admin -u root password new_password

This command changes the password for the database r oot user, which is the default
administrator user name for the MySQL or MariaDB database server. This command is part of
the database client package.
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IMPORTANT: The database r oot user name is not the same as the Linux r oot user. The Linux
r oot user has a password established for it when you install Linux. In a parallel fashion, the
database r oot user needs to have a password established for it when you install MySQL or
MariaDB.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Installation Planning Worksheet, specify the database
administrator password. The Vibe installation program prompts you for this information.

Learning More about MySQL/MariaDB

The following table includes some basic and useful MySQL or MariaDB commands:

Action Command
Stop MySQL /etclinit.d/ nysqgl stop
Start MySQL /etcl/init.d/ nysqgl start

Show MySQL status nysqgladm n -u root -p extended-status

If you want to administer MySQL or MariaDB through a GUI interface, you can download tools from:
MySQL GUI Tools Downloads (http://dev.mysgl.com/downloads/gui-tools/5.0.html)
For more information about MySQL, see:

MySQL Documentation (http://dev.mysql.com/doc)

MySQL or MariaDB on Windows

1 In your web browser, go to the MySQL or MariaDB download site.

2 Scroll down if necessary, then click the type of Windows operating system you are using (32-bit
or 64-bit).

3 On the Windows Essentials line, click Download.

4 Click Save File, browse to and select a convenient temporary directory, then click Save.

5 In Windows Explorer, browse to the directory where you saved the MySQL . exe file.

6 Double-click the . exe file to start the Setup Wizard.

7 Follow the online instructions to install the software on the Windows server, then continue with

Step 8 to configure the server.

8 Unless you are already familiar with configuring MySQL or MariaDB on a Windows server, select
Standard Configuration, then click Next.

9 Select Include Bin Directory in Windows PATH, then click Next.

10 Set the database r oot user password, then click Next.
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BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Installation Planning Worksheet, specify the database
administrator password. The Vibe installation program prompts you for this information.

11 Click Execute to configure the database server, then click Finish.
Some messages report the status of your installation.

12 To monitor the database server, click Start > All Programs, then click MySQL > MySQL Server 5.1 >
MySQL Command Line Client or the equivalent MariaDB options.

PostgreSQL on Linux

IMPORTANT: The steps in this section are optimized for installing PostgreSQL on SUSE Linux
Enterprise Server (SLES) 12.

For information regarding the installation of PostgreSQL on other versions of SLES or other flavors of
Linux, see the PostgreSQL (https://www.postgresgl.org/docs/manuals/) and the SUSE (https://
www.suse.com/documentation/) documentation on the web.

+ “Installing PostgreSQL and Setting the postgres User Password” on page 66
+ “Configuring the Socket Connection Method” on page 67
+ “Learning More about PostgreSQL” on page 67

Installing PostgreSQL and Setting the postgres User Password

1 Ensure you have access to your operating system installation media.
2 In YaST, click Software > Software Management.

3 In the Search field, type post gr esql , then click Search.

4

Select the postgresql-jdbc and postgresql94-server packages for the PostgreSQL server, and if
the Vibe software is running on the same machine, select the PostgreSQL client package,
libecpg6, then click Accept.

5 If needed, click Continue to resolve dependencies.
6 Click Continue to acknowledge package support status.
PostgreSQL is then installed from the SLES media.
7 Click Finish.
8 In YaST, click System > Services Manager.
9 Scroll to and select postgresql, then click Enable/Disable > Start/Stop > OK.
10 After the configuration is updated, close YaST and open a terminal prompt.

11 Set a password for the database administrator (post gr es system user) by entering the
following commands:
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12

su - postgres

psql

\ password postgres
speci fy-a- password
r epeat -t he- passwor d
\q

exit

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Installation Planning Worksheet, record the postgres
administrator password. If you want to use a password other than post gr es you must modify the
postgresql-create-empty-database.sql file. See the PostgreSQL documentation on the web (https://
www.postgresql.org/docs/manuals/) for help.

Continue with “Configuring the Socket Connection Method” on page 67.

Configuring the Socket Connection Method

1
2

O 00 N O U1 A~ W

10
11

As the r oot user, browse to/var/|i b/ pgsql / dat a.

Edit the pg_hba. conf file and change the following local and host lines to specify md5
encryption, as follows:

| ocal all al | nd5
host al | al | 127.0.0.1/32 nd5
host al | al | ::1/128 nd5
host al | al | 0.0.0.0/0 nd5

For more information about the pg_hba.conf file, see the PostgreSQL documentation on the

web (https://www.postgresql.org/docs/9.4/static/auth-pg-hba-conf.html).
Save the file.

Edit the post gresql . conf file.

Uncomment the listen_addresses line by removing the pound sign (#).
Change ‘localhost’ to “*’.

Save and close the file.

In YaST, click System > Services Manager.

Scroll to and select postgresql, then click Start/Stop > OK to stop PostgreSQL.
Repeat from Step 8 to restart PostgreSQL, then close YaST.

Continue with “Securing PostgreSQL and Vibe Communications” on page 68

Learning More about PostgreSQL

If you want to administer PostgreSQL through a GUI interface, you can download tools from:

Community Guide to PostgreSQL GUI Tools (https://wiki.postgresql.org/wiki/
Community_Guide_to_PostgreSQL_GUI_Tools)

For more information about PostgreSQL, see:
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The PostgreSQL Wiki (https://wiki.postgresql.org/wiki/Main_Page)

PostgreSQL on Windows

N

N o 1 ~AW

10

11

12

13

In your web browser, go to the PostgreSQL download site.

Scroll down if necessary, then click the type of Windows operating system you are using (32-bit
or 64-bit).

On the Windows Essentials line, click Download.

Click Save File, browse to and select a convenient temporary directory, then click Save.
In Windows Explorer, browse to the directory where you saved the . exe file.
Double-click the . exe file to start the Setup Wizard.

Follow the online instructions to install the software on the Windows server, then continue with
Step 8 to configure the server.

Unless you are already familiar with configuring PostgreSQL on a Windows server, select
Standard Configuration, then click Next.

Select Include Bin Directory in Windows PATH, then click Next.

Set the database postgres user password, then click Next.

BASIC VIBE INSTALLATION SUMMARY SHEET

Under Database Credentials on the Basic Installation Planning Worksheet, specify the database
administrator password. The Vibe installation program prompts you for this information.

Click Execute to configure the database server, then click Finish.
Some messages report the status of your installation.

To monitor the database server, click Start > All Programs, then click PostgreSQL > PostgreSQL
Server > PostgreSQL Command Line Client.

Continue with “Securing PostgreSQL and Vibe Communications” on page 68

Securing PostgreSQL and Vibe Communications

IMPORTANT: If SSL is enabled on your PostgreSQL server, you must modify the Vibe server as
follows:

1
2

3

Shut down the Vibe server.

Rerun the Vibe installer and when specifying the JDBC URL, add ?ssl =t r ue after the database
name, for example:

url ="j dbc: postgresql ://1P_address_or_ DNS name: 5432/
vi be_db_nane?ssl =t rue"

Restart Vibe.
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1 1 Installing and Setting Up a Basic Vibe Site

Follow the setup instructions for the platform where you are installing Micro Focus Vibe:

¢ “Linux: Installing and Setting Up a Basic Vibe Site” on page 69
+ “Windows: Installing and Setting Up a Basic Vibe Site” on page 80

Linux: Installing and Setting Up a Basic Vibe Site

You should already have reviewed Chapter 8, “Planning a Basic Vibe Installation,” on page 41 and
filled out the Basic Installation Planning Worksheet. The following sections step you through the
process of installing and starting Micro Focus Vibe on Linux:

¢ “Performing Pre-Installation Tasks on Linux” on page 69

¢ “Running the Linux Vibe Installation Program” on page 70

+ “Creating the Vibe Database” on page 73

+ “Performing Post-Installation Tasks on Linux” on page 75

Performing Pre-Installation Tasks on Linux

1 Ensure that the Linux server where you plan to install Vibe meets the system requirements
listed in “Vibe System Requirements” on page 23.

2 In a terminal window, become r oot by entering su - and the r oot password.
3 Set the Linux open file limit to meet the needs of the Vibe software:
3a Openthe/etc/security/limts. conf filein an ASCIl text editor.

3b Add the following lines to the bottom of the list, following the format of the example lines:

* har d nofile 65535
* sof t nofil e 4096

3c Save the file, then exit the text editor.
4 Perform the following conditional tasks if necessary:
+ “Stopping and Disabling an Existing Web Server” on page 69
* “Creating a Vibe User and Group” on page 70

Stopping and Disabling an Existing Web Server

If a web server is currently running on the Vibe server, stop it, and preferably disable it.
For example, to stop the Apache web server and its associated instance of Tomcat:

1 Enter the following commands to stop Apache and Tomcat:
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/etc/init.d/tontat5 stop
/etcl/init.d/ apache2 stop

2 Enter the following commands to ensure that Apache and Tomcat do not start again when you
reboot the server:

chkconfig --del apache2
chkconfig --del tontath

Creating a Vibe User and Group

If the user and group that you want to use for Vibe (as described in “Identifying Vibe’s Linux User
and Group” on page 45) do not exist yet, create them. It is easier if you create the group first.
1 Create the Linux group that you want to own the Vibe software and data store directories:

1a In YaST, click Security and Users > User and Group Management to display the User and
Group Administration page.

1b Click Groups, then click Add.
1c Specify the group name, then click Accept or OK.
The group does not need a password.
2 Create the Linux user that you want Vibe to run as:
2a Click Users, then click Add.

2b On the User Data tab, specify the user’s full name, user name, and password, then select
Disable User Login.

Like any Linux system user, the Vibe Linux user does not need to manually log in. The Vibe
Linux user does not need a password, either, but YaST requires you to provide one.

2c Click the Details tab.

2d In the Login Shell drop-down list, select /bin/false, because this user does not need to
manually log in.

2e In the Default Group drop-down list, select the Linux group that you created in Step 1.
2f In the Additional Groups list, select the Linux group that you created in Step 1.
2g Click Accept or OK.

3 Exit YaST.

Running the Linux Vibe Installation Program

When you run the Vibe installation program for the first time, you typically want to use the GUI
interface. However, if you are installing Vibe on a server where the X Window System is not
available, a text-based installation program is also available. After you are familiar with the Vibe
installation process, you can use a silent installation to automate the process.

¢ “Using the GUI Installation Program” on page 71

¢ “Using the Text-Based Installation Program” on page 72

+ “Performing a Silent Installation” on page 73
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Using the GUI Installation Program

1 In aterminal window, enter su - to become the r oot user, then enter the r oot password.

You need r oot permissions in order to install the Vibe software, but you should not run the
Vibe software as r oot .

2 Change to the directory where you downloaded and extracted the Vibe software.

3 Ensure that you have al i cense- key. xm file in the same directory with the Vibe installation
program.

nore |icense-key. xm

The Vibe installation program does not start without a license file in the same directory. If you
have not already, rename the license file to be called | i cense- key. xni .

For more information about licensing, see Chapter 13, “Updating Your Vibe License,” on
page 89.

4 Enter the following command to start the Vibe installation program:
.linstaller-team ng.!linux

5 Accept the License Agreement, then click Next.

Novell Vibe 4 Installation Program = x
Installation Options
Select the action you want to perform. N
* New installation
" Update software and settings

" Reconfigure settings

6 Click Next to accept the default of New installation.

Novell Vibe 4 Installation Program = x
Choose Installation Type

Select the type of installation you want to perform N

Select the Basic installation if you do not want to configure
any of the optional features.

| Advanced

7 Click Next to accept the default of Basic.
8 Use the information that you have gathered on the Basic Installation Planning Worksheet to
provide the information that the Vibe installation program prompts you for:

Installation Locations

Additional Extensions for View as HTML
Default Locale for Micro Focus Vibe
User ID for Micro Focus Vibe
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Built-In Administrator Name for Micro Focus Vibe
Network Information
WebDAV Authentication Method
Database Selection
Database Type
JDBC URL
Credentials
Setup
Encryption Algorithm
Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User Name, Password, and Authentication
Allow Sending Email to All Users
Inbound Email Configuration

The installation program stores the information that it gathers in the i nstal | er. xm file in
the same directory where you started the installation program.

9 After you have provided all the requested information, click Install to begin the Vibe installation.
10 Verify that the JCE is properly configured.
11 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the i nst al | er. | og file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
i nstall er. | og file provides information that can help you resolve the problem.

12 Continue with “Creating the Vibe Database” on page 73.

Using the Text-Based Installation Program

If you try to start the GUI Vibe installation program in an environment where the X Windows System
is not running, the text-based Vibe Installation program starts.

Checking license key...

License Summary

Product: Novell Vibe

Version: 3.0

UID: 1
Effective: 10/27/2012
Expires: never
Users: unlimited

Installing this software requires agreement to the
terms and conditions set forth in the:
Novell EULA and Export Compliance Notice

You can review this agreement again at the download site or
type "REVIEW" below.

Note: You must answer "YES" to install the software.

Have you read and agree with the license? :
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If you want to use the text-based installation program in an environment where the GUI starts by
default, use the following command in the directory where the installation program is located:

.linstaller-teamng.linux --text

IMPORTANT: The text-based Vibe installation program must be run in the same directory where the
Vibe license file is located. If the license file is not in the same directory, the text-based installation
program cannot find it.

The text-based installation program gathers the same configuration information as the GUI
installation program does. This information is stored in the i nstal | er. xm file in the directory
where you run the installation program.

The installation program does not write the information it gathers into the i nst al | er. xnl file
until you exit the installation program, and you cannot go back when you use the text-based
installation program. Therefore, when you use the text-based installation program, you should plan
your installation carefully in advance, using the Basic Installation Planning Worksheet or the
Advanced Vibe Installation Summary Sheet. If you make a mistake during the installation, continue
to the end of the installation process and exit the installation program normally, so that all
information is saved. Then run the text-based installation program again. Your previous information
is supplied as defaults, and you can change the information as needed.

Performing a Silent Installation

If your Vibe system expands beyond one server, you might need to repeatedly install the same Vibe
components. A silent installation makes this an easy process.

1 Edit an existingi nstal | er. xm file so that it has the hostname of the server where you want
to perform the silent installation and copy it to that server.

2 Inthe directory where the installation program is located, use the appropriate command to run
the Vibe installation program, depending on the action that you want the silent installation to
perform:

.linstaller-teamng.linux --silent --instal
.linstaller-teamng.linux --silent --upgrade
.Jinstaller-teamng.linux --silent --reconfigure

The Installation program obtains all the information it needs from thei nst al | er. xm file and
completes the installation without user interaction. If you have manually modified index server
scripts, such as the i ndexser ver - st art up. sh file as described in “Installing the Lucene
Software” on page 137, all modifications will be lost when you perform a silent upgrade. To
retain your modifications, you should upgrade with the GUI installation program, as described
in “Using the GUI Installation Program” on page 71.

Creating the Vibe Database

Before you can start Vibe, you need to create the Vibe database.

1 If you haven’t done so already, install the database on the Vibe server.
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For single-server installations running on Linux, we recommend that you install the PostgreSQL
database, but other databases are also supported (see Step 3). For information about how to
install the database on the Vibe server (on Linux), see “PostgreSQL on Linux” on page 66.

For more information about installing the database for a multi-server Vibe system, see
Chapter 19, “Creating the Vibe Database on a Remote Server,” on page 129.

Ensure that the database already exists on the server that is running the Vibe software or on
the remote server, depending on where you want to install the database.

In the terminal window as r oot , change to the following directory, as follows:
cd /vibe_installation_source/tenp-installer/db/scripts/sq

This directory contains the following scripts, one for each database type (MySQL/MariaDB,
Microsoft SQL, Oracle, and Postgresqgl):

+ nysql - creat e- enpt y- dat abase. sq|

+ oracl e-creat e-enpty-dat abase. sql

+ postgresql - creat e- enpt y- dat abase. sql
+ sqgl server-create-enpty-dat abase. sql

(Optional) If you need to change the default database name from si t escape to something
else, edit the . sql file for your database type to replace si t escape with the new name.

Use the database utility command for your database type to run the corresponding script for
your database from the vi be_instal | ati on_source/tenp-installer/db/scripts/
sql directory:

MysQL/ nysql -uadm n-username -ppassword < "mysql -create-enpty-
MariaDB:  dat abase. sqgl "

Microsoft  psql -Uadm n-usernane -Ppassword -i sql server-create-enpty-
sQL: dat abase. sql

You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85¢c-
27ed01cf6b02&displaylang=en) to create the database.

Oracle: sql plus "/ as sysdba"
SQ.>spool update-oracle.out;cd
SQ.>@r acl e- creat e- enpt y- dat abase

SQ>quit;
Postgresql: psql -Uadmi n-usernane < "postgresql -create-enpty-database. sql "

You are prompted for the password that you set for the admin user.

Change to the db directory in the Vibe installation:
cd /vibe_installation_source/tenp-installer/db
This directory contains the following properties files:

+ nysql -1i qui base. properties

¢ Oracl e-liquibase. properties

¢ postgresql-1iqui base. properties

¢ sql server-1iqui base. properties
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10

11

In a text editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and r ef er enceDri ver sections. Save and close the
text editor when you are finished making changes.

¢ Change the user nane, passwor d, r ef erenceUser nane, and r ef er encePasswor d
fields to reflect the username and password for accessing your database.

+ (Conditional) If the database is running on a remote server, replace | ocal host with the IP
address of the remote server.

+ (Optional) If you changed the database name in Step 4 on page 74, change the ur| and
r ef er enceURL fields to reflect name of your Vibe database.

Save and close the text editor.

In the same directory, execute the following commands to create the database schema:
PATH=/ opt/ novel | / t eami ng/ j r e/ bi n: $PATH

./ manage- dat abase. sh dat abase_t ype updat eDat abase

where database_type is one of the following: mysql , or acl e, post gresql , or sql server.

NOTE: Extending the schema can take a while. Wait until the command prompt reappears.
You can safely ignore the following Liquibase log messages:

* VWarning: nodi fyDataType will |ose prinary key/ autoi ncrenent/not nul |
settings for nysql

+ Any messages that contain the wordsi nfo: failureorinfo: failed,aslongasthey
are associated with a type | NFOmessage

Start the Vibe server as described in “Starting Vibe on Linux” on page 78.
For security reasons, delete the password that you specified in Step 7:
10a Change to the following directory in your Vibe installation:

cd /vibe_ installation_ source/tenp-installer/db

10b In a text editor, open the database script that corresponds with your database type to
delete the password.

10c Save and close the properties file.

Continue with “Performing Post-Installation Tasks on Linux” on page 75.

Performing Post-Installation Tasks on Linux

*

*

*

*

“Checking for Available Hot Patches” on page 76

“Configuring Vibe to Start Automatically on Reboot” on page 76
“Disabling Automatic Starting on Reboot” on page 76

“Setting Up Port Forwarding” on page 77

“Starting Vibe on Linux” on page 78

“Checking the Status of the Vibe Server” on page 79
“Restarting Vibe” on page 79

“Stopping Vibe” on page 79

“Uninstalling Vibe” on page 79
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Checking for Available Hot Patches

After you install Vibe, ensure that you check the Vibe download site where you downloaded the
Vibe software for any hot patches that might be available.

Configuring Vibe to Start Automatically on Reboot

You can configure Vibe to start automatically each time you reboot the Linux server.
1 Asthe Linuxr oot user, enter the following command:
systentt| enabl e vibe. service

The system returns a message that a symlink has been created.

2 To verify that automatic startup is turned on, enter the following command:
systentt| status vibe. service
The system returns a message containing
Loaded: | oaded (/usr/lib/systend/systentvibe.service; enabled;

indicating that autoload is enabled.

IMPORTANT: Configuring Vibe to start automatically on a reboot doesn’t start the Vibe service.
You must still use the systentt| start vibe. servi ce command or restart the server to
start Vibe.

Disabling Automatic Starting on Reboot

If you have configured Vibe to start automatically each time you reboot the Linux server and you
want to disable this, do the following.

1 Asthe Linux r oot user, enter the following command:
systentt!| disabl e vibe.service

The system returns a message that a symlink has been removed.

2 To verify that automatic startup is turned off, enter the following command:
systentt| status vibe. service
The system returns a message containing
Loaded: | oaded (/usr/lib/systend/systentvibe.service; disabled;

indicating that autoload is disabled.

IMPORTANT: Disabling autostart on a reboot doesn’t stop the Vibe service. You must still use
the systentt| stop vi be. servi ce command or restart the server to stop Vibe.
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Setting Up Port Forwarding

In order to make Vibe available on the default HTTP/HTTPS ports of 80 and 443, you must set up
port forwarding in order to forward the browser default ports (80 and 443) to the Vibe server ports
(8080 and 8443). In addition, you must set up port forwarding if you want to forward the default
SMTP mail host port (25) to the default Vibe internal mail host port (2525).

You can set up port forwarding in one of two ways, depending on whether you are using the Vibe
server as a firewall.

¢ “Using the SuSEfirewall2 File” on page 77
¢ “Using iptables Commands on SLES 12” on page 77

Using the SuSEfirewall2 File
To enable port forwarding on a SUSE Linux server that uses SUSEf i r ewal | 2:

1 Asthe Linux r oot user, open the following file:
/ etc/sysconfig/ SuSEfirewal | 2

2 Find the following line:
FW REDI RECT=""

3 Between the quotation marks, copy and insert the following string:

0/0,i p_address, tcp, 80,8080 0/0,ip_address,tcp, 443, 8443 0/
0, i p_address, tcp, 25, 2525

4 Replacei p_addr ess with the IP address of the Vibe server.

5 Save the SuSEf i r ewal | 2 file, then exit the text editor.

6 Use the following command to restart the firewall:
/sbin/SuSEfirewal | 2 start

7 Use the following command to verify that the default browser ports (80 and 443) have been
forwarded to the Vibe server ports (8080 and 8443) and that the default SMTP mail host port
(25) has been forwarded to the Vibe internal mail host:

i ptabl es-save | grep REDI RECT

Now, users do not need to include a port number in the Vibe site URL.

Using iptables Commands on SLES 12
Complete the following steps to avoid needing to run the iptables commands after every boot:

1 Asthe Linux root user, change to the/ et c/i ni t. d directory.
2 Opentheafter.|ocal filein atexteditor.

3 Copy/past the following commands to the end of the af t er . | ocal file and save the file.
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iptables -t nat -A QUTPUT -d local host -p tcp --dport 80 -j REDI RECT --
to-ports 8080

iptables -t nat -A QUTPUT -d hostnane -p tcp --dport 80 -j REDI RECT --
to-ports 8080

i ptables -t nat -A PREROUTING -d hostnane -p tcp --dport 80 -j REDI RECT
--to-ports 8080

iptables -t nat -A QUTPUT -d |ocal host -p tcp --dport 443 -j REDI RECT -
-to-ports 8443

iptables -t nat -A QUTPUT -d hostnane -p tcp --dport 443 -j REDI RECT --
to-ports 8443

i ptables -t nat - A PRERQUTING -d hostnanme -p tcp --dport 443 -j REDI RECT
--to-ports 8443

iptables -t nat -A QUTPUT -d local host -p tcp --dport 25 -j REDI RECT --
to-ports 2525

iptables -t nat -A QUTPUT -d hostnane -p tcp --dport 25 -j REDI RECT --
to-ports 2525

i ptables -t nat -A PREROUTING -d hostnane -p tcp --dport 25 -j REDI RECT
--to-ports 2525

4 Replace hostname with the hostname or IP address of the Vibe server.

The lines above are wrapped. When you copy/paste them into the text editor, if the lines are
still wrapped, remove the hard returns so that you have nine iptables commands, each on its
own line.

5 Save the /etc/init.d/after.local file, then exit the text editor.

6 Reboot the Vibe server. Port forwarding should now be working again.

Starting Vibe on Linux

To start Vibe services, do the following:

1 In a terminal window, become r oot by entering su - and the r oot password.
2 Enter the following command to start Vibe:
systenctt| start vibe.service

You must execute the t eam ng script as r oot , but the script runs Vibe as the user you selected
in “Identifying Vibe’s Linux User and Group” on page 45 and specified during installation.

3 Ensure that Vibe is ready for work:
3a Change to the following directory:
/ opt/ novel | / t eam ng/ apache-tontat/| ogs
3b Enter the following command to display the end of the Tomcat log:

tail --f catalina.out
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At the end of the log file listing, you should see:
| NFO. Server startup in nnnn s

4 Press Ctrl+C when you finish viewing the cat al i na. out file.

Checking the Status of the Vibe Server

You can see if Vibe is running by checking for its process ID (PID).

1 In a terminal window, enter the following command:
ps -eaf | grep team ng

You should see the Vibe PID number, along with a listing of configuration settings.

Restarting Vibe

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 16, “Performing an Advanced Vibe Installation,” on page 119.
1 Asroot inaterminal window, enter the following command:
systenttl restart vibe.service

You should see the same output as when you originally started Vibe.

Stopping Vibe

1 Asroot in aterminal window, enter the following command:
systenctt| stop vibe.service
You should see the same output as when you started Vibe.

2 To verify that Vibe has stopped, check for its PID number:
ps -eaf | grep teamng

The Vibe PID number, along with a listing of configuration settings, should no longer be
displayed.

Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server
to reclaim disk space. The default Vibe file locations are:

Vibe Software / opt/ novel | / t eam ng

Vibe File Repository and [ var/ opt/novel | /team ng
Lucene Index

MySQL or MariaDB /var/lib/nmysql
Database
Postgresql Database /var/1ib/pgsql
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For a complete list of your Vibe files, check the i nst al | er. xm file in the directory where you
originally ran the Vibe installation program.

Windows: Installing and Setting Up a Basic Vibe Site

You should already have reviewed Chapter 8, “Planning a Basic Vibe Installation,” on page 41 and
filled out the Basic Installation Planning Worksheet. The following sections step you through the
process of installing and starting Micro Focus Vibe on Windows:

+ “Performing Pre-Installation Tasks on Windows” on page 80
+ “Running the Windows Vibe Installation Program” on page 81
+ “Creating the Vibe Database” on page 82

+ “Performing Post-Installation Tasks on Windows” on page 84

Performing Pre-Installation Tasks on Windows

+ “Verifying System Requirements” on page 80
+ “Stopping an Existing Web Server” on page 80

+ “Setting Environment Variables” on page 80

Verifying System Requirements

Ensure that the Windows server where you plan to install Vibe meets the system requirements listed
in “Server Operating System Requirements” on page 23.

Stopping an Existing Web Server

If a web server is currently running on the Vibe server, stop it, and preferably disable it.
For example, to stop and disable the Internet Information Services (IIS) web server:

1 On the Windows desktop, click Start > Administrative Tools > Services.

2 Right-click World Wide Web Publishing Service, then click Properties.

3 In the Startup type drop-down list, select Disabled.
4 Click Stop, then click OK.

Setting Environment Variables

Ensure that the Windows PATH environment variable includes the path to your database server.

1 Right-click My Computer, then click Properties.
2 On the Advanced tab, click Environment Variables.
3 Check the PATH environment variable:
3a On the Advanced tab, click Environment Variables.

3b In the System variables list, locate the PATH environment variable.
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3c If the path includes your database server software directory, click Cancel.
or

If the path does not include your database server software directory, add the directory,
then click OK.

Running the Windows Vibe Installation Program

1 Login to the Windows server as a user with Administrator rights.

2 In Windows Explorer, browse to the directory where you downloaded and extracted the Vibe
software.

3 Ensure thatthereisal i cense-key. xmi file in the directory.

The Vibe installation program does not start without a license file, and it has a different name
when you download it.

For more information about licensing, see Chapter 13, “Updating Your Vibe License,” on
page 89.

4 Double-click thei nstal | er -t eam ng. exe file to start the Vibe installation program.

5 Accept the License Agreement, then click Next.

, :
CIETETEIEE

Installation Options

Select the action you want to perform. N

' New installation
" Update software and settings

" Reconfigure settings

6 Click Next to accept the default of New installation.

[ a
s vt v e S ==

Choose Installation Type N

Select the type of installation you want to perform

Select the Basic installation if you do not want te configure any of
| Advanced the optional festures. |

7 Click Next to accept the default of Basic.

8 Use the information that you have gathered on the Basic Installation Planning Worksheet to
provide the information that the Vibe installation program prompts you for:

Installation Locations
Default Locale for Micro Focus Vibe
Network Information
WebDAV Authentication Method
Database Selection

Database Type

JDBC URL
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10

11

Credentials
Setup
Encryption Algorithm
Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User Name, Password, and Authentication
Allow Sending Email to All Users
Inbound Email Configuration
Adding File Types for HTML Conversions

The installation program stores the information that it gathers in the i nst al | er. xml file in
the same directory where you started the installation program.

After you have provided all the requested information, click Install to begin the Vibe installation.
When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the i nst al | er. | og file in the same
directory where you ran the Installation program. If a problem arises during the installation, the
i nstal |l er. | og file provides information that can help you resolve the problem.

Continue with “Creating the Vibe Database” on page 82.

Creating the Vibe Database

IMPORTANT: The following procedures are performed at the command prompt.

Before you can start Vibe, you need to create the Vibe database.

1

If you haven’t done so already, install the database on the Vibe server.

For single-server installations running on Windows, install either the MySQL/MariaDB,
Postgresql, or Microsoft SQL database. (For information about how to install the PostgreSQL,
MySQL or MariaDB database on the Vibe server (on Windows), see “PostgreSQL on Windows”
on page 68 and “MySQL or MariaDB on Windows"” on page 65).

For more information about installing the database for a multi-server Vibe system, see
Chapter 19, “Creating the Vibe Database on a Remote Server,” on page 129.

Open a command prompt window, then change to the following directory in your Vibe
installation:

vibe_ installation\tenp-installer\db\scripts\sq

This directory contains the following scripts for each database type (MySQL/MariaDB, Microsoft
SQL, and Oracle):

+ nysql - creat e- enpt y- dat abase. sq

¢ Oracl e-create-enpty-dat abase. sql

+ postgresql - creat e-enpt y- dat abase. sq
+ sgl server-create-enpty-database. sq

(Optional) If you need to change the default database name from si t escape to something
else, edit the . sql file for your database type to replace si t escape with the new name.
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4 Open a command terminal, then use the database utility command for your database type to
run the corresponding script for your database from the vi be_i nstal | ati on_sour ce/
temp-installer/db/scripts/sql directory:

MysQL/ nysqgl -uadm n-username -ppassword < "mysql -create-enpty-
MariaDB:  dat abase. sqgl "

Microsoft psql -Uadmi n-usernane -Ppassword -i sql server-create-enpty-
saL: dat abase. sql

You can also use the script with the SQL Server Express Utility (http://www.microsoft.com/
downloads/details.aspx?familyid=fa87e828-173f-472e-a85¢c-
27ed01cf6b02&displaylang=en) to create the database.

Oracle: sql plus "/ as sysdba"
SQ.>spool update-oracle. out;
SQ.>@r acl e- creat e- enpt y- dat abase

SQ>qui t;

Postgresql: psql -Uadm n-usernane <

post gresql - creat e- enpt y- dat abase. sql "

You are prompted for the password that you set for the admin user.

5 Change to the db directory in the Vibe installation:
vibe_installation_source\tenp-installer\db
This directory contains the following properties files:

+ nysql -1iqui base. properties

¢ Oracl e-liquibase. properties

¢ postgresql-1iqui base. properties
+ sqgl server-1iquibase. properties

6 In atext editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and r ef er enceDr i ver sections. Save and close the
text editor when you are finished making changes.

¢ Change the database user name and password for accessing the database.
¢ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace | ocal host with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database
is si t escape, the name of the company that previously developed the Vibe software).

7 In the same directory, execute the following commands to create the database schema:
SET PATH=C:\ Program Fi | es\ Novel | \ Teanmi ng\j r e\ bi n; %PATH%
nmanage- dat abase. bat dat abase_t ype updat eDat abase
For example, if you are using a Microsoft SQL database:

SET PATH=C.\ Program Fi | es\ Novel |\ Teani ng\j r e\ bi n; %PATH%
nmanage- dat abase. bat sql server updat eDat abase
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NOTE: You can safely ignore the following Liquibase log messages:

+ VWarning: nodi fyDataType will | ose primary key/ autoi ncrement/not nul |
settings for mnysql

+ Any messages that contain the wordsi nfo: failureorinfo: fail ed,aslongasthey
are associated with a type | NFOmessage

8 Start the Vibe server as described in “Running Vibe as a Windows Service” on page 84 and
“Running Vibe as a Windows Application” on page 86.

9 For security reasons, delete the password that you specified in Step 7:
9a Change to the following directory in your Vibe installation:
vibe_instal |l ation_source\tenp-installer\db

9b In a text editor, open the database script that corresponds with your database type to
delete the password.

10 Continue with “Performing Post-Installation Tasks on Windows” on page 84.

Performing Post-Installation Tasks on Windows

+ “Checking for Available Hot Patches” on page 84
¢ “Running Vibe as a Windows Service” on page 84
¢ “Running Vibe as a Windows Application” on page 86

¢ “Uninstalling Vibe” on page 86

Checking for Available Hot Patches

After you install Vibe, ensure that you check on the Vibe download site where you downloaded the
Vibe software for any hot patches that might be available.

Running Vibe as a Windows Service

+ “Removing Vibe as a Windows Service” on page 84

+ “Configuring Vibe as a Windows Service” on page 85

+ “Starting Vibe as a Windows Service” on page 85

+ “Configuring the Vibe Service to Start Automatically on Reboot” on page 85
+ “Restarting the Vibe Service” on page 86

* “Stopping the Vibe Service” on page 86

Removing Vibe as a Windows Service

The Vibe installation program creates a ser vi ce. bat file that you can use to remove the Vibe
service.

1 Inthec:\ Program Fi | es\ Novel | \ Team ng\ apache-t ontat\ bi n\ wi ndows directory,
copy the files from the appropriate subdirectory—x64 ori a64.

If you are unsure which subdirectory is appropriate for your server, use the r eadne. t xt file
located in the windows directory as a reference.
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2 Paste the filesinto the c: \ Program Fi | es\ Novel I \ Teani ng\ apache-t ontat\bin
directory.

3 In a Command Prompt window, change to the following directory:
c:\Program Fi | es\ Novel | \ Team ng\ apache-tontat\ bin

4 Use the following command to configure Vibe as a Windows service:
service. bat renove Teani ng

This removes a service named Apache Tomcat Teaming.

Configuring Vibe as a Windows Service

The Vibe installation program created a ser vi ce. bat file for configuring Vibe to run as a Windows

service.

1 Ina Command Prompt window, change to the following directory:
c:\Program Fi | es\ Novel | \ Team ng\ apache-tontat\ bin

2 Inthe wi ndows directory, copy the files from the appropriate subdirectory.
The following subdirectories exist: x64 ori a64.

If you are unsure which subdirectory is appropriate for your server, use the r eadne. t xt file
located in the c: \ Program Fi | es\ Novel | \ Tean ng\ apache-t ontat\ bi n\ wi ndows
directory as a reference.

3 Paste the files into the ¢: \ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\bin
directory.

4 Use the following command to configure Vibe as a Windows service:
service. bat install Team ng

This creates a service named Apache Tomcat Teaming.

Starting Vibe as a Windows Service

IMPORTANT: If you named your Vibe service something other than “Teaming,” substitute your
service name for Teaming in the sections that follow.

1 On the Windows desktop, click Start > Administrative Tools > Services.

2 Right-click Apache Tomcat Teaming, then click Start.

Configuring the Vibe Service to Start Automatically on Reboot

When you run Vibe as a Windows service, you can configure Vibe to start automatically each time
you reboot the Windows server.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Properties.
3 In the Startup type drop-down list, select Automatic, then click OK.
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Restarting the Vibe Service

You need to restart Vibe whenever you use the Vibe installation program to make configuration
changes, as described in Chapter 16, “Performing an Advanced Vibe Installation,” on page 119.

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Restart.

3 Close the Services window.

Stopping the Vibe Service

1 On the Windows desktop, click Start > Administrative Tools > Services.
2 Right-click Apache Tomcat Teaming, then click Stop.

3 Close the Services window.

Running Vibe as a Windows Application

+ “Starting Vibe as an Application” on page 86
+ “Stopping Vibe as an Application” on page 86

Starting Vibe as an Application
The Vibe installation program created a st ar t up. bat file for starting Vibe.

1 Ina Command Prompt window, change to the following directory:
c:\Program Fi | es\ Novel | \ Team ng\ apache-tontat\ bin
2 Runthe startup. bat file to start Vibe as an application.

Stopping Vibe as an Application

1 Ina Command Prompt window, change to the following directory:
c:\Program Fi | es\ Novel | \ Team ng\ apache-tontat\ bin
2 Run the shut down. bat file to stop the Vibe application.

Uninstalling Vibe

If you move the Vibe site to a different server, you can delete the Vibe files from the original server
to reclaim disk space. The default Vibe file locations are:

Vibe Software c:\Program Fil es\ Novel | \ Teani ng

Vibe File Repository and c:\ Novel I\ Team ng
Lucene Index

MS SQL Database c:\Program Fil es\M crosoft SQL Server\MSQ.\ Dat a

For a complete list of your Vibe files, check the i nst al | er. xnl file in the directory where you
originally ran the Vibe Installation program.
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1 2 Adding Users to Your Vibe Site

After you have installed Micro Focus Vibe and ensured that Vibe starts successfully, you are ready to
access your Vibe site from your web browser and add users.

+ “Accessing Your Basic Vibe Site as the Site Administrator” on page 87
+ “Creating a User” on page 87
¢ “Adding Vibe Users from Your LDAP Directory” on page 88

Accessing Your Basic Vibe Site as the Site Administrator

1 In your web browser, specify one of the following URLs, depending on whether you are using a
secure SSL connection:

http://vi be_host name
https://vi be_host nanme

Replace vi be_host nane with the hostname or fully qualified domain name of the Vibe server
that you have set up in DNS. If you configured the HTTP ports correctly during installation, you
do not need to include the port number in the Vibe URL.

Fang ol your paEssword

2 If this is the first time you have logged in to the Vibe site, log in using admi n as the login name
and admi n as the password.

The Change Password dialog box is automatically displayed when you first log in to the Vibe site.

If this is not your first time logging in, log in using adm n as the login name and your password.

Creating a User

For information about how to create a local user in the Vibe system, see “Creating a New Local User”
in the Micro Focus Vibe 4.0.5 Administration Guide.
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Adding Vibe Users from Your LDAP Directory

Unless you have a very small Micro Focus Vibe site, you create Vibe users by synchronizing their user
information from an LDAP directory service such as eDirectory, Active Directory, or GroupWise.

For information about how to add users to your Vibe system via LDAP, see “Synchronizing Users and
Groups from an LDAP Directory” in the Micro Focus Vibe 4.0.5 Administration Guide.

IMPORTANT: Consider the following before you add users to your Vibe system:

+ For alarge Vibe site with thousands of users, the synchronization process can consume
substantial server resources and can take some time to complete. Perform the initial import
from the LDAP directory at a time when this processing does not conflict with other activities on
the server.

+ After they are added to the Vibe system, users could log into the Vibe site by using their
eDirectory, Active Directory, or GroupWise user names and passwords. However, you should
not invite users to access the Vibe site until after you have finished setting up the Vibe site, as
described in “Site Setup” in the Micro Focus Vibe 4.0.5 Administration Guide.

88 Adding Users to Your Vibe Site


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#ldap
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#ldap
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bj5cq17
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo

Updating Your Vibe License

Several Vibe license types are available:
¢ Evaluation License: Available from Novell Downloads (http://download.novell.com).

You receive your 60-day evaluation license when you download the evaluation version of Vibe.

+ Standard Vibe License: Purchased through a Micro Focus sales representative or Micro Focus
partner.

The Standard Vibe License gives full Vibe functionality on a per-user basis.
After you purchase the Standard Vibe License, you can access your license key or view your
purchase history in the Novell Customer Center (http://www.novell.com/customercenter).

If you are upgrading to a new version of Vibe, or if you originally installed Vibe with an Evaluation
License, it is easy to update your Vibe site with a new license file.

1 Copy the new license file that you downloaded from one of the sources listed above into the
directory where you originally ran the Vibe installation program.

Rename the existing | i cense- key. xm file to a different name.

Rename the new license fileto | i cense- key. xm .

Stop Vibe.

v A W N

Run the Vibe Installation program, select the Reconfigure Settings option, then select the Basic
Installation option.

6 Click Next through all the installation program pages, then click Install to update your Vibe
license.

7 Start Vibe.
8 Log in to the Vibe site as the Vibe administrator.
9 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon .
10 Under Management, click License.
11 If the contents of the new license file are not displayed, click Reload Vibe License.
12 Click Close.

At any time, you can generate a report of license usage, as described in “License Report” in “Site
Maintenance” in the Micro Focus Vibe 4.0.5 Administration Guide.
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Setting Up Vibe

After you have installed and started Micro Focus Vibe, there are still administrative tasks to perform

before your Vibe site is ready for users to log in and use Vibe efficiently. Refer to the following
sections of the Micro Focus Vibe 4.0.5 Administration Guide as you finish setting up your Vibe site.

*

*

*

*

“Setting Up Initial Workspaces”

“Planning and Controlling User Access to Workspaces and Folders”

“Setting Up User Access to the Vibe Site”

“Setting Up Site-Wide Customizations”

“Configuring Email Integration”

“Configuring Weekends and Holidays”

“Configuring Real-Time Communication Tools”
“Enabling Custom JSPs to Be Used on Your Vibe Site”
“Enabling Custom JAR Files to Be Used on Your Vibe Site”
“Setting Up Mirrored Folders”

“Setting Up Zones (Virtual Vibe Sites)”

“Adding Software Extensions to Your Vibe Site”
“Using Remote Applications on Your Vibe Site”

“Managing a Multiple-Language Vibe Site”
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Chapter 15, “Planning an Advanced Vibe Installation,” on page 95

*

Chapter 16, “Performing an Advanced Vibe Installation,” on page 119

*

Chapter 17, “Setting Configuration Options after Installation,” on page 121

*

Chapter 18, “Advanced Vibe Installation Summary Sheet,” on page 123
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5 Planning an Advanced Vibe Installation

The Advanced installation provides additional options for you to customize Micro Focus Vibe.

¢ “What Is an Advanced Installation?” on page 95

+ “Distributing Different Data Types to Different Locations” on page 96
¢ “Using Advanced Network Information Settings” on page 97

+ “Configuring Requests and Connections Configuration” on page 98

+ “Configuring Web Services” on page 99

+ “Changing Your Lucene Index Server Configuration” on page 99

+ “Managing RSS Feeds” on page 101

+ “Configuring Presence” on page 102

+ “Configuring Single Sign-On with Novell Access Manager” on page 103
+ “Configuring Single Sign-On with Internet Information Services for Windows” on page 104
+ “Configuring Mirrored Folder Resource Drivers” on page 116

+ “Installing the Vibe Software in a Clustered Environment” on page 118

As you proceed with planning, you can use the Advanced Vibe Installation Summary Sheet to record

your decisions about the options you want to use.

What Is an Advanced Installation?

In addition to the Basic installation options described in “What Is a Basic Vibe Installation?” on
page 41, the installation program for Vibe provides several advanced installation and configuration
alternatives. You can implement the advanced options after performing a Basic installation, or you
can have the installation program present all the options together.

Compared to a Basic installation, an Advanced installation offers the following additional options:

¢ Changing the session timeout

+ Specifying a keystore file

+ Specifying different directories for different types of data

+ Configuring requests and connections configuration

+ Disabling and enabling four different web services

+ Changing the configuration of the Lucene Index Server

+ Configuring a remote Lucene Index Server or a group of high-availability Lucene nodes
+ Reconfiguring how RSS feeds are retained or disabling them entirely

¢ Enabling presence in conjunction with GroupWise Messenger

+ Configuring a reverse proxy to accommodate single sign-on

+ Configuring Windows Authentication
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+ Configuring mirrored folders

¢ |Installing Vibe in a clustered environment

IMPORTANT: The following Vibe configurations require that you perform an Advanced installation as
your initial installation of the Vibe software:

+ Setting up the Vibe file repository so that some types of files are located outside the Vibe file
repository root directory. See “Distributing Different Data Types to Different Locations” on
page 96 for Advanced installation instructions. You cannot move subdirectories within the Vibe
file repository after they have been created.

+ Installing the Vibe software on multiple servers to create a clustered environment. See
Chapter 21, “Running Vibe on Multiple Servers,” on page 141 for Advanced installation
instructions. The option to enable a clustered environment is available only during an Advanced
installation.

If you want to implement an Advanced installation option, you should perform a Basic installation
first, in a test environment, before performing the Advanced installation to set up your permanent
Vibe site.

Distributing Different Data Types to Different Locations

The default location for the Micro Focus Vibe file repository varies by platform:

Linux: [var/opt/novel | /tean ng

Windows:  ¢:\ Novel | \ Teani ng

Under the main Vibe file repository root directory are subdirectories for various kinds of data files
that are not stored in the Vibe database (MySQL/MariaDB, Microsoft SQL Server, Oracle, or
PostgreSQL). You can use an Advanced installation to store Vibe data files in various locations.

The data files not stored in the Vibe database are divided into several functional areas:
+ Simple file repository: A large consumer of disk space.

All attachment files are stored in the file repository. All versions of files are also stored here.

+ Jackrabbit repository: (Optional) Takes only a fraction of the space consumed by the file
repository.

By default, Vibe stores all data files individually on disk, in the file repository. If you prefer to
store data files in the database itself, you can use Apache Jackrabbit with Vibe. See the Apache
Jackrabbit website (http://jackrabbit.apache.org) for setup instructions.

+ Extensions repository: Disk space consumption depends on the number of extensions you add
to your Vibe site.

An extension is a software program that you can incorporate into your Vibe site in order to
enhance (extend) Vibe capabilities. Adblock Plus is an example of a Firefox browser extension
that filters out advertisements. You or a Java developer can create custom extensions for your
Vibe site. For more information about creating and using Vibe extensions, see the Micro Focus
Vibe 4.0.5 Developer Guide.

Planning an Advanced Vibe Installation


http://jackrabbit.apache.org
http://jackrabbit.apache.org
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_devel/vibe4_devel.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_devel/vibe4_devel.pdf#bookinfo

+ Archive store: A large consumer of disk space.

When entries are deleted, files that were attached to the deleted entries are retained in the
archive store in order to meet compliance and archival goals. Previous versions of documents
are also retained in the archive store. After files have been archived, they are inaccessible from
the Vibe site. Files that accumulate in the archive store must be manually deleted as needed to
manage the disk space occupied by the archive store.

¢ Cache store: Consumes less disk space than the file repository.

Information derived from the attachments (such as thumbnails, HTML renderings, scaled
images), and word lists for indexing are stored in the cache store.

+ Lucene index: Takes only a fraction of the space consumed by the file repository.

The Lucene index contains only pointers to the actual data stored in the file repository. The
index enables the Lucene search engine to perform very fast searches through large quantities
of data.

The directories for the various types of data can be on the Vibe server or on a remote server. Data
access is fastest if the data is local; however, depending on the size of your Vibe site and the types of
data you store, the Vibe server might not be the best place to store all the Vibe data. If you want to
store any of the data types on a remote server, you must ensure that the remote location of the data
appears local to the Vibe server and that it is always available with read/write access.

Linux: Mount the file repository to the Vibe server.
Windows:  Map a drive from the Vibe server to the file repository.

Linux and Place the file repository on a SAN (storage area network) with read/write access. This

Windows alternative provides the most reliable remote location for the Vibe file repository. This is
required for a clustered environment, as described in Chapter 21, “Running Vibe on Multiple
Servers,” on page 141.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Data Locations, specify the directories where you want to store the various types of Vibe data.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 119.

Using Advanced Network Information Settings

¢ “Changing the Vibe Session Timeout” on page 97

+ “Providing a Secure Keystore File” on page 98

Changing the Vibe Session Timeout

By default, if a user’s Micro Focus Vibe session is idle for four hours (240 minutes), Vibe logs the idle
user out. For increased convenience to Vibe users, you can make the session timeout interval longer.
For increased security for your Vibe site, you can make the session timeout shorter.
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ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the session timeout interval (in minutes) for your Vibe site.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 119.

Providing a Secure Keystore File

For your convenience, the Vibe software includes a self-signed public certificate that enables you to
specify secure HTTP and listen ports during installation. This certificate is stored in the . keyst ore
file in the following directory:

Linux: /opt/ novel | /t eam ng/ apache-t ontat/ conf

Windows:  c¢:\ Program Fi | es\ Novel | \ Team ng\ apache-t ontat \ conf

To ensure secure SSL connections for your Vibe site, you should replace the self-signed public
certificate with a public certificate issued by a valid certificate authority.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the name and location of the public certificate.

If you do not already have a permanent public certificate for your Vibe server, see “Securing HTTP
Browser Connections” in “Site Security” in the Micro Focus Vibe 4.0.5 Administration Guide.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 119.

Configuring Requests and Connections Configuration

You can configure the number of client requests and database connections that Vibe is able to
support.

If you have an extremely large Vibe site and you need to make numerous client requests and
database connections, you might see improved performance by increasing these settings.

+ Max Threads: The maximum number of simultaneous client request threads that Vibe is able to
support. The default is 200 threads.

+ Max Active: The maximum number of database connections that can be allocated from this
pool at the same time.

If your database server license (for Oracle or MS SQL) restricts you from having more
connections than the Vibe default of 50, you must specify a number that does not exceed your
database server license.
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+ Max Idle: The maximum number of database connections that can be idle in this pool at the
same time. The default is 20 connections.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Requests and Connections Configuration, mark the maximum client request threads, maximum
active database connections, and maximum idle database connections.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 119.

Configuring Web Services

When you install and set up your Micro Focus Vibe site, three web services are enabled by default; a
fourth is available for selection. These web services enable programs to access information on your
Vibe site just as users would. Allowing programmatic access to your Vibe site can be useful or can be
viewed as a security risk.

+ WSS authentication: Uses OASIS Web Services Security (WSS) (http://www.oasis-open.org).

+ HTTP Basic authentication: Uses HTTP Basic Access authentication (http://tools.ietf.org/html/
rfc2617).

+ Token-based authentication: Uses custom Vibe tokens to communicate with Vibe remote
applications. For more information, see “Using Remote Applications on Your Vibe Site” in “Site
Setup” in the Micro Focus Vibe 4.0.5 Administration Guide.

+ Anonymous access: Allows access to your Vibe site without authentication. It is similar to the
Guest access provided for users, as described in “Allowing Guest Access to Your Vibe Site” in
“Site Setup” in the Micro Focus Vibe 4.0.5 Administration Guide.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Web Services, mark which web services you want enabled for your Vibe site. The first three are
enabled by default. The fourth is disabled by default.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 119.

Changing Your Lucene Index Server Configuration

The default Lucene Index Server configuration is appropriate for a medium-sized Micro Focus Vibe
site. If you have a larger Vibe site, you can change its Lucene Index Server configuration.

¢ “Understanding Indexing” on page 100
¢ “Changing Lucene Configuration Settings” on page 100

¢ “Running the Lucene Index Server in Its Own JVM” on page 101
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¢ “Running the Lucene Index Server on a Remote Server” on page 101

¢ “Running Multiple Lucene Index Servers” on page 101

After planning your Lucene configuration, complete the planning process for additional Advanced
installation features as needed, then perform the Advanced installation as described in Chapter 16,
“Performing an Advanced Vibe Installation,” on page 119.

Understanding Indexing

The Lucene Index Server is responsible for indexing all data on the Vibe site so that Vibe users can
easily use the Find and Search features to retrieve the information that they need. Text posted in
folder entries is easy to index, because the formatting is simple. However, text in attached files
arrives in many different file formats, many of which require conversion before the text in the files
can be indexed. Therefore, the Lucene Index Server is dependent on the available file conversion
technology in order to perform its indexing function. For information about the file viewers that
Vibe uses, see “File Viewer Support” on page 29.

The Lucene Index Server provides additional services on your Vibe site in addition to indexing. In
fact, you cannot access your Vibe site if the Lucene Index Server is not running.

Changing Lucene Configuration Settings

If you have an extremely large Vibe site and you need to reindex the Vibe data, you might see
improved performance by increasing these settings.

+ Max booleans: The default is 10000. This means that 10,000 Boolean clauses are allowed in a
guery. You need to increase this only if your Vibe site includes more than 10,000 users, groups,
or teams.

+ RAM in MB that may be used for buffering: The default is 256 MB for remote and high
availability Lucene configurations and 32 MB for local Lucene configurations. This is the amount
of RAM that is allocated for buffering documents and deletions before they are flushed to the
directory. (This setting can be changed only in the Lucene installer; it is not available in the Vibe
installer.)

+ Merge factor: The default is 10. This sets the number of index segments that are created on
disk. When additional index segments are needed, existing segments are merged to keep the
merge factor constant.

+ Network interface for RMI service: (Optional) Specify the IP address or hostname for the
network interface for the RMI (Remote Method Invocation (http://java.sun.com/javase/
technologies/core/basic/rmi/index.jsp)) service.

This is the hosthname of the server where the Lucene Index is installed.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify any Lucene configuration settings that you want to change.
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Running the Lucene Index Server in Its Own JVM

By default, the Lucene Index Server runs in the same Java Virtual Machine (JVM) as the Vibe
software. To leave more memory available for the Micro Focus Vibe software, you can configure the
Lucene Index Server to run in a separate JVM. In this configuration, it communicates with the Vibe
software using the RMI (Remote Method Invocation (http://java.sun.com/javase/technologies/core/
basic/rmi/index.jsp)) port, which by default is 1199.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Lucene Configuration, specify a hostname of | ocal host . Use the default RMI port number
unless it is already in use on the server.

To change from running the Lucene Index Server in the same JVM with Vibe to running it in its own
JVM, you must complete the same steps that you use for setting up the Lucene Index Server on a
remote server. This includes manually installing the Lucene Index Server software on the Vibe server,
as described in Chapter 20, “Installing the Lucene Index Server on a Remote Server,” on page 137.

Running the Lucene Index Server on a Remote Server

If the Lucene Index Server requires more memory, disk space, or CPU resources than are available on
the Micro Focus Vibe server, you can move it to a remote server. This requires installing the Lucene
Index Server software on that server. For instructions, see Chapter 20, “Installing the Lucene Index
Server on a Remote Server,” on page 137.

Running Multiple Lucene Index Servers

Because the availability of the index is critical to the functioning of the Micro Focus Vibe site, you
can install multiple Lucene Index Servers on multiple remote servers to provide high availability. For
instructions, see Chapter 22, “Running Multiple Lucene Index Servers,” on page 149.

Managing RSS Feeds

By default, Micro Focus Vibe users can set up RSS feeds in folders on the Vibe site, as described in
“Viewing Folders as RSS or Atom Feeds” in “Getting Informed” in the Micro Focus Vibe 4.0.5 User
Guide.

+ “Configuring RSS Feeds” on page 102

+ “Disabling RSS Feeds” on page 102
After planning the RSS settings, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 16, “Performing
an Advanced Vibe Installation,” on page 119.
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Configuring RSS Feeds

The following aspects of RSS functionality on your Vibe site are configurable:

+ Max elapsed days: By default, items from RSS feeds are retained on the Vibe site for 31 days.
You can decrease the number of days to reduce the amount of disk space occupied by the RSS
files.

+ Max inactive days: By default, if no one on the Vibe site accesses an RSS feed for 7 days, the
feed is no longer updated. Increase or decrease the retention time for inactive feeds to meet
the needs of Vibe users and disk space considerations.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, specify the number of days that meet the needs of your Vibe site.

Disabling RSS Feeds

Some administrators consider RSS feeds to be a security risk because the RSS feed URL includes user
name and password information. If you do not want Vibe site users to be able to subscribe to RSS
feeds from the Vibe site, you can disable this feature.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under RSS Configuration, mark No.

Configuring Presence

If you are using GroupWise Messenger as your instant messaging solution, you can configure Micro
Focus Vibe to display a user’s Messenger presence information. For information about where
presence information is displayed in Vibe, see “Sending an Instant Message from within Vibe” in the
Micro Focus Vibe 4.0.5 User Guide.

When you click a user’s presence icon, the Profile Quick View is displayed. This enables you to send
an instant message to the user, view the user’s personal workspace, follow the user, and more.

In order to configure Messenger presence to be displayed in Vibe, you need the following
information about the Messenger system during the Vibe installation:

+ Server address: Specify the IP address or DNS hostname of the messaging agent for your
Messenger system.

+ Port: Specify the port number.

+ Server user: Specify the Messenger user you created and assigned as the Service ACL in

“Integrating Micro Focus Vibe with GroupWise Messenger” in the GroupWise Messenger 18
Administration Guide.

+ Password: Specify the password for the Allowed Service User that you want to log in to the
Messenger system and retrieve presence information.

For more information about the Allowed Service User, see “Integrating Micro Focus Vibe with
GroupWise Messenger” in the GroupWise Messenger 18 Administration Guide.
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+ Server Certificate: Browse to and select the Messaging Agent’s SSL certificate. Vibe uses this
certificate to identify the Messenger server.

If Messenger is installed on a separate server, copy the certificate from the Messenger server
and place it in a location on the Vibe server that can be reached from the Vibe installation
program.

The certificate is located in the following directory on the Messenger server:

Linux: / opt/novel | / messenger/certs

Windows: c:\ Novel I\ Messenger\certs

To remove the certificate after you have already selected it, click Browse > Cancel.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Presence Configuration, select Enable GroupWise Messenger Presence, then list the
information that the Vibe site needs to know in order to communicate with the Messenger system.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 119.

IMPORTANT: In order for Messenger presence to display in Vibe when using LDAP, you need to map
pr esencel Dto your authentication attribute in the Vibe LDAP configuration page. For example,
presencel D=cn. For more information, see “Configuring Presence” in the Micro Focus Vibe 4.0.5
Administration Guide

Configuring Single Sign-On with Novell Access Manager

Novell Access Manager provides secure single sign-on access to your Micro Focus Vibe site by
functioning as a reverse proxy server. Access Manager 3.1 SP1 IR1 is required for use with Micro
Focus Vibe. You can download the required version of Access Manager from Novell Downloads
(http://download.novell.com).

For background information about setting up Novell Access Manager 3.1, see the Access Manager
3.1 Documentation website (http://www.novell.com/documentation/novellaccessmanager31). For
instructions specific to Vibe, see “Configuring a Protected Resource for a Micro Focus Vibe Server” in
the Micro Focus Vibe 4.0.5 Administration Guide.

After you have configured Novell Access Manager, you must configure your Vibe site with the IP
address of one or more Access Gateway servers and with the logout URL. When you configure the
Vibe site to use the Access Gateway, the IP addresses that you specify are the only locations from
which the Vibe site accepts logins. The logout URL is the location where users find themselves when
they log out of the Vibe site.

When you enable the Access Gateway for use with your Vibe site, all Vibe users must log in through
the Access Gateway. It is not possible to set up the Vibe site so that some users log in through the
Access Gateway and some do not.
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ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Reverse Proxy Configuration, list one or more IP addresses of Access Gateway servers that have
been configured for use by Vibe. List the logout URL, and if necessary, the Access Gateway hostname
for WebDAV connections.

Complete the planning process for additional Advanced installation features as needed, then
perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 119.

Configuring Single Sign-On with Internet Information
Services for Windows

Like Novell Access Manager, Windows Authentication provides Windows users with a single sign-on
experience, enabling users to automatically authenticate to Micro Focus Vibe after they log in to
their individual workstations. Internet Information Services (11S) provides this capability.

Before you implement Windows Authentication, consider the following limitations:
+ |IS is best suited for an intranet environment. Because NTLM is a connection-based protocol, it
does not work well with HTTP proxy servers.

+ IS does not support Guest Access.

After you configure the Vibe server to support Windows Authentication, complete the planning
process for additional Advanced installation features as needed, then perform the Advanced
installation as described in Chapter 16, “Performing an Advanced Vibe Installation,” on page 119.

+ “System Requirements” on page 104

+ “Planning Your IIS Installation and Configuration” on page 106

+ “Configuring the Vibe Server to Support Windows Authentication” on page 107

+ “Running the Vibe Installation Program” on page 112

+ “Configuring Your Browser to Allow Access to the Vibe Site” on page 112

+ “Bypassing Windows Authentication to Configure LDAP and Perform Other Tasks” on page 113

+ “Logging In to the Vibe Site through Windows Authentication” on page 114

+ “Editing Files through WebDAV with Windows Authentication” on page 114

+ “Configuring IIS to Allow Uploading of Large Files to the Vibe Site” on page 115

+ “Configuring IIS to Load Balance in a Clustered Environment” on page 115

System Requirements

Windows Authentication with 1IS can be enabled for Vibe only in the following environments:
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Server

* Windows 2008 Server
* Windows 2008 R2 Server

s

+ IS 7 with IIS Manager with CGl and ISAPI components
+ [IS 7.5 with 1IS Manager with CGI and ISAPI components

Authentication Protocol

One of the following authentication protocols:

¢ NTLM
+ Kerberos v5
+ Negotiate/SPNEGO (wrapper for NTLM and Kerberos v5)

Domain Controller

¢ Active Directory Service

Vibe needs to be configured and synchronized with your Active Directory directory service. For
more information about configuring LDAP synchronization within Vibe, see “Gathering
Directory Services Information” on page 59 and “Synchronizing Users and Groups from an LDAP
Directory” in the Micro Focus Vibe 4.0.5 Administration Guide.

If you are using Kerberos as your authentication protocol, then Key Distribution Services is also
required.

For more information about installing and configuring the domain controller and other domain
services to support Windows Authentication, refer to the appropriate Microsoft
documentation.

Client

One of the following clients:

* Windows 7
* Windows XP

Browser

One of the following browsers, configured to support Windows Authentication:

+ Internet Explorer

* Firefox

For information on how to configure your browser to support Windows Authentication, see
“Configuring Your Browser to Allow Access to the Vibe Site” on page 112.
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Planning Your IIS Installation and Configuration

Use the information in the following table as you consider your IIS installation.

Directory: The default installation directory for the IIS plug-inis C: \ Progr am Fi | es\ Novel | .
This is the recommended directory. If for some reason you choose to install the IS plug-in in a
directory other than the C: \ Program Fi | es\ Novel | directory, you need to modify the

i sapi _redirect. properti es files, as described in “Installing the Vibe IS Plug-In” on

page 107.

External or Local Server: You can install the IIS plug-in on the same server where you are running
Vibe, or you can install it on an external server. Installing IS on an external server can have the
following benefits:

* Performance improvement
+ Ability to integrate with several Vibe servers in a clustered environment

¢ Ability to run Vibe from a non-Windows server

If you are running IIS from an external server, you need to edit the C. \ Pr ogr am
Fil es\Novel I\Vibe IS Pl ugin\conf\workers. properti es file, as described in
“Installing the Vibe IIS Plug-In” on page 107.

64-bit/32-bit: You can install the IIS plug-in on a 64-bit or 32-bit operating system. However, Vibe
should run on a 64-bit operating system; therefore, if you install 1IS on a 32-bit operating system,
you should use an external server.

HTTP Ports: Regardless of whether IIS and Vibe are located on the same server or separate
servers, the HTTP port and secure HTTP port for Vibe should always be 80 and 443. This ensures
that when links are generated, they contain the correct hostname and port number.

These are the ports that Vibe uses to refer to the browser. In a very basic Vibe system (single

server without Windows Authentication), the HTTP ports can be the same as the listen ports.
However, in a Vibe system with Windows Authentication enabled, the HTTP ports correspond
with the ports that the IIS server is configured to use.

Listen Ports: If you plan to run IIS on the same server as the Vibe server, you need to set the listen
port and secure listen port for Vibe to something other than 80 and 443.

By default, Vibe listens on ports 80 and 443. Because IIS also uses these ports to listen on, you
must reconfigure the Vibe listen ports to ports that are not currently in use, such as 8080 for the
listen port and 8443 for the secure listen port.

You configure Vibe ports during the Vibe installation, as described in Chapter 16, “Performing an
Advanced Vibe Installation,” on page 119.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Network Information, specify the HTTP ports and listen ports.

Under Integration with IS for Windows Authentication, select Enable Integration with IIS for
Windows Authentication, then list the logout URL.
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Configuring the Vibe Server to Support Windows Authentication

To configure the Vibe server to support Windows Authentication, you must first configure IIS. You
can set up lIS on the same server where Vibe is running, or on a separate server. See “Planning Your
IS Installation and Configuration” on page 106 for more information.

Complete the instructions in the following sections to ensure that IIS is configured correctly to work
with Vibe.

¢ “Installing the Vibe IIS Plug-In” on page 107

¢ “Installing ISAPI and GCI” on page 108

+ “Installing Windows Authentication Role Service” on page 108

+ “Creating and Managing Vibe Resources with IIS Manager” on page 108

Installing the Vibe IIS Plug-In

1 Locate thet eam ng-versi on-iis-plugin. zi p file from the Vibe distribution, then unzip it
into the C:\ Program Fi | es\ Novel | directory.

This creates a directory called Vi be 11S Pl ugi n.

2 Ifin Step 1 you chose to unzip the t eani ng- ver si on-ii s-pl ugi n. zi p file into the
C.\ Program Fi | es\ Novel | directory, continue with Step 3.

or

If in Step 1 you chose to unzip the t eani ng- versi on-ii s-pl ugi n. zi p file into a location
other than C:\ Program Fi | es\ Novel | , you must complete the following steps:

2a Locate thei sapi _redirect. properti es file in each of the following directories:
¢ Vibe II'S Plugin\resourcesl\hbin
¢ Vibe II'S Plugin\resources2\bin
2b In each of the directories, open the i sapi _redi rect. properti es file in a text editor.

2c Adjust the values of thel og_fil e, worker _fil e andwor ker _mount _fil e properties
to reflect the directory where you chose to unzip the t eam ng-version-iis-
pl ugi n. zi p file.

2d Save your changes and close both of the i sapi _redi rect. properti es files.
3 If lIS and the Vibe server are located on the same server, continue with Step 4.
or
If IS and the Vibe server are located on separate servers, complete the following steps:

3a Locatethe C:\ Program Fil es\ Novel [\Vibe I1S
Pl ugi n\ conf\ wor kers. properti es file.

3b Open the wor kers. properti es file in a text editor.

3c Adjust the value of the wor ker . wor ker 1. host property from | ocal host to the
hostname or IP address of the Vibe server.

3d Save your changes and close the editor.

Planning an Advanced Vibe Installation 107



4 (Conditional) If you are running IIS on a 64-bit server, complete the following steps:

da Locate the C:\ Program Fi | es\ Novel I\Vibe IS Plugin\library\w n64
directory.

4b Copy the appropriate version of the . dl | library and paste it into each of the following
directories:

¢ C\Program Fil es\Novel I\Vibe 11S Pl ugin\resourcesl\bin
¢ C\Program Fil es\Novel I\Vibe I1S Pl ugin\resources2\bin

Ensure that you copy the correct version of the . dl | library. If you copy the incorrect
version, you receive a 500 error when you try to access the Vibe site.

4c Delete the existing i sapi _redirect. dl| files from the C.\ Program
Fil es\ Novel I\Vibe IS Pl ugin\resourcesl\ bi ndirectory, as well as from the
C.\Program Fi |l es\ Novel I\Vibe I1S Pl ugi n\resources2\ bi n directory.

4d Rename the . dl | library files that you copied in Step 4btoi sapi _redirect.dl .

For example, if Vibe is running on an AMD64/EM64T platform, copy C. \ Pr ogr am

Fil es\Novel I\Vibe II'S Plugin\library\w n64\and64\i sapi _redirect-
version.dl | intothe C:\ Program Fi |l es\ Novel I\Vibe IS

Pl ugi n\resources1\binand C.\ Program Fi | es\ Novel I\Vibe |IS

Pl ugi n\ r esour ces?2\ bi n directories, then delete the original i sapi _redirect.dl |
file and renamei sapi _redirect-version.dl| toisapi _redirect.dll.

Installing ISAPI and GCI

1 Install the ISAPI and CGIl components:
1a Launch the Web Platform Installer.
1b Search for isapi.

1c Add both the extensions and filters.

Installing Windows Authentication Role Service

If the Windows Authentication Role Service is not already installed, use the Add Roles and Features
Wizard to add "Windows Authentication" to 1IS/Web Server/Security.

Creating and Managing Vibe Resources with 1IS Manager

Internet Information Services (IIS) Manager is used to complete the integration.

1 Click Start > Administrative Tools > Internet Information Services (1IS) Manager.
2 In the Connections pane on the left side of the window, expand your server, then expand Sites.
3 Right-click Default Web Site, then click Add Virtual Directory.

The Add Virtual Directory dialog box is displayed.
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Add Virtual Directory

2l x|

Path: !

Site name;  Default Web Site

Alizs:

Example: images

Physical path:

—

Pass-through authentication

Connect as. ..

Test Settings. .. |

OK I Cancel

4 In the dialog box, specify the following information:

Alias: Vi beResour ces1

Physical path: C: \ Program Fi | es\ Novel [\Vibe IS Pl ugin\resourcesl\bin

5 Click OK.

6 Repeat Step 3 through Step 5 to add another virtual directory.

This time, specify the following information in the Add Virtual Directory dialog box:

Alias: Vi beResour ces?2

Physical path: C: \ Program Fi | es\ Novel [\Vibe IS Pl ugi n\resources2\bin

7 In the Connections panel, select VibeResources1, then double-click Handler Mappings.

“E Internet Information Services (IIS) Manager

@G) [:J P PEN b Sites b Default\WebSite b VibeResourcesl b

Fle View Help

G-k 2|8

- Start Page
= Gﬂ PEN {LPTEAMING \administratar)
£} Application Pools
=-[&] Sites
B Default Web Site
[#(_| VibeResources1
l& VibeResources2

[l |»

EJ Handler Mappings

Use this feature to specify the resources, such as DLLs and managed code,
that handle responses for specific request types.

Group by: State M

Name = [ Path | state
Disabled

CGI-exe “exe Disabled

1SAPT-dIl =dll Disabled
Enabled

OPTIONSVYerbHandler * Enabled

TRACEVerbHandler * Enabled

StaticFile * Enabled

o i

Canfiguration: ‘Default Web Site fvibeResources1' web.config

=10 x|

|5& @ -

Add Managed Handler...
Add Script Map...

Add Module Mapping...
Revert To Inherited

@ rHep

Online Help

Add Wildcard Script Map...

Edit Feature Permissions...

View Ordered List...

%

8 In the Actions pane, click Edit Feature Permissions.
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The Edit Feature Permissions dialog box is displayed.

Permissions:
v Read
IV soript

|7 Execute

CK I Cancel

9 Select Execute, then click OK.
10 Repeat Step 7 through Step 9 for the Vi beResour ces?2 virtual directory.
11 In the Connections pane, select Default Web Site, then double-click ISAPI Filters.
12 In the Actions panel, click Add.
The Add ISAPI Filter dialog box is displayed.

Filter name:

|
Executable:

| .|

oK I Cancel

13 In the dialog box, specify the following information:
Filter name: Vi beResour cesl
You must name the filter Vi beResour ces1 for Windows Authentication to work successfully.

Executable: C.\ Program Fi | es\ Novel I\Vibe I1S
Pl ugi n\resources1\bin\isapi _redirect.dll

14 Click OK.

15 Repeat Step 12 through Step 14 to add another ISAPI filter.
This time, specify the following information in the Add ISAPI Filter dialog box:
Filter name: Vi beResour ces?2

You must name the filter Vi beResour ces2 in order for Windows Authentication to work
successfully.

Executable: C.\ Program Fi | es\ Novel I\Vibe IS
Pl ugi n\resources2\ bi n\isapi _redirect.dll

16 In the Connections pane, select the server, then double-click ISAPI and CGI Restrictions.
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‘E Internet Information Services (IIS) Manager

—loj x|

€3] EEEEE

[ - B e~

File  view Help

€-iH|7 8

& Start Page

Eiij PEN (LPTEAMING \administrator)
; 3 Application Poals

8| Sites

E--@ Default Web Site
Bl-] VibeResources1
] [ VibeResources2

4

| »

a‘il_ ISAPI and CGI Restrictions

Use this feature to specify the ISAPI and CGI extensions that can run on the
Web server,
Group by: Mo Grouping <

I Restriction
TeamingResourc... Allowed

I Path
C:'\Program Files\Mavell\Teamir
C:'\Program Files\Movell\Teamir

Description =

TeamingResourc... Allowed

« | i

Configuration: localhost’ applicationHost. config

17 In the Actions pane, click Add.
The Add ISAPI or CGI Restriction dialog box is displayed.

Add ISAPI or CGI Restriction

ISAPI or CGI path:

2l

Description:

L

I Allow extension path to execute

o |

Cancel

18 In the dialog box, specify the following information:

ISAPI or CGI path: Specify C: \ Program Fi | es\ Novel [\ Vibe IS
Pl ugi n\resourcesl1\bin\isapi _redirect.dll

Description: Vi beResour cesl

Add...

Edit Feature Settings...

@ Help

Online Help

ia51.:5

Allow extension path to execute: Select this option to allow the path to execute.

19 In the Actions pane, click Add.
The Add ISAPI or CGI Restriction dialog box is displayed.
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ISAPI or CGI path:

|| ]

Description:

[T allow extension path to execute

oK Cancel

20 In the dialog box, specify the following information:

ISAPI or CGI path: Specify C: \ Program Fi | es\ Novel [\ Vibe IS
Pl ugi n\resources2\bin\isapi _redirect.dll

Description: Vi beResour ces2

Allow extension path to execute: Select this option to allow the path to execute.
21 In the Connections pane, select VibeResources1, then double-click Authentication.
22 Select Anonymous Authentication, then click Disable in the Actions panel.
23 Select Windows Authentication, then click Enable in the Actions panel.
24 Exit the Internet Information Services Manager.

25 Perform the Advanced installation as described in Chapter 16, “Performing an Advanced Vibe
Installation,” on page 119.

Running the Vibe Installation Program

See “Choosing Windows Authentication” on page 51 for information about how to configure the
Vibe installation program to support Windows Authentication, then follow the instructions for the
advanced installation as described in Chapter 16, “Performing an Advanced Vibe Installation,” on
page 119.

Return here and continue with “Configuring Your Browser to Allow Access to the Vibe Site” on
page 112.

Configuring Your Browser to Allow Access to the Vibe Site

After Windows Authentication has been enabled on the server, you need to configure the client
browser to allow access to the Vibe site.

¢ “Internet Explorer” on page 112
+ “Firefox” on page 113

Internet Explorer

1 In anInternet Explorer window, click Tools > Internet Options.

The Internet Options dialog box is displayed.
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2 Click the Security tab, select Local intranet, then click Sites.

The Local Intranet dialog box is displayed.

3 Click Advanced.

4 |n the Add this website to the zone field, specify the Vibe website.

5 Click Add > Close.

Firefox

1 In Firefox, specify about : conf i g in the URL field.

2 Specify nt | min the Filter window, then locate and select the network.automatic-ntim-
auth.trusted-uris entry.
The Enter String Value dialog box is displayed.

3 Specify the DNS name of your Vibe site, then click OK.
For example, vi be. myconpany. com

4 Repeat Step 2 through Step 3 for network.negotiate-auth.trusted-uris and network.negotiate-

auth.delegation-uris.

Bypassing Windows Authentication to Configure LDAP and
Perform Other Tasks

After Windows Authentication is working on your Vibe server, you can bypass the Windows
Authentication functionality by including the Vibe listening port in the Vibe URL.

You need to do this in order to configure your LDAP directory.

1 In a web browser, specify your Vibe URL with the Vibe listening port.

For example, ht t p: / / vi be: 8080.
The Vibe login page is displayed.

Novell. Vibe

User ID

Password

Forgat your password?

2 Login to the Vibe site as the Vibe administrator.
3 Configure LDAP, as described in “Adding Vibe Users from Your LDAP Directory” on page 88.
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You might also need to bypass Windows Authentication to access Vibe for the following reasons:

+ To access a specific Vibe node in a clustered environment

¢ To troubleshoot the Vibe system

Logging In to the Vibe Site through Windows Authentication

After you have performed the configuration steps described in “Configuring the Vibe Server to
Support Windows Authentication” on page 107 through “Configuring Your Browser to Allow Access
to the Vibe Site” on page 112, users can access the Vibe site through Windows Authentication. Users
who have been configured through LDAP and are already logged in to their individual workstations
do not need to log in again to access the Vibe site. Users who are not already logged in before they
access Vibe see the following dialog box:

x
0 Enter username and password for http://13.6.7.31
User Name: I
Password: I LI
Ok I Cancel |

Editing Files through WebDAV with Windows Authentication

+ “Achieving Single Sign-On When Editing Files through WebDAV” on page 114
+ “Enabling Basic Authentication for WebDAV” on page 114

Achieving Single Sign-On When Editing Files through WebDAV

By default, when you edit a file in Vibe through WebDAV, you are prompted for your system login
credentials before you can edit the file. However, when Windows Authentication is enabled on your
Vibe server, you are no longer prompted for your system login credentials before you edit a file
through WebDAV.

This functionality is supported only when you use Microsoft Office as your default document editor.
When you use LibreOffice as your default document editor, Vibe allows you to edit files through
WebDAV, but it still requires you to enter your system login credentials. The single sign-on
experience is only available when you use Microsoft Office.

Enabling Basic Authentication for WebDAV

If you are using a version of LibreOffice that requires basic authentication (it does not support
Windows Authentication), you need to configure your IIS server to support basic authentication.
Supporting basic authentication enables Vibe users to edit files through WebDAV when using a
document editor other than Microsoft Office.

Planning an Advanced Vibe Installation



NOTE: If you enable basic authentication on your IIS server, all users who access the Vibe site
through Firefox are prompted for their login credentials. Single sign-on to the Vibe server no longer
functions. However, users who access the Vibe site using Internet Explorer retain the single sign-on
experience.

To enable basic authentication on your IIS server, you need to install the Basic Authentication Role
Service.

1 On the Windows 2008 server, click Start > Administrative Tools > Server Manager.

2 Expand Roles, then right-click Web Server (l1S).
Click Add Role Services.

w

The Add Role Services window is displayed.
Scroll to the Security section, then select Basic Authentication.
Click Next, then complete the installation.

Click Start > Administrative Tools > Internet Information Services (IIS) Manager.

N o o un b

In the Connections pane on the left side of the window, expand your server, expand Sites, then
expand Default Web Site.

(<)

Select VibeResources1, then double-click Authentication.
9 Select Basic Authentication, then click Enable in the Actions panel.

10 Close the Internet Information Services (11S) Manager.

Configuring IIS to Allow Uploading of Large Files to the Vibe Site

By default, 1IS might not allow you to upload large files to the Vibe site. This is caused by timeout
restrictions as well as maximum upload size restrictions.

For information about how to configure IIS to allow you to upload large files, see article 925083 in
the Microsoft Support Knowledgebase (http://support.microsoft.com/kb/925083).

Configuring IIS to Load Balance in a Clustered Environment

If you have Vibe installed in a clustered environment where there are multiple Vibe nodes, you can
configure IIS to balance the load of user requests from the multiple Vibe nodes, while still
supporting Windows Authentication.

1 Onthe lIS server, locate the C: \ Program Fi | es\ Novel I\Vibe 11S
Pl ugi n\ conf\ workers. properties.clustered.tenpl at e file, then open the file in a
text editor.

2 Copy the contents of the file.

3 LocatetheC.\ ProgramFil es\ Novel I\Vibe IS Pl ugi n\ conf\workers. properties
file, then open the file in a text editor.

4 Paste the contents of the C: \ Program Fi | es\ Novel [\Vibe IIS
Pl ugi n\ conf\ wor kers. properties. cl ustered.tenpl at e file that you copied in Step 2
andinto the C:\ Program Fi | es\ Novel I\Vibe |1S
Pl ugi n\ conf\ wor kers. properti es file, overwriting the content that was previously there.
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5 Replace the value of worker.workerl.host from first_hostname_or_ip with the hostname or IP
address of your first Vibe node.

6 Repeat Step 5 for each additional Vibe node that is running in your environment. If you have
more than two Vibe nodes, you should add an additional section to the wor ker s. properti es
file for each additional node.

The values that you specify in the wor ker s. properti es file (for example, wor ker 1,

wor ker 2, etc.) must exactly match the values that you specify as the JVM Route setting during
the Vibe installation, as described in “Installing the Vibe Software on Multiple Servers” on
page 142.

7 Locatethe C:\ Program Fi |l es\ Novel I\Vibe I1S
Pl ugi n\ resour ces1\ conf\ uri wor ker map. properti es file, then open the file in a text
editor.

8 Replace all instances of wor ker 1 with bal ancer.
9 Repeat Step 7 and Step 8 for each Vibe node.

10 Locate the C:\ Program Fil es\ Novel I\Vibe 11S
Pl ugi n\ resour ces2\ conf\ uri wor ker map. properti es file, then open the file in a text
editor.

11 Replace all instances of wor ker 1 with bal ancer.
12 Repeat Step 10 and Step 11 for each Vibe node.
13 Restart each Vibe node.
14 Restart the IIS server:
14a Click Start > Administrative Tools > Internet Information Services (1IS) Manager.

14b Select your server in the Connections panel, then click Restart in the Actions panel.

Configuring Mirrored Folder Resource Drivers

A mirrored folder is a directory, either local or shared on a SAN (storage area network), that is
directly accessible from the Micro Focus Vibe site. The files on the file system are accessed by the
Micro Focus Vibe program through a resource driver, not directly by individual Vibe users. A
resource driver defines how the Vibe program accesses the file system.

During installation, you define the users and groups that can access the mirrored folder resource
drivers. After installation, from the Vibe site, you associate resource drivers with specific Vibe
folders and use folder access controls to govern which users and groups can access the data in the
mirrored folder. As a result, you can set up a small number of users who can create mirrored folders,
and allow a larger number of users to access the mirrored folders.

Vibe attempts to keep the metadata about each mirrored folder synchronized with the contents of
the actual file system. Therefore, mirrored folders are most appropriate for large sets of relatively
static data. Mirrored folders are also useful for making extremely large files available from your Vibe
site without including them in the Vibe file repository.
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Although the installation program allows you to set up three mirrored folder resource drivers during
installation, you can set up and test just one to start with, and then set up additional resource drivers
later.

+ “File System Type” on page 117

+ “File System Directory” on page 117

+ “File System Access” on page 118

+ “Mirrored Folder Setup” on page 118
After planning mirrored folders, complete the planning process for additional Advanced installation

features as needed, then perform the Advanced installation as described in Chapter 16, “Performing
an Advanced Vibe Installation,” on page 119.

File System Type

Vibe provides resource drivers for two different types of file systems:

+ file: A directory in a regular file system on a Linux or Windows server.

+ webdav: A directory on a web server that supports WebDAV (Web-based Distributed Authoring
and Versioning). The WebDAV server must support HTTP Basic Authentication (http://
en.wikipedia.org/wiki/Basic_access_authentication) so that Vibe can provide a user name and a
password when making a request from the WebDAV server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, mark the type of directory that you want to
mirror in your Vibe site.

File System Directory

The file system that a Vibe mirrored folder uses can be on Linux, NetWare, or Windows, as long as
the following conditions are met:

+ The file system is accessible from the Vibe server by using a directory path specification that the
Vibe server operating system understands.

+ The file system is accessible through the standard j ava. i 0 package interface.

IMPORTANT: On Windows, you must use forward slashes (/) in the path name, not the typical
Windows backslashes (\). For example, use ¢: / Docunent s rather than c: \ Docunent s.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, specify the full path for the directory that you
want to mirror in your Vibe site. Also, provide a title for the mirrored folder resource driver that
indicates what directory or data is being mirrored. For WebDAV mirrored folders, you must also specify
the URL of the WebDAV host where the data is located.
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If you need to eventually set up more than three directories as mirrored folders in your Vibe site, you
can edittheinstal | er. xnl file in the directory where you run the Installation program.

File System Access

Vibe offers several security options for controlling access to the data that resides on the file system.
+ You can restrict the Vibe program to read-only access to the mirrored data, or you can allow full
read/write access.

* You can list specific Vibe users who are allowed to access the mirrored folder resource drivers
and thereby create mirrored folders.

+ You can list specific Vibe groups whose members are allowed to access the mirrored folder
resource drivers and thereby create mirrored folders.

+ For WebDAV mirrored folder resource drivers, you must also specify a user name and password
that the Vibe program can use to access the WebDAV server.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under Mirrored Folder Resource Driver Configuration, list the file access (read/write or read-only) for
the mirrored data, along with users and groups that you want to have access to the resource driver. For
a WebDAV mirrored folder, list a user name and password that provides access to the WebDAV server.

Mirrored Folder Setup
After you run the Vibe Installation program to configure the Vibe site for mirrored folder resource

drivers, additional folder setup is required. Follow the instructions in “Setting Up Mirrored Folders”
in “Site Setup” in the Micro Focus Vibe 4.0.5 Administration Guide.

Installing the Vibe Software in a Clustered Environment

You must use an Advanced installation in order to install the Micro Focus Vibe software on multiple
servers and set up a clustered environment. Setting up multiple Vibe servers, along with other
clustering options, are described in Chapter 21, “Running Vibe on Multiple Servers,” on page 141.
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6 Performing an Advanced Vibe Installation

You should already have reviewed Chapter 8, “Planning a Basic Vibe Installation,” on page 41 and
filled out the Basic Installation Planning Worksheet. You should also have reviewed Chapter 15,
“Planning an Advanced Vibe Installation,” on page 95 and filled out the Advanced Vibe Installation
Summary Sheet for those aspects of an Advanced installation that you want to implement for your
Micro Focus Vibe site.

1 Follow the Basic installation instructions provided in Chapter 11, “Installing and Setting Up a
Basic Vibe Site,” on page 69 for the platform where you are installing Vibe.

2 When you run the installation program, select Advanced on the Choose Installation Type page.

Novell Vibe 4 Installation Program - x
Choose Installation Type

Select the type of installation you want to perform N

% Basic Select the Advanced installation if you want to configure any
I of the optional features.

3 Use the information that you have gathered on the Basic Installation Planning Worksheet and
the Advanced Vibe Installation Summary Sheet to provide the information that the Vibe
Installation program prompts you for:

Basic Installation Pages:

Installation Locations

Default Locale for Micro Focus Vibe

User ID for Micro Focus Vibe (Linux only)
Network Information

WebDAV Authentication Method
Database Selection

Outbound Email Configuration

Inbound Email Configuration

Some Basic installation pages have additional options available when you perform an Advanced
installation.

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration

Reverse Proxy Configuration

Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
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Vibe Cluster Configuration

The Installation program stores the information it gathersin the i nstal | er. xn file in the
same directory where you started the Installation program.

4 After you have provided all the requested information, click Install to begin the Advanced
installation.

5 When the installation is complete, click Finish to exit the Vibe installation program.

Information about the installation process is written to the i nst al | er. | og file in the same
directory where you ran the Installation program. If a problem occurs during the installation,
thei nstal | er. | og file provides information that can help you resolve the problem.

6 After you complete the Advanced installation, continue setting up your Vibe site, as described
in Chapter 12, “Adding Users to Your Vibe Site,” on page 87.

120  Performing an Advanced Vibe Installation



Setting Configuration Options after
Installation

After you install Micro Focus Vibe, following the instructions in Part Ill, “Basic Installation,” on
page 33 or Part IV, “Advanced Installation and Reconfiguration,” on page 93, you can rerun the Vibe
installation program to change configuration options or add new functionality to your Vibe site.

1 Stop Vibe.
2 Start the Vibe installation program as described in “Running the Linux Vibe Installation

Program” on page 70 and “Running the Windows Vibe Installation Program” on page 81.

Novell Vibe 4 Installation Program = x

Installation Options

Select the action you want to perform.

" New installation
™ Update software and settings
* Reconfigure settings

Because the Installation program finds an existing i nst al | er. xm file, it defaults to
Reconfigure settings.

3 Click Next.
The Vibe Installation program asks you to verify that you have stopped Vibe.
4 Click Yes.

Novell Vibe 4 Installation Program = x
Choose Installation Type

Select the type of installation you want to perform

Select the Advanced installation if you want to configure any

[Basic
| of the optional features.

5 Select Basic or Advanced, depending on the configuration settings that you want to change,
then click Next.

6 Click Next until you reach an installation page where you want to reconfigure settings.
Basic Installation Pages:
Installation Locations

Default Locale for Micro Focus Vibe
User ID for Micro Focus Vibe (Linux only)
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Network Information

WebDAV Authentication Method
Database Selection

Outbound Email Configuration
Inbound Email Configuration

Advanced Installation Pages:

Web Services

Lucene Configuration

RSS Configuration

Presence Configuration

Reverse Proxy Configuration

Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

7 When you reach the Ready to Install page, click Install to implement the reconfigured settings.
8 Start Vibe.
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Advanced Vibe Installation Summary

Sheet

Installation Program Field

Value for Your Vibe Site

Explanation

Data Locations:
Linux default:
[ var/ opt/novel | /team ng
Windows default:
c:\ Novel I \ Team ng
¢ Simple file repository
¢ Jackrabbit repository
¢ Extensions repository

¢ Cache store

¢ Lucene index

See “Distributing Different Data
Types to Different Locations” on
page 96.

Network Information:
¢ Enable web services:

No / Yes

* Session timeout
Default: 240 minutes

¢ Enable Tomcat access log:
No / Yes

* Keystore file:

See “Using Advanced Network
Information Settings” on page 97.

Network Information:
¢ Max Threads

Default: 200
* Max Active

Default: 50
* Max Idle

Default: 20

See “Configuring Requests and
Connections Configuration” on
page 98.
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Installation Program Field

Value for Your Vibe Site

Explanation

WebDAV Authentication Method

¢ basic

¢ digest

See “Planning the WebDAV
Authentication Method” on
page 49.

Web Services:

¢+ Enable WSS authentication
¢ Enable Basic authentication

¢ Enable token-based
authentication

¢ Enable anonymous access

See “Configuring Web Services” on
page 99.

Lucene Configuration:
Configuration type: all
¢ Max booleans:

Default: 10000
* Merge factor:

10

See “Changing Lucene
Configuration Settings” on
page 100.

Server Lucene Configuration:
Configuration type: server only

¢ Host:
¢ RMI port:
Default: 1199

See “Running the Lucene Index
Server in Its Own JVM” on
page 101.

High Availability Lucene
Configuration:

Configuration type: high availability
only

Number of high availability search
nodes:

¢ Service name:
* Service title:
¢ Host:

¢ RMI port:

¢ Service name:
* Service title:
¢ Host:

¢ RMI port:

See Chapter 22, “Running Multiple
Lucene Index Servers,” on
page 149.
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Installation Program Field

Value for Your Vibe Site Explanation

RSS Configuration:

Enable RSS: No / Yes

*

*

Max elapsed days:

Max inactive days:

See “Managing RSS Feeds” on
page 101.

Presence Configuration:

Enable presence: No / Yes

*

*

Server address:
Port:

Server user:
Password:

Server Certificate:

See “Configuring Presence” on
page 102.

Reverse Proxy Configuration:
Enable Access Gateway: No / Yes

¢ Access Gateway address(es):

*

¢ Use Access Gateway for WebDav
connections: No / Yes

Logout URL:

¢ WebDAV Access Gateway

address:

See “Configuring Single Sign-On
with Novell Access Manager” on
page 103.

Integration with IIS for Windows

Authentication:

Enable Integration with IIS for
Windows Authentication: No / Yes

*

*

IIS address(es):
Logout URL:

See “Configuring Single Sign-On
with Internet Information Services
for Windows” on page 104.
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Installation Program Field Value for Your Vibe Site Explanation

Mirrored Folder Resource Driver See “Configuring Mirrored Folder
Configuration: Resource Drivers” on page 116.

Enable file share: No / Yes

¢ Share type
* File
¢ WebDav
¢ Read only: No / Yes
* Title
¢ Root path
* Allowed users
¢ Allowed groups
¢ User
¢ Password

¢ Host URL
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Multi-Server Configurations and
Clustering

¢ Chapter 19, “Creating the Vibe Database on a Remote Server,” on page 129

¢ Chapter 20, “Installing the Lucene Index Server on a Remote Server,” on page 137
¢ Chapter 21, “Running Vibe on Multiple Servers,” on page 141

¢ Chapter 22, “Running Multiple Lucene Index Servers,” on page 149

+ Chapter 23, “Running Multiple Database Servers,” on page 167
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Creating the Vibe Database on a Remote
Server

The default database location for Micro Focus Vibe is on the same server with the Vibe software, as
described in “Database Location” on page 52. However, for better performance and scalability, you
can install the database server (MySQL, MariaDB, Microsoft SQL, Oracle, or PostgreSQL) on a remote
server, and then use the scripts that are included with the Vibe software to manually create the Vibe
database in any location that you prefer.

+ “JDK 9 or Later Required to Run manage-database Script” on page 129

¢ “Creating a MySQL/MariaDB Database” on page 129

¢ “Creating a Microsoft SQL Database” on page 131

¢ “Creating an Oracle Database” on page 133

¢ “Creating a PostgreSQL Database” on page 134

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part I, “Basic Installation,” on
page 33 before attempting a more complex Vibe configuration.

JDK 9 or Later Required to Run manage-database Script

Creating the Vibe database by running the manage-database.sh script as instructed in the following
sections, requires that the server have JDK 9 or later installed. Any Java release, such as IBM, Oracle,
OpenlDK, and so on, meets this requirement.

Creating a MySQL/MariaDB Database

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about MySQL, see the following references:

* MySQL 5.0 Reference Manual (http://dev.mysql.com/doc/refman/5.0/en)
* MySQL 5.1 Reference Manual (http://dev.mysql.com/doc/refman/5.1/en)

For information on installing SLES 12 and using MariaDB, see the SLES 12 Documentation (https://
www.suse.com/documentation/sles-12/) and MariaDB (http://www.mariadb.com) web sites.

The following database tools can be helpful:

+ MySQL GUI Tools (http://dev.mysqgl.com/downloads/gui-tools)
+ SQlyog (http://www.webyog.com)
¢ Squirrel SQL Client (http://squirrel-sql.sourceforge.net)
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To create the MySQL database:

1 Review the MySQL requirements listed in “Database Server Requirements” on page 24.

2 Ensure that the MySQL database server and client have been installed and configured, as
described in “Installing and Running the Database Server” on page 63.

3 Ensure that the MySQL database client is also installed on the Vibe server.

The Vibe installation program needs the MySQL client in order to communicate with the remote
MySQL database server.

4 Ensure that you know the password for the MySQL r oot administrator user.
5 Ensure thati nnodb support is enabled.
It is enabled by default. To verify that i nnodb support is enabled:

5a Enter the following command to access the MySQL monitor:
nysqgl -u root -p

For information on how to set a password for your MySQL database if you have not already
done so, see “Configuring MySQL/MariaDB” on page 64.

5b Specify your password.

5¢ From the MySQL prompt, enter the following command to display status information
about the server’s storage engines:

SHOW ENG NES\ G

5d Locate the InnoDB engine, and ensure that i nnodb support is enabled.
6 Update the MySQL configuration file:

6a Locate the MySQL configuration file and open it in a text editor.

Linux: /etc/ny. cnf

Windows: c¢:\Program Fi | es\ MySQ.\ M\ySQ. Server version\ny.ini

6b Under the [ client] section, add the following line:
default _character_set = utf8

6c Under the [ mysql d] section, add the following line:
character_set_server = utf8

Setting the character set to UTF-8 ensures that extended characters are handled correctly
in the database.

6d (Conditional) For a system with multiple network interfaces, in the [ mysql d] section, add
the following line:

bi nd- address = nysql _server _address

Replace nysql _server _addr ess with the IP address that you want MySQL to bind to
and to listen on.

6e Save the updated configuration file, then exit the text editor.
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11

12

13

14

15

16

17

18

19

Copy the t eam ng- 4. 0. n- db. zi p file from the Vibe server where the Vibe installation
program is located and copy it to the database server.

or

Download and unzip the Vibe software onto the database server.

In the directory where the Vibe Installation program is located on the database server, or in the

location where you copied the t eani ng- 4. 0. n- db. zi p file, unzip the t eani ng- 4. 0. n-

db. zi pfile.
Change to the db subdirectory.
Change to the db/ scri pt s/ sql subdirectory.

Copy the mysql - cr eat e- enpt y- dat abase. sql script to a convenient temporary location

on the server where you want to create the database, and ensure that your database
management utility is on your path so that you can run it from that directory.

Specify the following command to run the MySQL database creation script:
nysqgl -uuser -ppassword < mysql -create-enpty-database. sql
Configure MySQL to allow access from a remote server:

nysqgl -uuser -ppassword

nysql > grant all privileges on *.*
-> to 'username' @%
-> identified by 'password'
-> with grant option

-> ,
Edit the mysql -1 i qui base. properti es file to use your specific credentials.
For example:
vi nysqgl -1iqui base. properties

Populate the database that you just created:

./ manage- dat abase. sh nysql updat eDat abase

Verify that the database tables were created:

nysql -uuser -p

Specify the password for the MySQL user.

Specify the following command to use the default Vibe database:
nysgl > use sitescape;

A message indicating that the database has been changed is displayed.
Specify the following command to show that the tables were created:

nysql > show t abl es;

Creating a Microsoft SQL Database

Before you begin, you should be familiar with standard database maintenance procedures.

For more information about Microsoft SQL, see the following Microsoft Web Site (http://
www.microsoft.com/sqlserver/).
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The following database tool can be helpful:

*

Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

To create a Microsoft SQL database:

1
2

Review the Microsoft SQL requirements listed in “Database Server Requirements” on page 24.

Ensure that the Microsoft SQL Server and Client have been installed and configured properly.

IMPORTANT: Ensure that TCP/IP is enabled for the Microsoft SQL Server.

For more information, see “Microsoft SQL Server” (http://msdn.microsoft.com/en-us/library/
bb545450.aspx).

Ensure that the Microsoft SQL database client is also installed on the Vibe server.

The Vibe installation program needs the Microsoft SQL client in order to communicate with the
remote Microsoft SQL database server.

When you install Microsoft SQL Server, select SQL Server and Windows for authentication.
The default is Windows Only, which is not appropriate for Vibe.

Copy the t eam ng- 4. 0. n- db. zi p file from the Vibe server where the Vibe installation
program is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the t eami ng- 4. 0. n- db. zi p file, unzip the t eam ng- 4. 0. n-
db. zi pfile.

Change to the db subdirectory.
Change to the db/ scri pt s/ sql subdirectory.

9 Use Microsoft SQL Server Management Studio to create the empty database:

10
11

12

13

14

9a Copy the sqgl server-creat e-enpty- dat abase. sql file from the db/ scri pt s/ sql
subdirectory .

9b Execute the query to create the empty database.

When the database is created, you should see Conmand(s) conpl et ed successfully
in the messages window.

Change to the db directory.

Edit the sql server-1i qui base. properti es file to use your administrator user name and
password for the SQL database server.

Populate the database that you just created (requires that Java is installed):
run manage- dat abase. bat sql server updat eDat abase

Verify that the database tables were created by using Microsoft SQL Server Management
Studio.

If desired, you can now uninstall Java.
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Creating an Oracle Database

Before you begin, you should be familiar with standard database maintenance procedures.
For more information about your Oracle database, see the following references:

¢ Oracle Product Documentation (http://www.oracle.com/technetwork/indexes/documentation/
)

¢ Oracle SQL Plus Documentation (http://download.oracle.com/docs/cd/B19306_01/server.102/
b14357/toc.htm)

The following database tool can be helpful:
+ Squirrel SQL Client (http://squirrel-sql.sourceforge.net)

1 Review the Oracle database requirements listed in “Database Server Requirements” on page 24.

2 Ensure that the Oracle database server software has been installed and configured properly.
For more information, see Oracle Database (http://www.oracle.com/database).

3 Set up the Oracle database character set to support Unicode character encodings.

Vibe requires either the UTF-8 or AL32UTF8 character set for proper operation. Oracle
recommends AL32UTF8, because it has increased support for certain Asian languages. For more
information, see “Choosing a Character Set” (http://download.oracle.com/docs/cd/
B19306_01/server.102/b14225/ch2charset.htm) in the Oracle Database Globalization Support
Guide.

4 Copythet eam ng-4. 0. n-db. zi p file from the Vibe server where the Vibe installation
program is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

5 Inthe directory where the Vibe Installation program is located on the database server, or in the
location where you copied the t eami ng- 4. 0. n- db. zi p file, unzip the t eam ng- 4. 0. n-
db. zi pfile.

6 Change to the db subdirectory.

7 Change to the db/ scri pt s/ sqgl subdirectory.

8 Editthe oracl e- cr eat e- enpt y- dat abase. sql script with your Oracle database password.
Original:
drop user sitescape cascade;
create user sitescape identified by sitescape;

grant connect, resource to sitescape;
connect sitescape/sitescape;

(SiteScape is the name of the company that previously developed the Vibe software.)

Updated:

drop user sitescape cascade;

create user sitescape identified by your oracl e _password;
grant connect, resource to sitescape;

connect sitescape/ your_oracl e _password;
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IMPORTANT: Unless you are very familiar with editing scripts, change only the password. Do
not attempt to change the name of the database from the legacy default of si t escape.

9 Enter the following commands to run the database creation script:

sql plus "/ as sysdba"
SQ.> spool oracl e-create-enpty-dat abase. out;
SQ.> @r acl e- creat e- enpt y- dat abase;

SQ.> quit
10 Check the resulting or acl e- cr eat e- enpt y- dat abase. out file for errors and resolve them.

11 Editthe oracl e-1i qui base. properti es file to use your administrator user name and
password.

For example:
vi oracl e-1iquibase. properties
12 Populate the database that you just created:
run ./ manage- dat abase. sh oracl e updat eDat abase

13 Verify that the database tables were created.

Creating a PostgreSQL Database

Before you begin, you should be familiar with standard database maintenance procedures.

For more information about PostgreSQL, see the PostgreSQL documentation on the web (https://
www.postgresgl.org/docs/manuals/).

To create the PosgreSQL database:

1 Review the PostSQL requirements listed in “Database Server Requirements” on page 24.

2 Ensure that the PostgreSQL database server and client have been installed and configured, as
described in “Installing and Running the Database Server” on page 63.

3 Ensure that the PostgreSQL database client is also installed on the Vibe server.

The Vibe installation program needs the PostgreSQL client in order to communicate with the
remote PostgreSQL database server.

4 Ensure that you know the password for the PostgreSQL post gr es administrator user.
5 Configure the socket connection method.
5a Asther oot user, browseto/var/li b/ pgsql/data.

5b Edit the pg_hba. conf file and change the following local and host lines to specify md5
encryption, as follows:

| ocal all al | nd5
host al | al | 127.0.0.1/32 nd5
host al | al | ::1/128 nd5

5c¢ Save the file.
5d Edit the post gresql . conf file.
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11

12
13

14

15

16

5e Make sure that the listen_addresses line is uncommented and configured to allow
connection requests from all Vibe servers by specifying individual IP addresses or by
replacing localhost with an asterisk (*).

5f Save and close the file.
5g Stop and restart the PostgreSQL system process.

Copy the t eam ng- 4. 0. n- db. zi p file from the Vibe server where the Vibe installation
program is located and copy it to the database server.

or
Download and unzip the Vibe software onto the database server.

In the directory where the Vibe Installation program is located on the database server, or in the
location where you copied the t eani ng- 4. 0. n- db. zi p file, unzip the t eani ng- 4. 0. n-
db. zi p file.

Change to the db subdirectory.
Change to the db/ scri pt s/ sql subdirectory.

Copy the post gresqgl - cr eat e- enpt y- dat abase. sql script to a convenient temporary
location on the server where you want to create the database, and ensure that your database
management utility is on your path so that you can run it from that directory.

Run the script to create your Vibe database:

psql -Uadm n-usernane < "postgresql -create-enpty-database. sql "
You are prompted for the admin-user password.

Change to the db directory:

In a text editor, open the post gresql - | i qui base. properti es file and make the following
changes:

¢ Change the user nane, passwor d, r ef erenceUser nane, and r ef er encePasswor d
fields to reflect the admin-username and password for accessing your database.

* Replace |l ocal host with the addresses specified in Step 5e on page 135.

+ (Optional) If you changed the database name, change the url andr ef er enceURL fields
to reflect name of your Vibe database.

Save and close the text editor.

In the same directory, make the manage- dat abase. sh file executable by entering the
following command:

chnmod +x nanage- dat abase. sh
Use the following command to create the database schema:

./ manage- dat abase. sh postgresql updateDat abase

NOTE: You can safely ignore the following Liquibase log messages:

* VWarning: nodi fyDataType will |ose prinary key/ autoi ncrenent/not nul |
settings for mysql

+ Any messages that contain the wordsi nfo: failureorinfo: failed,aslongasthey
are associated with a type | NFOmessage

Start the Vibe server as described in “Starting Vibe on Linux” on page 78.
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17 For security reasons, delete the password that you specified in Step 13 by opening the
post gresql -1i qui base. properti es file and removing the password from the password

and r ef er encePasswor d fields.

18 Save and close the properties file.
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Installing the Lucene Index Server on a
Remote Server

You can install the Lucene Index Server on a different server from where Micro Focus Vibe is running.
If the Lucene Index Server is already running on the same server as Vibe, you can move the Lucene
Index Server to a different server.

Running the Lucene Index Server on a remote server allows both the Lucene Index Server and the
Vibe server to have access to more server memory, disk space, and CPU resources.

Complete the following sections whether you are installing the Lucene Index Server on a remote
server, or moving the Lucene Index Server to a remote server.

IMPORTANT: The Vibe server and the Lucene Index Server must not have a firewall between them.
The RMI protocol used for the Lucene Index Server port works only within a trusted local area
network (LAN).

+ “Installing the Lucene Software” on page 137
+ “Updating Your Vibe Site” on page 139

+ “Managing a Remote Lucene Index Server” on page 139

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part Ill, “Basic Installation,” on
page 33 before attempting a more complex Vibe configuration.

Installing the Lucene Software

1 Ensure that there is no firewall between the Vibe server and the Lucene Index Server.

2 Copy the Lucene installation program from its original location in the same directory with the
Vibe installation program to a convenient temporary directory on the remote server.

The file name for the Lucene Installation program varies by platform:

Linux: |l ucene-installer.!linux

Windows: | ucene-installer. exe

Change to the directory where you copied the Lucene installation program, then start it.
Accept the License Agreement, then click Next.

Select New installation, then click Next.

D U A~ W

Browse to and select the directory where you want to install the Lucene Index Server, then click
Next.
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The default location varies by platform:

Linux: / opt/ novel | / t eam ng/ | uceneserver

Windows: c:\Program Fi | es\ Novel | \ Teani ng\ | uceneserver

7 Browse to and select the directory where you installed the JDK, then click Next.

8 Adjust the configuration of the Lucene Index Server, as described in “Changing Your Lucene
Index Server Configuration” on page 99, then click Next.

9 Click Install to install the Lucene software.
10 (Conditional) On Linux, deselect Start Lucene server.

You must edit the Lucene Index Server startup script before you start the Lucene Index Server.
Instructions are provided later in this procedure.

11 (Conditional) On Windows, if you do not want to start the Lucene Index Server immediately,
deselect Start Lucene server.

For instructions on starting and stopping the Lucene Index Server manually, see “Managing a
Remote Lucene Index Server” on page 139.

12 Click Finish.
13 (Conditional) On Linux:
13a Change to the following directory:

/ opt/ novel | /team ng/l uceneserver/indexserver/bin

13b Openthei ndexserver-startup. sh file in a text editor.

13c Add the following switch to the j ava launch command at the end of the script:
-Dj ava. rni . server. host nane=i p_addr ess

Rename i p_addr ess with the IP address of the server where you installed the Lucene
Index Server.

13d Save the i ndexserver-start up. sh file, then exit the text editor.
13e Start the Lucene Index Server.

For instructions on starting and stopping the Lucene Index Server manually, see “Managing
a Remote Lucene Index Server” on page 139.

Moving the Lucene Index Server from the Vibe server to a remote server increases the scalability of
your Vibe system, because the workload is distributed between two different physical servers.
However, in this configuration, the Lucene Index Server still runs on a single server. Your Vibe site
depends on the Lucene Index Server for full functionality. If that server goes down for some reason,
the Vibe site becomes inaccessible until access to the Lucene Index Server is restored. You can
further expand your Vibe system by setting up multiple Lucene Index Servers to provide high
availability, as described in Chapter 22, “Running Multiple Lucene Index Servers,” on page 149.
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Updating Your Vibe Site

Complete this section only if you are moving the Lucene Index Server. If you are performing a fresh
Lucene Index Server installation, disregard this section.

1 Stop Micro Focus Vibe.

2 Start the Vibe installation program to reconfigure the Lucene Index Server settings.

For information on how to start the installation program, see “Running the Linux Vibe
Installation Program” on page 70 or “Running the Windows Vibe Installation Program” on
page 81.

3 On the Choose Installation Type page, select Advanced, then click Next.

4 Click Next until you reach the Lucene Configuration page.

Novell Vibe 4 Installation Program = x

Lucene Configuration

N

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
‘You can run Lucene as a server on the same machine where the Vibe software is installed or on a
remote machine.

Enter the host name and edit the RMI port If the default port cannot be used.

Max booleans 100000
Merge factor .ID

Lucene configuration type: local j

5 In the Lucene configuration type field, select server to activate additional fields.
Host: Specify the hostname of the server where you installed the Lucene Index Server software.

RMI Port: Use the same port number that you used when you installed the Lucene Index Server
software. The default RMI port is 1199.

6 Click Next until you reach the Ready to Install page, then click Install.
7 When the installation is complete, click Finish.
8 Start Vibe.

Managing a Remote Lucene Index Server

¢ “Linux: Managing a Remote Lucene Index Server” on page 139

+ “Windows: Managing a Remote Lucene Index Server” on page 140

Linux: Managing a Remote Lucene Index Server

Use the following commands to start and stop the Lucene index server manually:
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letc/init.d/indexserver start
/etc/init.d/indexserver stop

To configure the Lucene Index Server to start automatically when the Linux server reboots, use:

chkconfig --add indexserver

Windows: Managing a Remote Lucene Index Server

Use the following commands at a DOS command prompt to start and stop the Lucene index server
manually:

c:\Program Fi | es\ Novel | \ Teami ng\ | uceneserver\i ndexserver\ bi n\
i ndexserver -
startup. bat

c:\Program Fi | es\ Novel | \ Teami ng\ | uceneserver\i ndexserver\ bi n\
i ndexserver -
shut down. bat

To configure the Lucene Index Server to start automatically when the Windows server reboots, you
can set it up as a scheduled task that runs at system startup.

1 On the Windows server where the Lucene Index Server is installed, click Start > All Programs >
Accessories > System Tools > Scheduled Tasks.

2 Double-click Add Scheduled Task to open the Scheduled Task Wizard, then click Next to
continue.

3 Click Browse, then browse to and double-click the i ndexser ver - st art up. bat file in the
following directory:

c:\Program Fi | es\ Novel | \ Team ng\ | uceneserver\i ndexserver\bin

4 In the Task name field, specify an informative name for the task, such as Lucene Index Server.
The default task name is the name of the batch file.

In the Perform this task field, select When my computer starts, then click Next.

Specify and confirm the Administrator password for the Windows server, then click Next.

Select Open advanced properties for this task when I click Finish, then click Finish.

0 N o U

Verify that Run only if logged on is deselected, then click OK.

A new task with the name you specified in Step 4 is added to the list in the Scheduled Tasks
window.

9 Click File > Exit to close the Scheduled Task Wizard.
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2 1 Running Vibe on Multiple Servers

By running Micro Focus Vibe on multiple servers, you can achieve high availability, including failover
and load balancing, depending on how you configure your servers. You must perform an Advanced
installation on each server in order to configure the Vibe software for such a clustered environment.
+ “Planning a Multi-Server Vibe Configuration” on page 141
+ “Installing the Vibe Software on Multiple Servers” on page 142

+ “Configuring a Web Application to Provide High Availability Functionality for Your Vibe Site” on
page 145

+ “Configuring Internet Information Services to Support Multiple Vibe Servers” on page 147

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommended that you follow the instructions in Part I, “Basic Installation,”
on page 33 before attempting a more complex Vibe configuration.

Planning a Multi-Server Vibe Configuration

+ “Lucene Index Server Considerations” on page 141
+ “Vibe File Repository Considerations” on page 141

+ “Configuring Routing for Multicast IP on the Vibe Server” on page 142

Lucene Index Server Considerations

Before you can implement a multi-server Micro Focus Vibe configuration, you must move your
Lucene Index Server away from the initial Vibe server, as described in Chapter 20, “Installing the
Lucene Index Server on a Remote Server,” on page 137.

Vibe File Repository Considerations

Before you implement a multi-server Micro Focus Vibe configuration, you must plan the Vibe file
repository for the clustered Vibe servers. Your configuration must comply with the following
restrictions:

+ The Vibe file repository must be placed in a shared location that is accessible to each Tomcat
instance.

+ All Tomcat instances must be configured with the same path leading to the shared storage.

For background information on the contents of the Vibe file repository, see “Distributing Different
Data Types to Different Locations” on page 96.
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Configuring Routing for Multicast IP on the Vibe Server

If you are planning to use ehcache as your hibernate caching provider, you might need to set up the
routing for multicast IP on each server where Vibe is installed. If this is not done, then depending on
your Vibe system, you might see a communication error when you start the Vibe server. For
example, in the log file you might see the following:

Error starting heartbeat. Error was: No such device.
To prevent this error, or to fix the Vibe system after the error occurs:
1 Run the following command:

route add -net 232.0.0.0/8 dev ethO

Installing the Vibe Software on Multiple Servers

1 Update your existing Micro Focus Vibe server to participate in a multi-server configuration:
la Stop Vibe.
1b Start the Vibe Installation program.

For information on how to start the installation program, see “Running the Linux Vibe
Installation Program” on page 70 or “Running the Windows Vibe Installation Program” on
page 81.

1c On the Installation Settings page, select Reconfigure Settings, then click Next.
1d On the Choose Installation Type page, select Advanced, then click Next.
le Click Next to proceed through the installation pages where no changes are needed.

1f (Conditional) If you do not have the Basic Installation Planning Worksheet and Advanced
Vibe Installation Summary Sheet from the initial Vibe server installation, record the
configuration of the initial Vibe server as you proceed through the installation pages.

Subsequent Vibe servers in the multi-server configuration must be installed with the same
configuration settings as the initial Vibe server.

1g On the Vibe Cluster Configuration page, select Enable clustered environment to enable
clustering.

1h On the first Vibe node, in the JVM Route field, specify wor ker 1. On the second Vibe node,
in the JVM Route field, specify wor ker 2, and so forth for each Vibe node, incrementing the
JVM Route setting. Each Tomcat instance should have a unique JVM Route setting.

wor ker 1, wor ker 2, and so forth are the default names for the matching values used for
the reverse proxy configuration. For example, if you have set up Apache or IIS as a reverse
proxy, these are the default values. The JVM Route setting in the Vibe installer must match
these values.

1i Select one of the following options for your hibernate caching provider:

ehcache: Ehcache is recommended for small clustered Vibe sites, and is included in the
Vibe software. If you select this option, no further configuration is necessary. For more
information, see Ehcache (http://ehcache.sourceforge.net).

142  Running Vibe on Multiple Servers


http://ehcache.sourceforge.net

memcached: Memcached is recommended for medium to large clustered Vibe sites.
Memcached is not included in the Vibe software. If you select this option, you must
download and install memcached on each server that you plan to use for caching in your
Vibe cluster. For information about downloading and installing memcached, see
Appendix B, “Memcached Caching with Micro Focus Vibe,” on page 229.

Depending on the cache provider you select, different options are displayed.

Novell Vibe 4 Installation Program i x

Vibe Cluster Configuration

Select the checkbox to configure this Vibe installation to participate in a cluster.

v Enable clustered environment

JVM Route:

Hiberate caching provider: |encache d

Network interface for distributed cache service (Optional: IP address or hostname expected)

HostName:
Multicast Group Address (Ip Address): 232.0.0.1

Multicast Group Port: |4446

Novell Vibe 4 Installation Program i X

Vibe Cluster Configuration

Select the checkbox to configure this Vibe installation to participate in a cluster.

v Enable clustered environment

JWM Route:

Hibemnate caching provider: Imnmachai |'|

Enter a space delimited list of memcached instances in the format host:port
For example, 192.168.1.5:11211 192.168.1.7:11212

Server Addresses: ..

1j (Conditional) If you selected ehcache as the hibernate caching provider in Step 1g, specify
the following information on the Vibe Cluster Configuration page to configure ehcache:

Network interface for distributed cache service: Specify the IP address or hostname of the
distributed cache service.

Multicast Group Address: (Optional) Specify the common multicast group IP address. Each
clustered node recognizes other nodes in the cluster by means of this IP address.

IMPORTANT: Ensure you specify the same IP address on all Vibe nodes in the cluster. After
you have set this IP address for each Vibe node, restart each node in succession, allowing
each node to initialize before restarting the next.
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The default multicast group IP address is 232.0.0.1. If you have more than one clustered
Vibe system (for example, one in the lab and one in production), or if you have another
software product that is already using the default multicast group IP address, you must
update this field for one system so that it uses an IP address other than the default.

Use an IP address in the range of 224.0.0.1 to 239.255.255.255.

Multicast Group Port: (Optional) Specify the port number through which the Vibe nodes
will communicate.

1k (Conditional) If you selected memcached as the hibernate caching provider in Step 1g,
specify the following information on the Vibe Cluster Configuration page to configure
memcached:

Server Addresses: Specify a list of memcached servers, with each server separated by a
space. For example, host nanmel: port host name2: port host nane3: port

The server addresses listed here are all nodes within the Vibe cluster. Changes made to one
Vibe node are immediately visible in other Vibe nodes. Ensure that the clock settings for
each Vibe node are synchronized. Failure to do so can significantly degrade overall system
performance.

Memcached is not included in the Vibe software. If you select memcached as your
hibernate caching provider, you must download and install memcached on each server in
your Vibe cluster. For information about downloading and installing memcached, see .

11 On the Ready to Install page, click Install.

1m On the Installation Complete page, click Finish.

2 Install the Vibe software on each additional server, using the same installation settings that you

used for the initial Vibe server.

(Conditional) If you set up ehcache as the caching provider, on each Linux server where you
installed the Vibe software, set the multicast route to enable the servers to function as a
cluster:

3a Use the following command on the command line to immediately set the multicast route
for the server:

route add -net 232.0.0.0/8 dev ethO

3b To run this command each time the server reboots, add the command to the following file
on each server:

/etc/init.d/ boot.| ocal

Start Vibe on each server, as described for the platform where you are installing Vibe:
+ “Starting Vibe on Linux” on page 78
¢ “Running Vibe as a Windows Service” on page 84
¢ “Running Vibe as a Windows Application” on page 86

(Conditional) If you set up ehcache as the caching provider and the Vibe servers fail to start
because of a communication error, ensure that you have followed the steps in “Configuring
Routing for Multicast IP on the Vibe Server” on page 142.

Continue with Configuring a Web Application to Provide High Availability Functionality for Your
Vibe Site.
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Configuring a Web Application to Provide High Availability
Functionality for Your Vibe Site

After Micro Focus Vibe is installed and running on multiple servers, you must provide additional
software to provide high availability functionality. Because Vibe is based on Tomcat, you can use
software that provides high availability for Tomcat.

1 Install and configure one of the following web applications to provide high availability for your
Vibe site:
* Apache web server (http://www.apache.org)
¢ Linux Virtual Server (http://www.linuxvirtualserver.org)
* Novell Access Manager (https://www.netiq.com/products/access-manager/)
* Microsoft Internet Information Services (http://www.iis.net)

2 Configure the web application to establish the Vibe site URL, which then stays constant for Vibe
users regardless of which Vibe server they access at any given time.

3 Start the web application with its new configuration settings.
4 Test your Vibe site for high availability.

+ If you are using Apache web server, Linux Virtual Services, or Microsoft Internet
Information Services, users can immediately log in to the Vibe site again after a failover has
occurred. The connection between the user’s browser and the Vibe site is maintained as
the failover occurs.

+ If you are using Novell Access Manager, users must start a new browser session, and then
log in to the Vibe site after a failover has occurred. They cannot log in again from the same
browser session, because the connection between the user’s browser and the Vibe site
must be reestablished after the failover.

The following sections provide examples of how to configure the web applications:

+ “Configuring Apache as a Load Balancer” on page 145

+ “Configuring Linux Virtual Server as a Load Balancer” on page 147

Configuring Apache as a Load Balancer

The following example configuration uses the balancer module built into the newer Apache (version
2.2.4 and later) web server. It is based on a widely used sticky session technique. Micro Focus Vibe
does not support session sharing/replication among Tomcat instances.

If you are using Novell Access Manager as described in “Configuring Single Sign-On with Novell
Access Manager” on page 103, you do not need to configure Apache to load balance as described in
this section, because Access Manager provides this service.

NOTE: When you update your Vibe system, these settings are not preserved. You must redefine
these settings each time you update your Vibe system.
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To configure Apache to load balance:

1 Install the Apache web server (http://httpd.apache.org) on one server.

2 Editthe/ et c/ sysconfi g/ apache?2 file

2a

2b

2c

2d

Locate the following line:
APACHE MODULES=

Then add the following lines:

pr oxy
proxy_aj p
proxy_bal ancer

The end result should look similar to the following:

APACHE_MODULES="actions alias auth _basic authn file authz_host
authz_groupfile authz_default authz_user authn_dbmautoi ndex cgi dir
env expires include | og_config mne negotiation setenvif ssl suexec
userdir php5 reqtineout proxy proxy_ajp proxy_bal ancer"

Create the following new configuration file:
/ et c/ apache2/ htt pd. conf. vi be

Add the following section to the / et ¢/ apache2/ ht t pd. conf . vi be file, providing a
Bal ancer Menber line for each j vnRout e value in a Tomcat server . xm file.

<Locati on /bal ancer - manager >
Set Handl er bal ancer - manager
Order deny, al | ow
Deny from all
Allow from127.0.0.1
</ Locat i on>
<Proxy bal ancer://cl uster_nane>
Bal ancer Menber aj p://vi be_server_1:8009 rout e=workerl
Bal ancer Menber aj p://vi be_server_2: 8009 rout e=wor ker 2
</ Pr oxy>
<Location />
ProxyPass bal ancer://cluster_nane/ stickysessi on=JSESSI ONI D
</ Locat i on>

The values that you specify for the r out e setting (for example, wor ker 1, wor ker 2, etc.)
must exactly match the values that you specify as the JVM Route setting during the Vibe
installation, as described in “Installing the Vibe Software on Multiple Servers” on page 142.

Save the ht t pd. conf . vi be file.

3 Reconfigure each Vibe server in the cluster so that each server has the same network
information (hostname and ports) as the Apache web server.

For each Vibe server in the cluster:

3a

Run the Vibe installation program by reconfiguring the Vibe server.

For information about how to reconfigure your Vibe server, see Chapter 17, “Setting
Configuration Options after Installation,” on page 121.
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3b On the Network Information page in the Vibe installation program, change the hostname in
the Host field for each Vibe server. The hostname must match the DNS name that users use
to access the Vibe service.

For example, if the URL for you Vibe site is vi be. acme. com you would specify
vi be. acne. comin this field.

3c Continue through the Vibe installation program for each Vibe server in the cluster, as
described in Chapter 17, “Setting Configuration Options after Installation,” on page 121.

4 Restart Apache.

TIP: For enhanced performance when using the Internet Explorer browser to access a Vibe system
that is using Apache as an SSL reverse-proxy server, change the Apache SSL exclusion regular
expression configuration from the following:

Set Envlf User-Agent ".*MSIE *" \
nokeepal i ve ssl -uncl ean- shut down \
downgrade-1.0 force-response-1.0

to the following:

Set Envlf User-Agent ".*MSIE [1-5].*"
nokeepal i ve ssl -uncl ean- shut down
downgrade-1.0 force-response-1.0

Set Envlf User-Agent ".*MSIE [6-9].*"
ssl - uncl ean- shut down

Configuring Linux Virtual Server as a Load Balancer

Consult the following online sources for instructions on setting up Linux Virtual Server as a load
balancer for your Micro Focus Vibe site:

¢ The Linux Virtual Server Project (http://www.linuxvirtualserver.org)
¢ Linux Virtual Server (LVS) Project (http://www.austintek.com/LVS)

¢ Linux Virtual Server Tutorial (http://www.ultramonkey.org/papers/lvs_tutorial/html)

Configuring Internet Information Services to Support
Multiple Vibe Servers

You can configure Internet Information Services (1IS) to support multiple Micro Focus Vibe servers.
For more information, see “Configuring IIS to Load Balance in a Clustered Environment” on
page 115.
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Running Multiple Lucene Index Servers

Your Micro Focus Vibe site depends on the Lucene Index Server for full functionality. Different
Lucene configurations provide different levels of scalability and reliability.

You can install the Lucene Index Server on a different server from where Vibe is running so that both
programs have access to more server memory, disk space, and CPU resources. However, the Vibe
server and the Lucene Index Server must not have a firewall between them. The RMI protocol used
for the Lucene Index Server port works only within a trusted local area network (LAN).

+ A Basic installation of Vibe places the Lucene Index Server on the same server where the Vibe
software is installed.

+ To provide additional memory for the Lucene Index Server, you might already have configured it
to run in its own memory space, as described in “Running the Lucene Index Server in Its Own
JVM” on page 101.

+ To provide additional disk space and memory for the Lucene Index Server, you might already
have moved it to a different server, as described in Chapter 20, “Installing the Lucene Index
Server on a Remote Server,” on page 137.

These configurations provide additional resources for the Lucene Index Server, but it is still a single
point of failure for your Vibe site. If the Lucene Index Server goes down, the Vibe site becomes
inaccessible until access to the Lucene Index Server is restored.

Running multiple Lucene Index Servers provides high availability functionality, so that if one Lucene
Index Server goes down, Vibe users can still access the Vibe site because other Lucene Index Servers
are still available.

+ “Planning a High Availability Lucene Configuration” on page 149

+ “Setting Up a High Availability Lucene Configuration” on page 150

+ “Testing Your Lucene High Availability Configuration” on page 162

+ “Synchronizing a High Availability Lucene Configuration” on page 164

NOTE: This section assumes that you already have a Basic installation of Vibe up and running
successfully. We highly recommend that you follow the instructions in Part I, “Basic Installation,” on
page 33 before attempting a more complex Vibe and Lucene configuration.

Planning a High Availability Lucene Configuration

A high availability Lucene Index Server configuration must include at least two different servers
(either physical or virtual), referred to as “nodes” in the Vibe installation program. Lucene nodesin a
high availability configuration can be set up on Linux servers, Windows servers, or both.

Each Lucene node must have its own independent directory structure for index files. The default
location for the index files for the Lucene Index Server varies by platform:
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Linux: [var/opt/novel | /team ng/l ucene

Windows:  c¢:\ Novel | \ Teami ng\ | ucene

As you plan your high availability Lucene configuration, you can use the Advanced Vibe Installation
Summary Sheet to record the options you want to use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the number of Lucene nodes that you want in
your high availability Lucene configuration.

Each Lucene node needs a unique name, a descriptive title, and a static IP address. The name and
title identify the node in the Vibe administrative interface. Typically, the Lucene Index Server listens
on RMI port 1199 on its server, but you can configure it to use a different port number if the default
port number is already in use.

ADVANCED VIBE INSTALLATION SUMMARY SHEET

Under High Availability Lucene Configuration, specify the name, description, IP address, and RMI port
number for each Lucene node.

If you have already accumulated index data on your initial Vibe server, you can choose to copy the
index files to the Lucene nodes, or you can reindex the Vibe site after the new Lucene nodes are
running. Depending on the amount of accumulated index data, reindexing can be a time-consuming
process.

The Vibe server and the Lucene nodes must not have a firewall between them. The RMI protocol
used for the Lucene Index Server port works only within a trusted local area network (LAN).

Setting Up a High Availability Lucene Configuration

+ “Changing from a Local Lucene Index Server” on page 150
+ “Changing from a Single Remote Lucene Index Server” on page 153
+ “Expanding an Existing High Availability Lucene Configuration” on page 156

+ “Changing Your Lucene Configuration without Vibe Site Down Time” on page 158

Changing from a Local Lucene Index Server

To change from a local Lucene Index Server running on the Micro Focus Vibe server, you must install
the Lucene Index Server on two or more remote servers, and then reconfigure Vibe for a high
availability Lucene configuration.
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NOTE: Although it is possible to use the Lucene Index Server on the Vibe server as one of the
“remote” Lucene nodes, this is not a recommended configuration. Consider it only if you are
restricted to two servers for your Vibe site.

1 Set up two or more Lucene nodes:

1a

1b

1c

Install the Lucene Index Server on each node, as described in “Installing the Lucene
Software” on page 137.

(Optional) Copy accumulated index data from the initial Lucene Index Server to each
additional Lucene node.

The default location for the index files varies by platform:

Linux: /var/opt/novel | /team ng/l ucene

Windows: c¢:\ Novel |\ Team ng\ | ucene

Start the Lucene Index Server on each Lucene node, as described in “Managing a Remote
Lucene Index Server” on page 139.

2 Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 21,
“Running Vibe on Multiple Servers,” on page 141, stop Vibe on all servers, or follow the
instructions in “Changing Your Lucene Configuration without Vibe Site Down Time” on
page 158.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:

3a
3b
3c
3d

On the Installation Settings page, select Reconfigure Settings, then click Next.

On the Choose Installation Type page, select Advanced, then click Next.

Click Next to proceed through the installation pages where no changes are needed.
On the Lucene Configuration page, fill in the following fields:

Lucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where you
have installed and started the Lucene Index Server.

Novell Vibe 4 Installation Program & X

Lucene Configuration

N

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
“You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max booleans 100000

Merge factor 10

Lucene configuration type: high avallability j

Connection credentials to the lucene server(s):
Login name: iucene service

Password:

o m—
—

Number of high availability search nodes: |2
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3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration

information for each Lucene node from the Advanced Vibe Installation Summary Sheet

that you filled out in “Planning a High Availability Lucene Configuration” on page 149, then
click Next.

Novell Vibe 4 Installation Program
Configure High Availablity Search Nodes

Gonfigure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high avallable search nodes, unselect Its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port if the default port cannot
be used.

High Availability Search Node 1

¥ Keep service name;LuceneLlnux

Service title ;Lucene on Linux

Host [172.16.5.2

RMI port | 1199

rHigh Avallability Search Node 2

v Keep Service name |Lucene Windows

Service title iLucene on Windows

Host[172.16.5.9

RMI port | 1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.

3h On the Installation Complete page, click Finish.

3i Start Vibe.

3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:

4a Login to the Vibe site as the Vibe administrator.

4b Click your linked name in the upper right corner of the page, then click the Administration

Console icon %,

4c Under Search Index, click Nodes.
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Lucene on Linux {lucenelinux)

Host 1721652
RMI port: 1199

User Mode Access
@ Read and Write
© write Only
© No Access

Enable Deferred Update Log
No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host: 172.16.5.19
RMI port: 1198

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes, click Apply, then
click Close.

The new setting is put into effect immediately, so that users immediately have access to
the additional Lucene nodes.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 162.

Changing from a Single Remote Lucene Index Server

To change from a single remote Lucene Index Server to a high availability configuration, you must
install the Lucene Index Server on one or more additional remote servers, and then reconfigure
Micro Focus Vibe for additional Lucene nodes.
1 Bring down your Vibe site:
la Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 21,
“Running Vibe on Multiple Servers,” on page 141, stop Vibe on all servers, or follow the
instructions in “Changing Your Lucene Configuration without Vibe Site Down Time” on
page 158.

1b Ensure that the existing remote Lucene Index Server also stops.
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2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in “Installing

the Lucene Software” on page 137.

2b (Optional) Copy accumulated index data from the initial remote Lucene node to each

additional Lucene node.

The default location for the index files varies by platform:

Linux: [ var/opt/novel |/t eam ng/| ucene

Windows: c¢:\ Novel |\ Team ng\ | ucene

2c Start the Lucene Index Server on each Lucene node, as described in “Managing a Remote

Lucene Index Server” on page 139, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for multiple Lucene nodes:

3a On the Installation Settings page, select Reconfigure Settings, then click Next.

3b On the Choose Installation Type page, select Advanced, then click Next.

3c Click Next to proceed through the installation pages where no changes are needed.

3d On the Lucene Configuration page, fill in the following fields:

Lucene configuration type: Change server to high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where you

have installed the Lucene Index Server.

Novell Vibe 4 Installation Program & X

Lucene Configuration

N

Use the following fields to configure the Lucene index.

To run the Lucene index as a server, select Server from the drop-down list.
“You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max booleans 100000

Merge factor 10

Lucene configuration type: high avallability j

Connection credentials to the lucene server(s):
Login name: iucene service

Password:

o m—
—

Number of high availability search nodes: |2

3e Click Next.
3f On the Configure High Availability Search Nodes page, specify the configuration

information for each Lucene node from the Advanced Vibe Installation Summary Sheet
that you filled out in “Planning a High Availability Lucene Configuration” on page 149, then

click Next.
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Novell Vibe 4 Installation Program o x
Configure High Availablity Search Nodes

Gonfigure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high avallable search nodes, unselect Its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port if the default port cannot
be used.

High Availability Search Node 1

¥ Keep Service name |LuceneLinux

Service title ELucene on Linux

Host [172.16.5.2

AMI port [1199

~High Avallability Search Node 2
Iv Keep Service nameELucene Windows

Service title iLucene on Windows

Host [172.16.5.9

RMI port [1199

If you need more than 2 high availability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.
3i Start Vibe.
3j (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:
4a Login to the Vibe site as the Vibe administrator.
4b Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,

4c Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)

Host 1721652
RMI port. 1199

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMI port: 1199

User Mode Access
© Read and Write
@ Write Only
© No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

L 2oty I cose ]
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ad
4e

1a

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

In the User Mode Access box, select Read and Write for all Lucene nodes.
Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to
the additional Lucene nodes.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 162.

Expanding an Existing High Availability Lucene Configuration

After you have set up an initial high availability Lucene configuration, you can add additional Lucene
nodes at any time.

1 Bring down your Vibe site:

Stop Vibe.

If you have installed the Vibe software on multiple servers, as described in Chapter 21,
“Running Vibe on Multiple Servers,” on page 141, stop Vibe on all servers, or follow the
instructions in “Changing Your Lucene Configuration without Vibe Site Down Time” on
page 158.

1b Stop all Lucene nodes, as described in “Managing a Remote Lucene Index Server” on

page 139.

2 Set up one or more additional Lucene nodes:

2a Install the Lucene Index Server on each additional remote server, as described in “Installing

the Lucene Software” on page 137.

2b (Optional) Copy accumulated index data from an existing Lucene node to each additional

Lucene node.

The default location for the index files varies by platform:

Linux: [var/opt/novel | /teani ng/l ucene

Windows: c:\ Novel |\ Team ng\ | ucene

2c Start the Lucene Index Server on each Lucene node, as described in “Managing a Remote

Lucene Index Server” on page 139, but do not bring up your Vibe site.

3 Run the Vibe installation program to configure the Vibe server for the additional Lucene nodes:

3a On the Installation Settings page, select Reconfigure Settings, then click Next.

3b On the Choose Installation Type page, select Advanced, then click Next.

3c Click Next to proceed through the installation pages where no changes are needed.

3d On the Lucene Configuration page, increase the number of nodes in the Number of high

availability search nodes field, then click Next.
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Novell Vibe 4 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index. N

To run the Lucene index as a server, select Server from the drop-down list.

‘You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannol be used.

Max booleans }1b6600
Merge factor ‘1 0

Lucene configuration type: high availability j

Connection credentials o the lucene server(s):
Login name: \I-ucene service

Password:

T m—
—

Number of high availability search nodes: 1‘2

3e On the Configure High Availability Search Nodes page, specify the configuration
information for each additional Lucene node, then click Next.

Novell Vibe 4 Installation Program
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel. N

Use the following Tields to configure each high availability search node.
To remove one of the high available search nodes, unselect its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port if the default port cannot
be used.

RMI port [1199 ‘ A

~High Availability Search Node 2

¥ Keep Service name |Lucene Windows

Service title |Lucene on Windows

Host 172.16.5.3
RMI port 1199

rHigh Availability Search Node 3
¥ Keep Service name |

Service title

Host

RMIport]HQQ

If you need more than 3 high availability search nodes, you will need =l
to select "< Back" and increase the specified number of nodes.

3f Click Next until you reach the Ready to Install page, then click Install.
3g On the Installation Complete page, click Finish.
3h Start Vibe.

3i (Conditional) If you have multiple Vibe servers, repeat Step 3 on each Vibe server.
4 Configure the Vibe site for the additional Lucene nodes:

4a Login to the Vibe site as the Vibe administrator.

4b Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,

4c Under Search Index, click Nodes.
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Lucene on Linux (lucenelinux)
Host 172.18.5.2
RMI port. 1199
User Mode Access
@ Read and Write
- Write Only
) No Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 17216519
RMI port. 1199

User Mode Access
) Read and Write
@ Write Only
) No Access
Enable Deferred Update Log

Mo Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. This setting is useful when you need to perform maintenance on
a Lucene node, but it is not the setting you want when you set up a new Lucene node.

4d In the User Mode Access box, select Read and Write for all Lucene nodes.
4e Click Apply, then click Close.

The new setting is put into effect immediately, so that users immediately have access to
the additional Lucene nodes.

5 Skip to “Testing Your Lucene High Availability Configuration” on page 162.

Changing Your Lucene Configuration without Vibe Site Down
Time

Vibe site down time can be avoided only if you have installed the Vibe software on multiple servers,
as described in Chapter 21, “Running Vibe on Multiple Servers,” on page 141.

To change to a high availability Lucene configuration in a multiple Vibe server configuration:

1 Set up two or more Lucene nodes:

1a Install the Lucene Index Server on each node, as described in “Installing the Lucene
Software” on page 137

1b Start the Lucene Index Server on each Lucene node, as described in “Managing a Remote
Lucene Index Server” on page 139.

2 Stop Vibe on one server.

The other Vibe servers remain in service for users and continue to communicate with the
original Lucene Index Server.

3 Run the Vibe installation program on the Vibe server that you stopped to configure it for
multiple Lucene Index Servers:

3a On the Installation Settings page, select Reconfigure Settings, then click Next.

3b On the Choose Installation Type page, select Advanced, then click Next.
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3c Click Next to proceed through the installation pages where no changes are needed.
3d On the Lucene Configuration page, fill in the following fields.
Lucene configuration type: Select high availability.

Number of high availability search nodes: Specify the number of Lucene nodes where you
have installed the Lucene Index Server.

Novell Vibe 4 Installation Program

Lucene Configuration

Use the following fields to configure the Lucene index. N

To run the Lucene index as a server, select Server from the drop-down list.

“You can run Lucene as a server on the same machine where the Vibe software Is installed or on a
remote machine.

Enter the host name and edit the RMI port if the default port cannot be used.

Max booleans 100000
Merge factor 10

Lucene configuration type: high avallability j

Connection credentials to the lucene server(s):
Login name: ‘iucene service

Password:

o m—
—

Number of high availability search nodes: 2

3e Click Next.

3f On the Configure High Availability Search Nodes page, specify the configuration
information for each Lucene node from the Advanced Vibe Installation Summary Sheet

that you filled out in “Planning a High Availability Lucene Configuration” on page 149, then
click Next.

Novell Vibe 4 Installation Program
Configure High Availablity Search Nodes

Configure the high availability search nodes specified in the previous panel. N

Use the following fields to configure each high availability search node.
To remove one of the high avallable search nodes, unselect Its "Keep" check box.

Enter the high availability service name, host name and edit the RMI Port if the default port cannot
be used.

rHigh Availability Search Node 1

¥ Keep service name:LLaceneLlnux
Service title |Lucene on Linux
Host[172.16.5.2

RMI port 1198

High Avallability Search Node 2
i Keep Service name ELucene Windows

Service title ;Lucene on Windows

Host[172.16.5.9

AMI port|1199

If you need more than 2 high avallability search nodes, you will need
to select "< Back" and increase the specified number of nodes.

3g Click Next until you reach the Ready to Install page, then click Install.
3h On the Installation Complete page, click Finish.

4 Start the reconfigured Vibe server.
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5 Access the reconfigured Vibe server and prevent access to the additional Lucene nodes:

IMPORTANT: All Vibe servers must be reconfigured before any of them access the additional
Lucene nodes.

5a Loginto the reconfigured Vibe server as the Vibe administrator, using the server hostname
rather than your Vibe site URL.

5b Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,

5¢ Under Search Index, click Nodes.

Lucene on Linux (lucenelinux)
Host 172.16.5.2
RMi port: 1199
User Mode Access
@ Read and Write
2 Write Only
) No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)

Host 172.16.5.19
RMi part: 1199

User Mode Access
) Read and Write
@ Write Only
) No Access
Enable Deferred Update Log

No Deferred Update Log Record Exists

By default, the first Lucene node in the list has Read and Write access, meaning that Vibe
updates it as new content is added to the Vibe site. By default, subsequent nodes in the list
have Write Only access, meaning that the Vibe software can update content on the server,
but users cannot access it. When you set up a high availability Lucene configuration
without Vibe site down time, you need to prevent write access during the reconfiguration
process.

5d In the User Mode Access box, change Write Only to No Access for the additional Lucene
nodes.

5e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe server does
not communicate with the additional Lucene nodes.

6 Reconfigure the rest of the Vibe servers:
6a Stop each Vibe server.
6b Repeat Step 3 to configure each Vibe server for the additional Lucene nodes.
6¢ Start each reconfigured Vibe server.
7 Access the reconfigured Vibe site and allow write access to the additional Lucene nodes:
7a Login to the reconfigured Vibe as the Vibe administrator.
7b Click your linked name in the upper right corner of the page, then click the Administration

Console icon %,
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7c¢ Under Search Index, click Nodes.

Lucene on Linux (LuceneLinux}

Host172.16.5.19
RMI port: 1133

User Mode Access
@ Read and Witz
O write Only
O Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

Lucene on Windows (LuceneWindows)

Host: 137.65.67 222
RMI port: 1199

User Mode Access
O Read and Witz
O \rite Only
® Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

7d In the User Mode Access box, change No Access to Write Only for the additional Lucene
nodes.

7e Click Apply, then click Close.

The new setting is put into effect immediately, so that the reconfigured Vibe servers can
now communicate with the additional Lucene nodes, although user access is still
disallowed.

8 Reindex the Vibe site, so that the additional Lucene nodes are updated with the same index
data that the original Lucene Index Server has:

8a On the Administration page, under Search Index, click Index.

Search Index @

Manage Search Index

Re-Index Everything

Select the Places to Be Re-Indexed:
Selecting a folder or workspace automatically indexes all folders and workspaces within it.

B Home Workspace
-5 Users
By Global Workspaces

Groups

g Net Folders
3P Personal Workspace
5: Team Workspaces

Select the Nodes to Apolv Re-Indexing to:

If re-indexing all or large part of the tree, it is strongly recommended to change the access mode ofthe node(s) to write-only before starting
re-indexing so that all read requests can go to the other unselected node(s) while re-indexing is in progress. At least one node must allow

read-write at any given time. Once re-indexing is completed, change the access mode ofthe node(s) back to read-write so that search
requests can use them again

Lucene on Linux (lucenelinux} - Read and Write, Deferred Update Log Enabled, No Deferred Update Log Record Exists
Lucene on Windows (lucenewindows) - Write Only, Deferred Update Log Enabled, No Deferred Update Log Record Exists

8b On the Manage Search Index tab, select Re-Index Everything, so that the entire Vibe site is
reindexed.

8c Select the additional Lucene nodes, but do not select any previously existing nodes.
8d Click OK to start the indexing.
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Depending on the size of your Vibe site, reindexing can be a time-consuming process.
However, because one or more previously existing Lucene Index Servers are still servicing
the Vibe site, users are not affected by the reindexing process.

8e When the reindexing is complete, click Close.
9 Make the additional Lucene nodes available to Vibe users:

9a On the Administration page, under Search Index, click Nodes.

Lucene on Linux (lucenelinux)
Host: 172.16.5.2
RMi port: 1199
User Mode Access
@ Read and Write
2 Write Only
) No Access

Enable Deferred Update Log
No Deferred Update Log Record Exists

Lucene on Windows (lucenewindows)
Host 172.16.5.19
RMi part: 1199
User Mode Access
) Read and Write
@ Write Only
) No Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

9b In the User Mode Access box, change Write Access to Read and Write for the additional
Lucene nodes.

9c¢ Click Apply, then click Close.

The new setting is put into effect immediately, so that Vibe users have additional Lucene
Index Servers available as they use the Vibe site.

Testing Your Lucene High Availability Configuration

When you first set up your high availability Lucene configuration, you can configure Micro Focus
Vibe to write Lucene node information to the Tomcat log file so that you can observe the behavior of
the Lucene nodes. Then you can take nodes down and bring them up again to see the effect on your
Vibe site. This process helps you prepare for the situation where a Lucene node goes down
unexpectedly or you need to take one down on purpose, perhaps for maintenance.

+ “Configuring Vibe to Log Lucene Node Activity” on page 163
+ “Observing Lucene Node Activity” on page 163

NOTE: For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Micro Focus Vibe 4.0.5 Administration Guide.
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Configuring Vibe to Log Lucene Node Activity

By default, Vibe writes an error to the Tomcat log file whenever it cannot communicate with a
Lucene node. For testing purposes, you can change the logging level so that the Tomcat log file
includes a message for each time Vibe contacts a Lucene Index Server.

After observing and understanding the behavior, you should return the logging to normal levels.

1 Openthel og4j . properti es file in a text editor.
The location of the | 0g4j . properti es file varies by platform.

Linux: / opt/ novel | / t eam ng/ apache-t ontat / webapps/ ssf/ WEB- | NF

Windows: c¢:\Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF

2 Search for the following line:
#l og4j . cat egory. com novel | . t eanm ng. sear ch=DEBUG

3 Remove the pound sign (#) from the beginning of the line to activate the DEBUG logging level
for the Lucene Index Server.

The DEBUG logging level adds a message for each time Vibe contacts a Lucene Index.
4 Save thel og4j . properti es file, then exit the text editor.
5 Stop Vibe, then start Vibe to put the new logging level into effect.

Observing Lucene Node Activity

After changing the Vibe logging level to include Lucene node activity, you can monitor the Tomcat
log file to see which Lucene nodes Vibe is contacting.
1 Change to the directory where the Tomcat log file is located.

For background information about the Tomcat log file, see “Tomcat Log File” in “Site
Maintenance” in the Micro Focus Vibe 4.0.5 Administration Guide.

2 On Linux, use thet ai | command to monitor the end of the Tomcat log file.
tail -f catalina. out
or

On Windows, download an equivalent command from the Internet in order to perform the
following steps.

For example, there is a command available at SourceForge.net (http://sourceforge.net/
projects/tailforwin32).

3 Perform some activities on the Vibe site to create new content.

For example, you could create a blog entry. The Tomcat log file shows that Vibe is contacting
each available Lucene Index Server in turn as it submits the new information for indexing.
Nodes are considered available if they are marked Read and Write in the User Mode Access box
on the Lucene Nodes page.

4 Bring down one of the Lucene nodes.

Running Multiple Lucene Index Servers 163


http://sourceforge.net/projects/tailforwin32
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bkkrbbq
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bj5cu0t
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bj5cu0t
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo

164

For example, you might reboot the Lucene server, stop the Lucene Index Server on the node, or
otherwise prevent Vibe from contacting the Lucene node.

5 Observe that the Tomcat log file displays an error when the Lucene node becomes unavailable.
6 Perform some additional activities on the Vibe site that create new content.

You might notice a pause as Vibe tries to connect with the Lucene node that is no longer
available.

7 Observe that the Tomcat log file shows when normal Vibe processing has resumed without
access to the unavailable Lucene node.

8 Make the unavailable Lucene node available again.

9 Observe that the Tomcat log file indicates that Vibe has created a journal record on the Lucene
node that was temporarily unavailable.

The journal record contains the indexing operations that failed to take place while the Lucene
node was unavailable. Even though the Lucene node is back up, Vibe does not start accessing it
until it has been synchronized with the latest index information.

10 To synchronize the out-of-date Lucene node, follow the steps in “Synchronizing a High
Availability Lucene Configuration” on page 164.

After the out-of-date Lucene node has been synchronized, Vibe starts accessing it again.
If a situation arises where no Lucene node is marked Read and Write in the User Mode Access box on
the Lucene Nodes page, Vibe temporarily accesses the first node in the list that is set to Write Only.
If no nodes are set to Write Only or Read and Write, Vibe temporarily accesses the first node in the

list, even though it is set to No Access. This functionality is required because you cannot log in to the
Vibe site without access to a Lucene Index Server.

Synchronizing a High Availability Lucene Configuration

You should ensure that your Lucene node servers remain in sync with each other. Whenever a
Lucene node is down for a relatively short period of time (no more than one or two days), you can
synchronize it with other Lucene nodes whose index files are up-to-date.
1 Ensure that the out-of-date Lucene node is running reliably again.
2 Login to the Micro Focus Vibe site as the Vibe administrator.
3 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

4 Under Search Index, click Nodes.
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5 To repair the out-of-date Lucene node, select Apply Deferred Update Log Records to the Index,

then click Apply.

The Deferred Update Log options disappear if the update is successful. If for some reason the

deferred update log records cannot be applied to the index, you can rebuild the index, as
described in “Rebuilding the Lucene Index” in “Site Maintenance” in the Micro Focus Vibe 4.0.5

Administration Guide.

6 Click Close.
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Running Multiple Database Servers

Each of the four databases supported by Micro Focus Vibe (MySQL, MariaDB, Microsoft SQL, Oracle,
and PostgreSQL) has its own approach to clustering the database server. Information about
clustering database servers is available on the Internet, for example:

+ MySQL Cluster (http://www.mysqgl.com/products/database/cluster)
¢ MariaDB (https://mariadb.com/kb/en/mariadb/galera-cluster/)

+ SQL Server Clustering (http://www.sgl-server-performance.com/articles/clustering/
clustering_intro_p1.aspx)

+ Oracle Real Application Clusters (http://www.oracle.com/technology/products/database/
clustering)

¢ PostgreSQL High Availability (https://www.postgresql.org/docs/9.6/static/high-availability.html)

NOTE: We highly recommend that you follow the instructions in Part I, “Basic Installation,” on
page 33 before attempting a more complex Vibe configuration.
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Upgrade

*

Chapter 24, “Upgrading From Novell Vibe 4.x to Micro Focus Vibe 4.0.5,” on page 171
Chapter 25, “Upgrading From Novell Vibe 3.4 to Micro Focus Vibe 4.0.5,” on page 183

*

*

Chapter 26, “Upgrading to Novell Vibe 3.4 from Previous Versions,” on page 203

*

Chapter 27, “Updating the Operating System Where Vibe Is Running,” on page 205
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Upgrading From Novell Vibe 4.x to Micro
Focus Vibe 4.0.5

This section describes how to upgrade from Novell Vibe 4.x to Micro Focus Vibe 4.0.5.

After you upgrade your Vibe system, ensure that you check the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

*

*

“Obtaining and Preparing the Vibe 4.0.5 Software” on page 171
“Understanding the Upgrade Process” on page 171

“Backing Up Vibe Data” on page 172

“Remote Lucene Index Server Upgrade” on page 172

“Preserving Self-Signed Certificates During the Upgrade” on page 174
“Upgrading the Vibe Software” on page 175

“If the Installer Reports an Error” on page 176

“Upgrading the Vibe Database from 4.x to 4.0.5” on page 176
“Performing Post-Upgrade Tasks” on page 178

Obtaining and Preparing the Vibe 4.0.5 Software

You can download Vibe 4.0.5 through your Customer Center account or obtain the software from a
Micro Focus Partner.

As you extract the software, make sure that you don’t overwrite the previous Vibe version.

Understanding the Upgrade Process

During the upgrade to Vibe 4.0.5, the following aspects of your Vibe system are modified:

*

*

The software is upgraded to Vibe 4.0.5.

A backup copy of your existing Vibe 4.x installation is created in the following directory:

Linux: / opt/ novel | /t eam ng/t eam ng- backup

Windows: C:\ Program Fi | es\ Novel I \ Teani ng\t eam ng- backup

If your original Vibe system began with version 1.0 (this version of Novell Vibe is called Novell
Teaming), the backup copy is located in the following directory:

Linux: /opt/icecore

Windows: C:\ Program Fi |l es\icecore
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¢ The Java Virtual Machine (JVM) software that you installed to support the previous version of
Vibe is replaced by a customized version of OpenJDK.

Using a separate JDK and JRE is no longer required, nor is it supported.

Backing Up Vibe Data

Ensure that your Vibe data is backed up before you begin the upgrade process. For information
about the data that needs to be backed up, see “Backing Up Vibe Data” in the Micro Focus Vibe
4.0.5 Administration Guide.

Because of significant changes to the database schema, Micro Focus recommends that you use your
database backup software to back up your Vibe database before upgrading to Vibe 4.0.5.

Remote Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you do
not need to upgrade it separately. Skip to “Preserving Self-Signed Certificates During the Upgrade”
on page 174,

You have the following options when upgrading your remote Lucene search index to Vibe 4.0.5:
¢ Create a new search index

Because a full re-index is required after upgrading to Vibe 4.0.5, creating a new search index is
less time-consuming than upgrading your existing search index. The benefit to creating a new
Lucene search index is that you are able to maintain the original search index in the unlikely
case of an emergency rollback.

+ Upgrade your existing Lucene search index

If you choose to upgrade your existing Lucene search index, you must perform a re-index after
the upgrade, as described in “Resetting the Search Index” on page 179.

These options are described in the following sections:

+ “Creating a New Search Index” on page 172

¢ “Upgrading an Existing Search Index” on page 173

Creating a New Search Index

1 Stop Vibe.

Linux: On the Vibe server, specify the following command:
/etc/init.d/team ng stop

Windows: See “Stopping Vibe as an Application” on page 86.

2 Stop the Lucene search index.

On the Lucene index server, specify the following command:
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Linux: /etc/init.d/indexserver stop

Windows: c¢:\ Program
Fi I es\ Novel I\ Team ng\ | uceneserver\i ndexserver\bin\i ndexserver -
shut down. bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe4.0 system.

4 On a different server than where your original search index was running, create a new search
index, as described in “Installing the Lucene Software” on page 137.

Upgrading an Existing Search Index

The Vibe installation program cannot upgrade the Lucene search index when it is running on a
remote server. To upgrade your remote search index from Novell Vibe 4.x to Micro Focus Vibe 4.0.5,
you need to run the Remote Lucene Server installation program:

1 Stop Vibe.

Linux: On the Vibe server, specify the following command:
/etc/init.d/team ng stop

Windows: See “Stopping Vibe as an Application” on page 86.

2 Stop the Lucene search index.

On the Lucene index server, specify the following command:

Linux: /etc/init.d/indexserver stop

Windows: c¢:\ Program
Fi | es\ Novel I\ Teanmi ng\ | uceneserver\indexserver\bi n\i ndexserver -
shut down. bat

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 4.x system.

4 Copy the Vibe 4.0.5 Remote Lucene Server Installation program from the directory where the
Vibe 4.0.5 Installation program is located to a convenient directory on the server where the
remote Lucene search index is located.

The name of the Remote Lucene Server Installation program varies by platform:

Linux: | ucene-installer.!|inux

Windows: | ucene-installer.exe

5 Start the Vibe 4.0.5 Remote Lucene Server installation program.
6 Accept the License Agreement, then click Next.

7 Select Update software and settings.
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Click Next to continue.

9 Click Next to accept the installation location.

10
11
12

13
14
15

16

17

18

Click Next to accept the Java JDK location.
In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see “Changing Lucene Configuration
Settings” on page 100.

Click Install to install the upgraded Lucene search index software.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Lucene search index server, reboot the server
where it is running to ensure that the 4 cache is cleared.

Start the Lucene Index Server.

On the Lucene index server, specify the following command:

Linux: systenctt| start indexserver.service

Windows: ¢:\ Program
Fi | es\ Novel I \ Team ng\ | uceneserver\i ndexserver\bi n\i ndexserver -
startup. bat

Ensure that the index server is running.
/etc/init.d/indexserver status

Now that all remote Vibe components have been upgraded, follow the instructions in
“Upgrading the Vibe Software” on page 175.

Preserving Self-Signed Certificates During the Upgrade

If your Vibe site uses self-signed certificates for SSL connections to other services, such as LDAP,
WebDAV, and so on, the Vibe 4.0.5 installation program can preserve SSL connectivity by
automatically importing the certificates that you identify in your old JAVA Certificate Store (cacerts)
to the new OpenJDK cacerts file.

The process works as follows:

1

You must identify the aliases of the certificates you want to have imported to the new
certificate store. If you are unsure of any alias names, you can list the aliases in the current
cacerts file using a command similar to the following:

keytool -list -v -keystore $JAVA HOVE/jre/lib/security/cacerts

When you run the Vibe installer, you are prompted to enter the alias names, separated by
commas.

3 The Vibe installer makes appropriate backup copies of the old and new cacerts files.

When the installation process concludes, the new OpenJDK installation is configured for secure
communications just like your previous Java installation.
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Upgrading the Vibe Software

Complete the following steps for each server in your Vibe system that is running the Vibe software:

1 Ensure that you have a current backup of your Vibe 4.x system.
2 Stop Vibe.

Linux: On the Vibe server, specify the following command:
/etc/init.d/team ng stop

Windows: See “Stopping Vibe as an Application” on page 86.

3 Ensure that no application (such as a command prompt or Windows Explorer) is running on the
Vibe 4.x system.

4 Copytheinstaller.xm file from the directory where the previous-version Vibe 4
Installation program is located to the directory where you have extracted the Vibe 4.0.5
software.

5 Copythelicense-key.xm file from the directory where the Vibe 4 Installation program is
located to the directory where you have extracted the Vibe 4.0.5 software.

Alternatively, you can obtain a new license key (*. xr ) from the location where you
downloaded the Vibe 4.0.5 software, copy it to the directory containing the extracted Vibe
4.0.5 software, and rename itto | i cense-key. xm .

6 Start the Vibe 4.0.5 installation program.

If you need assistance with this task, see the detailed installation instructions for the platform
where you are upgrading Vibe:

¢ “Running the Linux Vibe Installation Program” on page 70
¢ “Running the Windows Vibe Installation Program” on page 81
7 Accept the License Agreement, then click Next.
Novell Vibe 4 Installation Program = X

Installation Options

Select the action you want to perform.

T New installation
+ Update software and settings
" Reconfigure settings

Because you provided your Vibe 4i nst al | er. xm file in the directory with the Vibe 4.0.5
installation program, the Update software and settings installation option is selected by default.

8 Click Next to continue.
9 Click Yes to let the Installation program know that you have stopped Vibe.

10 Select the check box to let the installation program know that you have backed up all of your
data, then click Next.
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11 Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then
click Next.

For more information about the differences between basic and advanced installations, see
“What Is a Basic Vibe Installation?” on page 41 and “What Is an Advanced Installation?” on
page 95.

12 Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 4.0.5 system.

13 If you are using self-signed certificates to secure communications between Vibe and other
services, when you reach the Java JDK screen, enter the aliases that you used when importing
the certificates, in a comma-separated list.

14 Click Install when you are ready to perform the upgrade.
15 Click Finish when the upgrade is complete.
If the installer reports errors, skip to “If the Installer Reports an Error” on page 176.

16 (Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the
cache is cleared.

17 Continue with “Upgrading the Vibe Database from 4.x to 4.0.5” on page 176.

If the Installer Reports an Error

1 If you have typed an alias name wrong, or if the installer doesn’t find a specified certificate for
some other reason, it notifies you.

Theinstal | er. | og file has information about the error.

2 Run the installation again as instructed in “Upgrading the Vibe Software” on page 175 and be
sure to repeat Step 4 on page 175 so that thei nstal | er. xm file doesn’t contain any
modifications made by the failed attempt to install 4.0.5.

Upgrading the Vibe Database from 4.x to 4.0.5

Upgrade the Vibe software (as described in “Upgrading the Vibe Software” on page 175) before
upgrading the Vibe database.

When you upgrade to Vibe 4.0.5, the Vibe Installation program does not update the database as part
of the Vibe software upgrade. Therefore, you must manually update the database before you can
start Vibe:

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set
for the Vibe system is in UTF-8 format.
1a To view the character set format, run the following command:

SELECT default_character_set _name FROM i nf ormati on_schema. SCHEMATA
S WHERE schema_name = 'sitescape';

In this command si t escape is the name of the Vibe database. Replace si t escape with
the name of your database.

1b If the character set format is anything other than UTF-8, run the following command to
change it:
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In the following command, si t escape is the name of the Vibe database. Replace
si t escape with the name of your database.

ALTER DATABASE sitescape CHARACTER SET utf 8;
2 Change to the db directory in the Vibe installation:
cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
+ nysql -1iqui base. properties
¢ Oracl e-1iquibase. properties
+ sqgl server-1iquibase. properties

3 In atext editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and r ef er enceDri ver sections. Save and close the
text editor when you are finished making changes.

¢ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace | ocal host with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database
is si t escape, the name of the company that previously developed the Vibe software).

4 Save your changes and close the properties file.

5 Inthe same directory (/ vi be_i nstal | ati on/tenp-install er/db), execute the following
commands to update the database schema:

Windows SET PATH=C.\path_to_java_used_by vi be\bi n; %ATH%
manage- dat abase. bat dat abase_t ype updat eDat abase

Possible database types (dat abaseType) are nysql , or acl e, or sql server,
depending on your type of database.

Linux PATH=/ path_to_j ava_used_by_ vi be/ bi n: $PATH
./ manage- dat abase. sh dat abase_t ype updat eDat abase

Possible database types (dat abaseType) are nysql , or acl e, or sql server,
depending on your type of database.

NOTE: Ensure that the manage- dat abase. sh file is executable.

NOTE: You can safely ignore the following Liquibase log messages:

+ Varni ng: nodi fyDataType will | ose primary key/autoi ncrenent/not nul |
settings for mysql

* Any messages that contain the wordsi nfo: failureorinfo: fail ed,aslongasthey
are associated with a type | NFOmessage

6 Start Vibe 4.0.5.

When you start Vibe for the first time after the upgrade, it takes longer to start than usual
because data in the Vibe database must be upgraded before the Vibe site is ready to use.
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Linux: On the Vibe server, specify the following command:
systenct!| start vibe.service

Windows: See “Starting Vibe as an Application” on page 86.
or
See “Starting Vibe as a Windows Service” on page 85.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your
existing Windows service configuration and re-configure Vibe as a Windows service before
you can start Vibe. For information about how to configure Vibe as a Windows service, see
“Configuring Vibe as a Windows Service” on page 85.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in
“Creating the Vibe Database” on page 73.

7a Change to the db directory in the Vibe installation:
cd /vibe_installation/tenp-installer/db
This directory contains the following properties files:
+ nysql -li qui base. properties
¢ Oracl e-liquibase.properties
¢ sql server-1iqui base. properties

7b In a text editor, open the dat abase_t ype-1i qui base. properti es file that
corresponds with your database type, then delete the password.

7c Save and close the properties file.

8 Continue with “Performing Post-Upgrade Tasks” on page 178.

Performing Post-Upgrade Tasks

After you start Micro Focus Vibe, you can access your Vibe site as usual. However, you need to reset
some aspects of the interface before you allow users to access the upgraded site. The interface reset
affects only those definitions and templates that are included with the Vibe product. If you have
created custom definitions and templates, they are unaffected by the interface reset.

¢ “Re-Installing the Windows Service” on page 179

+ “Resetting the Search Index” on page 179

+ “Resetting the Standard Templates” on page 180

+ “Resetting Your Definitions” on page 181

¢ “Updating the Server.xml File When Using Secure HTTP” on page 182
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Re-Installing the Windows Service

If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on
page 84), you must do the following by using the instructions in the same section.
1. Remove the service as described in “Removing Vibe as a Windows Service” on page 84.

2. Re-install the service as described in “Configuring Vibe as a Windows Service” on page 85.

This is necessary because the original service references an unsupported version of Tomcat.

Resetting the Search Index

In order for an upgraded search index to be compatible with Vibe 4.0.5, you need to re-index the
search index. Until you reset the search index, the search index and the vibe server are not in a
compatible state. The cat al i na. out and appser ver . | og files show errors until the search index
is reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 22, “Running Multiple
Lucene Index Servers,” on page 149.

Depending on the size of your Vibe site, this can be a very time-consuming process.

¢ “Resetting a Single Search Index” on page 179

+ “Resetting the Search Index with Multiple Index Servers” on page 180

Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 In the Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

6 After the index server has been reset, ensure that no errors are contained in the following log

files:
Windows: ¢ C \Program Fi | es\ Novel I \ Teanm ng\ apache-
tontat\ | ogs\ cat al i na. out
¢ C \Program Fi |l es\ Novel I \ Team ng\ apache-
tontat\ | ogs\ appserver. | og
Linux: * /opt/novel | /tean ng/ apache-tontat/| ogs/ catal i na. out

¢ /opt/novel I /team ng/ apache-tontat/| ogs/ appserver. | og
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Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

In the Search Index section, click Index.

Select Re-Index Everything.

Select each node that you want to re-index.

Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

a U~ W

A message notifies you when indexing is complete.

7 After the index server has been reset, ensure that no errors are contained in the following log

files:
Windows: ¢ C \Program Fi |l es\ Novel I \ Teanm ng\ apache-
tontat\ | ogs\ cat al i na. out
¢ C \Program Fi | es\ Novel I \ Tean ng\ apache-
tontat\ | ogs\ appserver. | og
Linux: * /opt/novel | /teamn ng/ apache-tontat/| ogs/catal i na. out

¢ /opt/novel I /team ng/ apache-tontat/| ogs/ appserver. | og

Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously
made to the default Vibe templates. If you have manually customized any default Vibe templates,
back up the files you have modified before performing the interface reset. This applies only to
default templates that you have modified; templates that you have created are not affected.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 In the Management section, click Workspace and Folder Templates.
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Workspace and Folder Templates

Mew - Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically pro
larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal Workspace. Visitors ms
A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users’ social networks.

Files - Afile folder is a place to put files. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatical
user to add and delete files via any WebDAY client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - A micro-blog folder is a spe
one that is created automatically will be

Mirrored Files - A mirrored file folder is a special type of file folderwhere it uses a server file system directory as its file storage area instead of the nom
knowledge about the folder contents in synch with whatever is in the directory. The mirrored folder feature can mirror any WebDAV or local file path.

ial folder that gets created automatically for each user. It is intended to contain short text entries only. Each us
essed as the user's real micro-blog.

4 Click Reset.
5 Click OK to confirm, then click Close.

Your Vibe site is now ready for use.

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 4. Some of
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes
you have made in order to make it easier to reconstruct the definition after you reset it. This applies
only to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon .
In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.
6 Click OK.
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Updating the Server.xml File When Using Secure HTTP

The server . xm Tomcat configuration file (apache-t ontat - | ocati on/ conf/server. xm )is
overwritten during the upgrade to Vibe 4.0.5. If you set up secure HTTP browser connections to the
Vibe server, and if you changed the password for the . keyst or e file to something other than the
default changei t , you need to update the server. xm file after upgrading Vibe.

For information about how to update the . keyst or e password in the server . xnl file, see “Do
Not Change the Password for the Keystore File” in the Micro Focus Vibe 4.0.5 Administration Guide.
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Upgrading From Novell Vibe 3.4 to Micro
Focus Vibe 4.0.5

This section describes how to upgrade from Novell Vibe 3.4 to Micro Focus Vibe 4.0.5.

After you upgrade your Vibe system, ensure that you check the Vibe download site where you
downloaded the Vibe software for any hot patches that might be available.

+ “Backing Up Vibe Data” on page 183

+ “AVibe Backup Is Automatically Created” on page 183

¢ “Upgrading Vibe on Linux” on page 184

¢ “Continuing the Vibe 3.4 to Vibe 4.0.5 on Linux” on page 193
¢ “Upgrading Vibe on Windows from 3.4 to 4.0.5” on page 193

Backing Up Vibe Data

Ensure that your Vibe data is backed up before you begin the upgrade process. For information
about the data that needs to be backed up, see “Backing Up Vibe Data” in the Micro Focus Vibe
4.0.5 Administration Guide.

Because of significant changes to the database schema, Micro Focus recommends that you use your
database backup software to back up your Vibe database before upgrading to Vibe 4.

A Vibe Backup Is Automatically Created

A backup copy of your existing Vibe 3.4 installation is created in the following locations, depending
on the hosting platform:

Linux: [ opt/ novel | / t eam ng/ t eam ng- backup

Windows:  C.\ Program Fi | es\ Novel | \ Team ng\t eam ng- backup

If your original Vibe system was Novell Teaming 1.0, the backup copy is located in the following
locations, depending on the hosting platform:

Linux: /opt/icecore

Windows: C.\Program Fil es\icecore

Upgrading From Novell Vibe 3.4 to Micro Focus Vibe 4.0.5 183


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bj5cvvl
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_admin/vibe4_admin.pdf#bookinfo

184

Upgrading Vibe on Linux

Overview-The Linux Upgrade Process

The platform requirements of Vibe 3.4 and Vibe 4.0.5 on Linux don’t overlap.

Therefore, it’s not possible to upgrade from Vibe 3.4 to Vibe 4.0.5 on the same server hardware.
Upgrading from 3.4 to 4.0.5 requires the installation of a new SLES 15 (or SLES 12) server along with
the specific upgrade and migration processes that are outlined in Figure 25-1 and Table 25-1 and
detailed in the sections referenced.

Figure 25-1 Graphical Overview—Upgrading from Vibe 3.4 to Vibe 4.0.5

Upgrading Vibe 3.4 to Vibe 4.0.5

SLES 11 Server © SLES 15 (or 12) Server
(Source) (Target)
. Upgrade . Upgrade
Vibe 3.4 —opgrade . 404 Vibe 4.0.4 P8, \ine 4.0.5
3.4 Service | ——  4.0.4 Service (4] 404 Service | ——  4.0.5 Service
Migrate
3.4 Data —_— 4.0.4 Data ====(Replace)===> 4.0.4Data —_— 4.0.5 Data
3.4 Database 4.0.4 Database Migrate 4.0.4 Database 4.0.5 Database
sitescape.sql sitescape.sql=—=(Replace)=——==P>sitescape.sql sitescape.sql

Table 25-1 Upgrade Process Explanation

Step

Explanation

¢ Using the instructions in this chapter, upgrade the source server from Vibe 3.4 to Vibe 4.0.4.

Install a new SLES 15 (recommended) or SLES 12 (supported) Server.

Install Vibe 4.0.4 on the target (new) SLES server. For instructions, download the 4.0.4
documentation set in PDF format. See “Previous Release” on the Vibe 4.0.5 documentation
web site (https://www.novell.com/documentation/vibe4).

Migrate the data from your current (source) Vibe 4.0.4 deployment to the new (target) Vibe
4.0.4 deployment. This involves replacing the data on the new server with the source server’s
Vibe data. See “Migrating Vibe on Linux” on page 210.

Migrate the sitescape.sqgl database from your current Vibe 4.0.4 deployment to the new Vibe
4.0.4 deployment. As with the data, this involves replacing the newly deployed database with
the older database. See “Importing the Vibe Database to the Target Server” on page 212.

@ O © 0060

After verifying that Vibe 4.0.4 is running on the new server as expected, upgrade Vibe to
version 4.0.5. See Chapter 24, “Upgrading From Novell Vibe 4.x to Micro Focus Vibe 4.0.5,” on
page 171.
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Preparing the New Target Server

As outlined in “Overview—The Linux Upgrade Process” on page 184, upgrading Vibe on Linux from
version 3.4 to 4.0.5 requires interim steps that involve the installation of a new Vibe 4.0.4 server.

Use the Vibe 4.0.4 software available through your Customer Center account for the new server.

If you need Vibe 4.0.4 installation instructions, download the 4.0.4 documentation set in PDF format
by accessing the “Previous Release” section on the Vibe 4.0.5 documentation web site (https://
www.novell.com/documentation/vibe4).

IMPORTANT: To ensure a smooth upgrade process, we recommend that you prepare your new
target Vibe 4.0.4 server before continuing the upgrade process.

Keep in mind that the new server will eventually be running Vibe 4.0.5.
Make sure that

+ Your new server meets the Vibe 4.0.5 system requirements specified in Part II, “System
Requirements and Support,” on page 21.

+ The new deployment uses the same database type as the previous deployment.

Remote Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you do
not need to upgrade it separately. Skip to “Upgrading the Linux Vibe Software” on page 187.

You have the following options when upgrading your remote Lucene search index to Vibe 4:
¢ Create a new search index

Because a full re-index is required after upgrading to Vibe 4, creating a new search index is less
time-consuming than upgrading your existing search index. The benefit to creating a new
Lucene search index is that you are able to maintain the original search index in the unlikely
case of an emergency rollback.

+ Upgrade your existing Lucene search index
If you choose to upgrade your existing Lucene search index, you must perform a re-index after
the upgrade, as described in “Resetting the Search Index” on page 190.

These options are described in the following sections:

+ “Creating a New Search Index” on page 185

¢ “Upgrading an Existing Search Index” on page 186

Creating a New Search Index

1 On the Vibe server at a terminal prompt, stop Vibe by entering/etc/init.d/team ng
st op.

2 Onthe Lucene server, stop the Lucene search index by entering/ et ¢/ i ni t. d/i ndexserver
st op.

Upgrading From Novell Vibe 3.4 to Micro Focus Vibe 4.0.5 185


https://www.novell.com/documentation/vibe4

186

3
4

Ensure that no application (such as a command prompt) is running on the Vibe 3.4 system.

On a different server than where your original search index was running, create a new search
index, as described in “Installing the Lucene Software” on page 137.

Upgrading an Existing Search Index

The Vibe installation program cannot upgrade the Lucene search index when it is running on a
remote server. To upgrade your remote search index from Novell Vibe 3.4 to Novell Vibe 4, you need
to run the Remote Lucene Server installation program:

1

On the Vibe server at a terminal prompt, stop Vibe by entering/etc/init. d/team ng
st op.

On the Lucene server, stop the Lucene search index by entering/ et ¢/ i ni t. d/i ndexserver
st op.

3 Ensure that no application (such as a command prompt) is running on the Vibe 3.4 system.

O 00 N O U

10
11
12

13
14
15

16

17

18

Copy the Vibe 4 Remote Lucene Server Installation program—| ucene-i nstal |l er. | i nux-—
from the directory where the Vibe 4 Installation program is located to a convenient directory on
the server where the remote Lucene search index is located.

Start the Vibe 4 Remote Lucene Server installation program.

Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

Click Next to accept the installation location.

Click Next to accept the Java JDK location.

In the Host field, specify the hostname where you are installing the remote Lucene Index Server.
Change Lucene configuration settings as needed, then click Next.

For information about Lucene configuration settings, see “Changing Lucene Configuration
Settings” on page 100.

Click Install to install the upgraded Lucene search index software.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Lucene search index server, reboot the server
where it is running to ensure that the 3.4 cache is cleared.

On the Lucene server, start the Lucene Index Server by entering systenct| start
i ndexserver. servi ce.

Ensure that the index server is running.
[etc/init.d/indexserver status

Now that all remote Vibe components have been upgraded, follow the instructions in
“Upgrading the Linux Vibe Software” on page 187.
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Upgrading the Linux Vibe Software

Complete the following steps for each server in your Vibe system that is running the Vibe software:

1 Ensure that you have a current backup of your Vibe 3.4 system.

2 On the Vibe server, stop Vibe by entering/ etc/init. d/team ng stop.

3 Ensure that no application (such as a command prompt) is running on the Vibe 3.4 system.
4

Copytheinstaller.xn file from the directory where the Vibe 3.4 Installation program is
located to the directory where you have extracted the Vibe 4 software.

Theinstall er.xnl file provides default values when you run the Vibe 3.4 Installation
program.

5 Obtain a new license key from the location where you downloaded the Vibe 4 software, then
place it in the same directory with the Vibe software. (The Vibe installation program does not
start without a license file in the same directory.) Rename the license to | i cense- key. xni .

Vibe 4 requires an updated license. If you use a license from a previous version, not all features
are available.

6 Make sure that your server platform meets the requirements outlined for the Vibe 4.0.4
release. See the Vibe 4.0.4 documentation available for download from the Vibe 4.0.5
documentation site (https://www.novell.com/documentation/vibe4).

7 Start the Vibe 4 installation program.

If you need assistance with this task, see the detailed installation instructions in “Running the
Linux Vibe Installation Program” on page 70.

8 Accept the License Agreement, then click Next.

Novell Vibe 4 Installation Program = X

Installation Options

Select the action you want to perferm.

T New installation
* Update software and settings
" Recenfigure settings

Because you provided your Vibe 3.4 i nst al | er. xm file in the directory with the Vibe 4.0.4
installation program, the Update software and settings installation option is selected by default.

9 Click Next to continue.
10 Click Yes to let the Installation program know that you have stopped Vibe.

11 Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

12 Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then
click Next.

For more information about the differences between basic and advanced installations, see
“What Is a Basic Vibe Installation?” on page 41 and “What Is an Advanced Installation?” on
page 95.
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13 Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 4 system.

14 Click Install when you are ready to perform the upgrade.
15 Click Finish when the upgrade is complete.

16 (Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the
3.4 cache is cleared.

17 Continue with “Upgrading the Vibe Database from 3.4 to 4.0.4” on page 188.

Upgrading the Vibe Database from 3.4 to0 4.0.4

IMPORTANT: Make sure you do the following:

1. Upgrade the Vibe software (as described in “Upgrading the Linux Vibe Software” on page 187)
before upgrading the Vibe database.

2. Because the Vibe 4 upgrade process does not update the database as part of the Vibe software
upgrade, you must

¢ Ensure that the 3.4 system is in UTF-8 format before updating the database.
¢ Manually update the database before you start Vibe.

The following example outlines the process for MySQL. Refer to the documentation for your
database type as needed.

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set
for the Vibe 3.4 system is in UTF-8 format.
la To view the character set format, run the following command:

SELECT default_character_set _name FROM i nf ormati on_schema. SCHEMATA
S WHERE schema_nane = 'sitescape’

In this command si t escape is the name of the Vibe database. Replace si t escape with
the name of your database.

1b If the character set format is anything other than UTF-8, run the following command to
change it:

In the following command, si t escape is the name of the Vibe database. Replace
si t escape with the name of your database.

ALTER DATABASE sitescape CHARACTER SET utf 8;
2 Change to the db directory in the Vibe installation:
cd /vibe_ installation/tenmp-installer/db
This directory contains the following properties files:
+ nysql -1i qui base. properties
¢ Oracle-1iquibase. properties
¢ sql server-1iqui base. properties
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3 In atext editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and r ef er enceDri ver sections. Save and close the
text editor when you are finished making changes.

+ Change the database user name and password for accessing the database.
+ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace | ocal host with the IP address of the remote server.

¢ (Optional) Change the name of the Vibe database (the default name of the Vibe database
is si t escape, the name of the company that previously developed the Vibe software).

4 Save your changes and close the properties file.

5 Inthe same directory (/ vi be_i nstal | ati on/tenp-install er/db), execute the following
commands to update the database schema:

PATH=/ pat h_t o_j ava_used_by_vi be/ bi n: $PATH (if not already set)
./ manage- dat abase. sh dat abaseType nar k33Dat abaseAsUpdat ed
./ manage- dat abase. sh dat abaseType updat eDat abase

Possible database types (dat abaseType) are nysql , or acl e, or sql server, depending on
your type of database.

NOTE: Ensure that the manage- dat abase. sh file is executable.

NOTE: You can safely ignore the following Liquibase log messages:

¢+ VArning: nodi fyDataType will | ose primary key/autoi ncrenent/not nul
settings for mysq

+ Any messages that contain the wordsi nfo: failureorinfo: fail ed,aslongasthey
are associated with a type | NFOmessage

6 Start Vibe 4 in the same way that you have been starting Vibe 3.4 (/etc/ini t. d/t eam ng
start)

When you start Vibe for the first time after the upgrade, it takes longer to start than usual
because data in the Vibe database must be upgraded before the Vibe site is ready to use.

7 (Recommended) For security reasons, delete the password that you specified in Step 7 in
“Creating the Vibe Database” on page 73.

7a Change to the db directory in the Vibe installation:
cd /vibe_installation/tenp-installer/db
This directory contains the following properties files:
* nysql -1iqui base. properties
¢ Oracl e-liquibase. properties
¢ sql server-1iqui base. properties

7b In a text editor, open the dat abase_t ype-Ii qui base. properti es file that
corresponds with your database type, then delete the password.

7c¢ Save and close the properties file.

8 Continue with “Performing Post-Upgrade Tasks” on page 190.
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Performing Post-Upgrade Tasks

After you start Micro Focus Vibe 4, you can access your Vibe site as usual. However, you need to
reset some aspects of the interface before you allow users to access the upgraded site. The interface
reset affects only those definitions and templates that are included with the Vibe product. If you
have created custom definitions and templates, they are unaffected by the interface reset.

+ “Resetting the Search Index” on page 190

+ “Resetting Your Definitions” on page 191

+ “Resetting the Standard Templates” on page 192
+ “Updating the Server.xml File When Using Secure HTTP” on page 192

Resetting the Search Index

In order for an upgraded search index to be compatible with Vibe 4, you need to re-index the search
index. Until you reset the search index, the search index and the vibe server are not in a compatible
state. The cat al i na. out and appser ver. | og files show errors until the search index is reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 22, “Running Multiple
Lucene Index Servers,” on page 149.

Depending on the size of your Vibe site, this can be a very time-consuming process.

¢ “Resetting a Single Search Index” on page 190

¢ “Resetting the Search Index with Multiple Index Servers” on page 191

Resetting a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 In the Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

6 After the index server has been reset, ensure that no errors are contained in the following log
files:

+ /opt/novel |/t eam ng/ apache-tontat/| ogs/ catal i na. out
+ /opt/novel |/t eam ng/ apache-tontat/| ogs/ appserver. | og

190 Upgrading From Novell Vibe 3.4 to Micro Focus Vibe 4.0.5



Resetting the Search Index with Multiple Index Servers

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

In the Search Index section, click Index.

Select Re-Index Everything.

Select each node that you want to re-index.

Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.
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A message notifies you when indexing is complete.

7 After the index server has been reset, ensure that no errors are contained in the following log
files:

+ /opt/novel |/t eam ng/ apache-tontat/| ogs/ catal i na. out
+ /opt/novel |/t eam ng/ apache-tontat/| ogs/ appserver. | og

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 3.4. Some of
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes
you have made in order to make it easier to reconstruct the definition after you reset it. This applies
only to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.

6 Click OK.
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Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously
made to the default Vibe templates. If you have manually customized any default Vibe templates,
back up the files you have modified before performing the interface reset. This applies only to
default templates that you have modified; templates that you have created are not affected.

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

3 In the Management section, click Workspace and Folder Templates.

Workspace and Folder Templates
Mew - Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically pro
larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal Workspace. Visitors ms
A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users’ social networks.

Files - Afile folder is a place to put files. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatical
user to add and delete files via any WebDAY client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - A micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each us
one that is created automatically will be accessed as the user's real micro-blog.

Mirrored Files - A mirrored file folder is a special type of file folderwhere it uses a server file system directory as its file storage area instead of the nom
knowledge about the folder contents in synch with whatever is in the directory. The mirrored folder feature can mirror any WebDAV or local file path.

4 Click Reset.
5 Click OK to confirm, then click Close.

6 Verify that the 4.0.4 site is working as expected before proceeding with the migration to your
new 4.0.4 server.

Updating the Server.xml File When Using Secure HTTP

The server. xn Tomcat configuration file is overwritten during the upgrade to Vibe 4. If you set up
secure HTTP browser connections to the Vibe server, and if you changed the password for the

. keyst or e file to something other than the default changei t, you need to update the

server. xn file after upgrading to Vibe 4.

For information about how to update the . keyst or e password in the server . xnl file, see “Do
Not Change the Password for the Keystore File” in the Micro Focus Vibe 4.0.5 Administration Guide.

Now proceed with “Continuing the Vibe 3.4 to Vibe 4.0.5 on Linux” on page 193.
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Continuing the Vibe 3.4 to Vibe 4.0.5 on Linux

After your old Vibe server is upgraded to Vibe 4.0.4 and is verified to be performing well, it is time to
proceed with the process outlined in “Overview—The Linux Upgrade Process” on page 184.

To summarize, you must do the following:
1 Migrate the data from your current (source) Vibe 4.0.4 deployment to the new (target) Vibe
4.0.4 deployment.

This involves replacing the datastore on the new server with the source server’s Vibe data. See
“Transferring Data from the Source Server to the Target Server” on page 211.

2 Migrate the sitescape.sql database from your current Vibe 4.0.4 deployment to the new Vibe
4.0.4 deployment.

As with the data migration, this involves replacing the newly deployed 4.0.4 database with the
older 4.0.4 database. See “Importing the Vibe Database to the Target Server” on page 212.

3 After verifying that Vibe 4.0.4 is running on the new server as expected, upgrade Vibe to
version 4.0.5. See Chapter 24, “Upgrading From Novell Vibe 4.x to Micro Focus Vibe 4.0.5,” on
page 171.

Upgrading Vibe on Windows from 3.4 to 4.0.5

IMPORTANT: In contrast with the Linux upgrade process, which requires a new SLES server,
upgrading from Vibe 3.4 to Vibe 4.0.5 on Windows doesn’t require interim steps, as long as the
platform on which Vibe 3.4 is running also supports Vibe 4.0.5.

Keep in mind, however, that Micro Focus policy dictates that we will no longer support Windows
2008 SP2 once Microsoft discontinues support for the platform.

If that support change will impact your Vibe deployment, you might want to plan to upgrade your
platform.

Remote Lucene Index Server Upgrade

IMPORTANT: If your Lucene search index is running on the same server as the Vibe software, you do
not need to upgrade it separately. Skip to “Upgrading the Windows Vibe Software” on page 195.

You have the following options when upgrading your remote Lucene search index to Vibe 4:
¢ Create a new search index

Because a full re-index is required after upgrading to Vibe 4, creating a new search index is less
time-consuming than upgrading your existing search index. The benefit to creating a new
Lucene search index is that you are able to maintain the original search index in the unlikely
case of an emergency rollback.

+ Upgrade your existing Lucene search index

If you choose to upgrade your existing Lucene search index, you must perform a re-index after
the upgrade, as described in “Resetting the Search Index” on page 190.
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These options are described in the following sections:

*

*

“Creating a New Search Index” on page 194

“Upgrading an Existing Search Index” on page 194

Creating a New Search Index

1

Stop Vibe.

See “Stopping Vibe as an Application” on page 86
Stop the Lucene search index.

On the Lucene index server, specify the command:

c:\ Program
Fi I es\ Novel | \ Team ng\ | uceneserver\indexserver\bi n\i ndexserver -
shut down. bat

3 Ensure that no application (such as Windows Explorer) is running on the Vibe 3.4 system.

On a different server than where your original search index was running, create a new search
index, as described in “Installing the Lucene Software” on page 137.

Upgrading an Existing Search Index

The Vibe installation program cannot upgrade the Lucene search index when it is running on a
remote server. To upgrade your remote search index from Novell Vibe 3.4 to Novell Vibe 4, you need
to run the Remote Lucene Server installation program:

1

Stop Vibe.

See “Stopping Vibe as an Application” on page 86.
Stop the Lucene search index.

On the Lucene index server, specify the command:

c:\ Program
Fi | es\ Novel I\ Teani ng\ | uceneser ver\i ndexserver\ bi n\i ndexserver -
shut down. bat

3 Ensure that no application (such as Windows Explorer) is running on the Vibe 3.4 system.

O 00 N O U

10
11
12

Copy the Vibe 4.0.5 Remote Lucene Server Installation program-| ucene-i nstal | er. exe—
from the directory where the Vibe 4.0.5 Installation program is located to a convenient
directory on the server where the remote Lucene search index is located.

Start the Vibe 4.0.5 Remote Lucene Server installation program.

Accept the License Agreement, then click Next.

Select Update software and settings.

Click Next to continue.

Click Next to accept the installation location.

Click Next to accept the Java JDK location.

In the Host field, specify the hostname where you are installing the remote Lucene Index Server.

Change Lucene configuration settings as needed, then click Next.
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For information about Lucene configuration settings, see “Changing Lucene Configuration
Settings” on page 100.

13 Click Install to install the upgraded Lucene search index software.
14 Click Finish when the upgrade is complete.

15 (Conditional) If memcached is running on the Lucene search index server, reboot the server
where it is running to ensure that the 3.4 cache is cleared.

16 Start the Lucene Index Server by specifying the following command:

c:\ Program
Fi I es\ Novel | \ Team ng\ | uceneserver\indexserver\bi n\i ndexserver -
startup. bat

17 Now that all remote Vibe components have been upgraded, follow the instructions in
“Upgrading the Windows Vibe Software” on page 195.

Upgrading the Windows Vibe Software

Complete the following steps for each server in your Vibe system that is running the Vibe software:

1 Ensure that you have a current backup of your Vibe 3.4 system.
2 Stop Vibe.
See “Stopping Vibe as an Application” on page 86.
3 Ensure that no application (such as Windows Explorer) is running on the Vibe 3.4 system.

4 Copytheinstaller.xm file from the directory where the Vibe 3.4 Installation program is
located to the directory where you have extracted the Vibe 4 software.

Theinstall er.xnl file provides default values when you run the Vibe 3.4 Installation
program.

5 Obtain a new license key from the location where you downloaded the Vibe 4 software, then
place it in the same directory with the Vibe software. (The Vibe installation program does not
start without a license file in the same directory.) Rename the license to | i cense- key. xni .

Vibe 4 requires an updated license. If you use a license from a previous version, not all features
are available.

6 Make sure that your server platform meets the requirements outlined in Part Il, “System
Requirements and Support,” on page 21.

7 Start the Vibe 4 installation program.

If you need assistance with this task, see the detailed installation instructions in “Running the
Windows Vibe Installation Program” on page 81.

8 Accept the License Agreement, then click Next.
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10
11

12

13

14
15
16

17

Novell Vibe 4 Installation Program = x

Installation Options

Select the action you want to perform.

" New Installation
i+ Update software and settings
" Reconfigure settings

Because you provided your Vibe 3.4 1 nstal | er. xm file in the directory with the Vibe 4
installation program, the Update software and settings installation option is selected by default.

Click Next to continue.
Click Yes to let the Installation program know that you have stopped Vibe.

Select the check box to let the installation program know that you have backed up all of your
data, then click Next.

Select Basic or Advanced, depending on the type of Vibe installation you are upgrading, then
click Next.

For more information about the differences between basic and advanced installations, see
“What Is a Basic Vibe Installation?” on page 41 and “What Is an Advanced Installation?” on
page 95.

Continue through the installation process, retaining or changing configuration information
depending on the needs of your Vibe 4 system.

Click Install when you are ready to perform the upgrade.
Click Finish when the upgrade is complete.

(Conditional) If memcached is running on the Vibe server, reboot the server to ensure that the
3.4 cache is cleared.

Continue with “Upgrading the Vibe Database from 3.4 to 4” on page 196.

Upgrading the Vibe Database from 3.4 to 4

IMPORTANT: Make sure you do the following:

1.

Upgrade the Vibe software (as described in “Upgrading the Windows Vibe Software” on
page 195) before upgrading the Vibe database.

. Because the Vibe 4 upgrade process does not update the database as part of the Vibe software

upgrade, you must
¢ Ensure that the 3.4 system is in UTF-8 format before updating the database.
+ Manually update the database before you start Vibe.
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The following example outlines the process for MySQL. Refer to the documentation for your
database type as needed.

1 (Conditional) When upgrading a MySQL database, ensure that the Vibe database character set
for the Vibe 3.4 system is in UTF-8 format.
la To view the character set format, run the following command:

SELECT default character_set name FROM information_schema. SCHEMATA
S WHERE schema_name = 'sitescape';

In this command si t escape is the name of the Vibe database. Replace si t escape with
the name of your database.

1b If the character set format is anything other than UTF-8, run the following command to
change it:

In the following command, si t escape is the name of the Vibe database. Replace
si t escape with the name of your database.

ALTER DATABASE sitescape CHARACTER SET utf 8;
2 Change to the db directory in the Vibe installation:
cd /vibe_installation/temp-installer/db
This directory contains the following properties files:
+ nysql -1iqui base. properties
¢ Oracl e-liquibase. properties
+ sqgl server-1iquibase. properties

3 In atext editor, open the properties file that corresponds with your database type and make the
applicable changes in both the Dri ver and r ef er enceDr i ver sections. Save and close the
text editor when you are finished making changes.

¢ Change the database user name and password for accessing the database.
¢ (Conditional) Specify the IP address for the database if it is running on a remote server.
You need to replace | ocal host with the IP address of the remote server.

+ (Optional) Change the name of the Vibe database (the default name of the Vibe database
is si t escape, the name of the company that previously developed the Vibe software).

4 Save your changes and close the properties file.

5 Inthe same directory (/ vi be_i nstal | ati on/tenp-instal | er/db), execute the following
commands to update the database schema:

SET PATH=C:\path_to_java_used_by_vi be\ bi n; %PATHY(if not already set)
nmanage- dat abase. bat dat abaseType nar k33Dat abaseAsUpdat ed
nmanage- dat abase. bat dat abaseType updat eDat abase

Possible database types (dat abaseType) are nysql , or acl e, or sql server, depending on
your type of database.
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NOTE: You can safely ignore the following Liquibase log messages:

¢+ VArning: nodi fyDataType will | ose primary key/autoi ncrenent/not nul
settings for mysq

+ Any messages that contain the wordsi nfo: failureorinfo: fail ed,aslongasthey
are associated with a type | NFOmessage

Start Vibe 4 in the same way that you have been starting Vibe 3.4.
See “Starting Vibe as an Application” on page 86.
or

See “Starting Vibe as a Windows Service” on page 85.

NOTE: If you have been starting Vibe as a Windows service, you need to delete your existing
Windows service configuration and re-configure Vibe as a Windows service before you can start
Vibe. For information about how to configure Vibe as a Windows service, see “Configuring Vibe
as a Windows Service” on page 85.

When you start Vibe for the first time after the upgrade, it takes longer to start than usual
because data in the Vibe database must be upgraded before the Vibe site is ready to use.

(Recommended) For security reasons, delete the password that you specified in Step 7 in
“Creating the Vibe Database” on page 82.

7a Change to the db directory in the Vibe installation:
cd /vibe_installation/tenp-installer/db
This directory contains the following properties files:
* nysql -liqui base. properties
¢ Oracl e-liquibase. properties
¢ sql server-1iqui base. properties

7b In a text editor, open the dat abase_t ype-1i qui base. properti es file that
corresponds with your database type, then delete the password.

7c Save and close the properties file.

8 Continue with “Performing Post-Upgrade Tasks” on page 198.

Performing Post-Upgrade Tasks

After you start Micro Focus Vibe 4, you can access your Vibe site as usual. However, you need to
reset some aspects of the interface before you allow users to access the upgraded site. The interface
reset affects only those definitions and templates that are included with the Vibe product. If you
have created custom definitions and templates, they are unaffected by the interface reset.

*

*

*

*

“Resetting the Search Index” on page 199
“Resetting Your Definitions” on page 200
“Resetting the Standard Templates” on page 200
“Re-Installing the Windows Service” on page 201

“Updating the Server.xml File When Using Secure HTTP” on page 201
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Resetting the Search Index

In order for an upgraded search index to be compatible with Vibe 4, you need to re-index the search
index. Until you reset the search index, the search index and the vibe server are not in a compatible
state. The cat al i na. out and appser ver . | og files show errors until the search index is reset.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers. For more information about multiple search indexes, see Chapter 22, “Running Multiple
Lucene Index Servers,” on page 149.

Depending on the size of your Vibe site, this can be a very time-consuming process.

+ “Resetting a Single Search Index” on page 199

+ “Resetting the Search Index with Multiple Index Servers” on page 199

Resetting a Single Search Index

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

3 In the Management section, click Search Index.

4 Select Re-Index Everything.

5 Click OK, then click Close.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

6 After the index server has been reset, ensure that no errors are contained in the following log
files:

¢ C.\Program Fi | es\ Novel | \ Teani ng\ apache-tontat\ | ogs\ cat al i na. out
¢ C.\Program Fi | es\ Novel | \ Teani ng\ apache-tontat\ | ogs\ appserver. | og

Resetting the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

In the Search Index section, click Index.

Select Re-Index Everything.

Select each node that you want to re-index.

Click OK, then click Close.

D U A~ W

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.
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7 After the index server has been reset, ensure that no errors are contained in the following log
files:

¢ C.\Program Fi | es\ Novel | \ Teani ng\ apache-tontat\ | ogs\ cat al i na. out
¢ C.\Program Fi | es\ Novel | \ Teani ng\ apache-tontat\ | ogs\ appserver. | og

Resetting Your Definitions

Various aspects of the Vibe interface have been redesigned and enhanced since Vibe 3.4. Some of
these enhancements affect entries, folders, user profiles, and user workspaces. If you have made
customizations to these areas of Vibe, you must reset these definitions in order to see the
enhancements, as described in this section.

WARNING: The following procedure deletes any custom modifications that you have previously
made to the default Vibe definitions. If you want to save any modified definitions before proceeding,
you can export the modified definitions. Also, you might want to document exactly what changes
you have made in order to make it easier to reconstruct the definition after you reset it. This applies
only to definitions that you have modified; definitions that you have created are not affected.

To reset your Vibe definitions:

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
3 In the System section, click Form/View Designers to display the Form and View Designers page.
4 Click Reset.
The Reset Definitions page is displayed.
5 Click Select All.
You can expand each definition to ensure that all definitions have been selected.

6 Click OK.

Resetting the Standard Templates

IMPORTANT: The following procedure deletes any custom modifications that you have previously
made to the default Vibe templates. If you have manually customized any default Vibe templates,
back up the files you have modified before performing the interface reset. This applies only to
default templates that you have modified; templates that you have created are not affected.

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 In the Management section, click Workspace and Folder Templates.
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Workspace and Folder Templates

Mew - Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created. Blogs typically pro
larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal Workspace. Visitors ms
A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users’ social networks.

Files - Afile folder is a place to put files. Comments or entire discussions can be posted about individual files. Additionally, the files can be automatical
user to add and delete files via any WebDAY client, such as the MS Windows File Manager.

Milestones - A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog - A micro-blog folder is a special folder that gets created automatically for each user. Itis intended to contain short text entries only. Each us
one that is created automatically will be accessed as the user's real micro-blog.

Mirrored Files - A mirrored file folder is a special type of file folderwhere it uses a server file system directory as its file storage area instead of the nom
knowledge about the folder contents in synch with whatever is in the directory. The mirrored folder feature can mirror any WebDAV or local file path.

4 Click Reset.
5 Click OK to confirm, then click Close.

6 Your Vibe 4 site is now ready for use.

Re-Installing the Windows Service

If you installed Vibe as a Windows service (as described in “Running Vibe as a Windows Service” on
page 84), you must remove the service and re-install it. This is necessary because the original service
references an unsupported version of Tomcat.

Updating the Server.xml File When Using Secure HTTP

The server. xn Tomcat configuration file is overwritten during the upgrade to Vibe 4. If you set up
secure HTTP browser connections to the Vibe server, and if you changed the password for the

. keyst or e file to something other than the default changei t, you need to update the

server. xn file after upgrading to Vibe 4.

For information about how to update the . keyst or e password in the server. xmi file, see “Do
Not Change the Password for the Keystore File” in the Micro Focus Vibe 4.0.5 Administration Guide.
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2 Upgrading to Novell Vibe 3.4 from Previous
Versions

For information about how to upgrade to Vibe 3.4, see “Update” (https://www.novell.com/
documentation/vibe34/vibe34 inst/data/bjOkxa6.html) in the Micro Focus Vibe 3.4 Installation
Guide (https://www.novell.com/documentation/vibe34/vibe34 _inst/data/bookinfo.html).
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2 Updating the Operating System Where
Vibe Is Running

You can update the operating system where Vibe is running.

1 Update the Linux or Windows operating system to a version that Vibe supports.

For information about which versions are supported, see “Server Operating System
Requirements” on page 23.

For information about how to update the operating system, view the appropriate
documentation for your operating system.
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V I I Migrate

+ Chapter 28, “Migrating Existing Micro Focus Vibe 4 Data into a New Vibe 4 System,” on
page 209

+ Chapter 29, “Migrating from SiteScape Forum or Other Collaboration Software,” on page 217
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Migrating Existing Micro Focus Vibe 4 Data
into a New Vibe 4 System

IMPORTANT: The term “data migration” as used in this section, is essentially about creating a clone
of an existing Vibe system.

+ Cross-version Migration Not Supported: Data migration between servers running different
versions of Vibe is not supported. However, you can use data migration in conjunction with an
upgrade (see “Using Data Migration in Conjunction with an Upgrade to Vibe 4” on page 210).

+ Name and Credentials Must Be the Same: The database name and the database username and
password must be the same on the source and the target server.

This section describes how to migrate data from an existing Vibe 4 server to a new Vibe 4 server. You
might want to do this for any of the following reasons:

+ Your existing Vibe system has outgrown the server where you originally set it up.

+ You want to move your existing Vibe system to a different operating system.

In this case, you can install Vibe 4 on a new server, then migrate your existing Vibe 4 data to
your new Vibe 4 system.

+ You want to preserve your old system in its current state.

+ You are upgrading from Kablink Vibe to Micro Focus Vibe.

NOTE: In the instructions that follow, “target server” refers to the server where you install the Vibe 4
software, and “source server” refers to the existing server from which you are migrating Vibe data.

The instructions in this section are based on a single-server Vibe configuration. If you have a multi-
server Vibe configuration, the single-server instructions can serve as a foundation to get you started
with your more complex migration process.

This section does not include instructions for migrating an Oracle database. Use the instructions for
your Vibe platform as a guideline for the tasks that are involved in migrating Vibe data, then apply
these guidelines to your Oracle database migration.

+ “Using Data Migration in Conjunction with an Upgrade to Vibe 4” on page 210
+ “Migrating Vibe on Linux” on page 210
+ “Migrating Vibe on Windows” on page 212
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Using Data Migration in Conjunction with an Upgrade to
Vibe 4

As stated above, data migration between servers running different versions of Vibe is not supported.
If you want to migrate data from Vibe 3.4 to a new Vibe 4 system, you must:

+ Upgrade the Vibe 3.4 server to Vibe 4.
+ Install a new Vibe 4 server

+ Migrate the data from the old Vibe 4 server to the new Vibe 4 system.

Migrating Vibe on Linux

NOTE: The instructions in this section assume that your Vibe deployment uses MySQL as the
database server. If you use another SQL database, you will need to adjust the steps to fit your
deployment.

* “Preparing the Target Linux Server” on page 210

+ “Preparing the Source Linux Server” on page 211

+ “Transferring Data from the Source Server to the Target Server” on page 211
+ “Importing the Vibe Database to the Target Server” on page 212

+ “Finalizing Your New Vibe 4 Site” on page 212

Preparing the Target Linux Server

On the target server:
1 Install the Vibe 4 software on the target server, as described in Part I, “Basic Installation,” on
page 33, paying special attention to these important details:

¢ Set up the same Linux user to run the Vibe software that has been used to run the Vibe
software in the source Vibe server.

¢ Select the same encryption algorithm for the Vibe database that was used for the source
Vibe server.

IMPORTANT: If the database encryption algorithms do not match between the source and
target Vibe systems, you cannot log in to the new Vibe 4 site.

2 Start Vibe on the target server.
3 Verify that the new Vibe site is working as expected.
4 Stop Vibe on the target server.

5 Rename the t eam ng directory to t eam ng_backup. In a future step, you will copy the
t eam ng directory from the source server to the target server.

The location of the t eam ng directory varies by platform:
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Linux: /var/ opt/novel | / t eam ng

Windows: c¢:\novel | \team ng

Continue with “Preparing the Source Linux Server” on page 211.

Preparing the Source Linux Server

On the source server:

1
2

Stop Vibe.

Back up your existing database:
nysql dunp -uusernane -ppassword sitescape > sitescape. sql

This creates a file named si t escape. sql in the directory where you executed the
nysql dunmp command.

3 Ensure that you have a recent backup of your entire Vibe system.

Continue with “Transferring Data from the Source Server to the Target Server” on page 211.

Transferring Data from the Source Server to the Target Server

On the source server:

1

Mount the target server to the source server so that data can be copied from one server to the
other.

In a terminal window on the source server, become the Linux user that runs the Vibe software.

Copy the database backup of your existing Vibe database (si t escape. sql file) that you
created in Step 2 in “Preparing the Source Linux Server” on page 211 to a convenient temporary
location on the target server.

Copy the entire data area from / var / opt / novel | / t eam ng on the source server to the same
location on the target server.

(Conditional) If you are using secure LDAP (LDAPS), you need to copy the cacert s file to the
same location on the target server.

Edit the / opt / novel | / t eam ng/ apache-t ontat / webapps/ ssf/WEB- | NF/ cl asses/
confi g/ ssf-ext. properties file on the target server to include the same content as the
corresponding file on the source server, as follows:

6a Make sure that the user . pwdenc. def aul t =PROPERTY- VALUE values are the same in
the ssf-ext.properties files on both servers.

6b Copy the following property values in the ssf - ext . properti es file on the source server
and replace the corresponding property values on the target server with the source server
values.

NOTE: We recommending pasting to avoid typing errors.

+ dat abase. passwor d=PROPERTY- VALUE
+ mai |l . SiteScape. out . passwor d=PROPERTY- VALUE
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¢ sntp. service. keyst or e. passwor d=PROPERTY- VALUE

+ kabl i nk. encryption. key=PROPERTY- VALUE

¢ kablink. encryption. key. initial =PROPERTY- VALUE
6¢c Save the modified ssf - ext. properti es file on the target server.

7 Continue with “Importing the Vibe Database to the Target Server” on page 212.

Importing the Vibe Database to the Target Server

On the target server:
1 Remove the empty Vibe database that was created when you installed the Vibe 4 software:
nysql >drop dat abase sitescape;

2 Change to the directory where you copied the si t escape. sql filein Step 3 in “Transferring
Data from the Source Server to the Target Server” on page 211.

3 Create an empty database called si t escape:

nysqgl -uusername -ppassword -e "create database sitescape character set
utf8"

4 Manually re-create the Vibe database with the data that you copied from the source server:

nysql -uusernane -ppassword sitescape < sitescape.sq

Finalizing Your New Vibe 4 Site

1 Start Vibe 4, as described in “Starting Vibe on Linux” on page 78.

2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in
the Micro Focus Vibe 4.0.5 Administration Guide.

Your Vibe site should now function just as it did on the original source server.

Migrating Vibe on Windows

NOTE: The instructions in this section assume that your Vibe deployment uses MS SQL as the
database server. If you use another SQL database, you will need to adjust the steps to fit your
deployment.

+ “Preparing the Target Windows Server” on page 213

+ “Preparing the Source Windows Server” on page 213

+ “Transferring Data from the Source Server to the Target Server” on page 213
+ “Importing the Database to the Target Server” on page 214

+ “Finalizing Your New Vibe 4 Site” on page 215
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Preparing the Target Windows Server

On the target server:

1 Install the Vibe 4 software, as described in Part Ill, “Basic Installation,” on page 33.

IMPORTANT: Select the same encryption algorithm for the Vibe 4 database that you selected
for the source Vibe server. If the database encryption algorithms do not match between the
source and target systems, you cannot log in to the new Vibe 4 site.

Start Vibe on the target server.
Verify that the new Vibe site is working as expected.

Stop Vibe on the target server.

v A W N

Rename the t eam ng directory to t eam ng_backup. In a future step you will copy the
t eam ng directory from the source server to the target server.

The location of the teaming directory varies by platform:

Linux: /var/ opt/novel | / t eam ng

Windows: c¢:\Program Fi | es\ Novel |\ Teani ng

6 Continue with “Preparing the Source Windows Server” on page 213.

Preparing the Source Windows Server

On the source server:

1 Stop Vibe.
2 Back up your existing database:

2a In Microsoft SQL Server Management Studio, browse to and right-click the existing
database (named si t escape), then click Tasks > Back Up.

2b For Backup type, select Full.
2c Set other backup options as desired, then click OK.

This creates a file named si t escape. bak in the following directory:
c:\Program Fil es\M crosoft SQ Server\ MsSQ.\ Backup

3 Ensure that you have a recent backup of your entire system.

4 Continue with “Transferring Data from the Source Server to the Target Server” on page 213.

Transferring Data from the Source Server to the Target Server

On the source server:

1 Map a drive from the target server to the source server so that data can be copied from one
server to the other.

2 Copy your existing software extensions to the target server:
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From: c:\ hone\i cecor edat a\ ext ensi ons

To: c:\novel | \'t eanm ng\ ext ensi ons

Beginning with Vibe 3, the ext ensi ons directory now contains kabl i nk and | i f eray. com
directories.

3 Delete the empty kabl i nk directory.

4 Delete or rename the following directories to make room for the corresponding directories that
you are copying from the source server:

c:\novel I\t eam ng
c:\novel I'\team ng\l ucene
c:\novel I\t eam ng\ ext ensi ons

5 Copy the entire data area from c: \ novel | \ t eanmi ng on the source server to the same
location on the target server.

6 (Conditional) If you are using secure LDAP (LDAPS), you need to copy the cacert s file to the
same location on the target server.

7 Editthe C.\ Program Fi |l es\ Novel I \ Teani ng\ apache-t ontat \ webapps\ ssf\ VVEB-
I NF\ cl asses\ confi g\ ssf-ext. properti es file on the target server to include the same
content as the corresponding file on the source server, as follows:

7a Make sure that the user . pwdenc. def aul t =PROPERTY- VALUE values are the same in
the ssf-ext.properties files on both servers.

7b Copy the following property values in the ssf - ext . properti es file on the source server
and replace the corresponding property values on the target server with the source server
values.

NOTE: We recommending pasting to avoid typing errors.

+ dat abase. passwor d=PROPERTY- VALUE

+ mail. SiteScape. out. passwor d=PROPERTY- VALUE

¢ sntp. service. keyst or e. passwor d=PROPERTY- VALUE

+ kabl i nk. encryption. key=PROPERTY- VALUE

+ kablink. encryption. key. initial =PROPERTY- VALUE
7c Save the modified ssf - ext. properti es file on the target server.

8 Continue with “Importing the Database to the Target Server” on page 214.

Importing the Database to the Target Server

On the target server:

1 In Microsoft SQL Server Management Studio, browse to and right-click the existing Vibe
database (named si t escape) that was created when you installed the Vibe 4 software, then
click Delete.

2 To import the data from your source database, browse to and right-click Databases, then click
Tasks > Restore.
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3 In the To database field, specify si t escape.

4 In the From device field, browse to and select the si t escape. bak file that you transferred to
the target server.

5 Set other restore options as desired, then click OK.
This creates the si t escape database in the following directory on the target server:

c:\Program Fil es\M crosoft SQ. Server\ MSSQL

Backed-up data from the source database is imported into the database for your new Vibe 4
system.

Finalizing Your New Vibe 4 Site

1 Start Vibe 4, as described in “Starting Vibe on Linux” on page 78.

2 Reindex the Vibe site, as described in “Rebuilding the Lucene Index” in “Site Maintenance” in
the Micro Focus Vibe 4.0.5 Administration Guide.

Your Vibe site should now function just as it did on the original source server.
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2 Migrating from SiteScape Forum or Other
Collaboration Software

Moving legacy corporate data into a new collaboration system can look like a long, challenging
process. To make the job easier, see the Micro Focus Teaming Migration Services Flyer. (http://
www.novell.com/docrep/2009/04/Novell_Teaming_Migration_Flyer_en.pdf)
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Appendix A, “Sizing and Performance Considerations,” on page 221

*

*

Appendix B, “Memcached Caching with Micro Focus Vibe,” on page 229
Appendix C, “Using MySQL 8 and Later with Vibe,” on page 235

*

*

Appendix D, “Third-Party Materials,” on page 237
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Sizing and Performance
Considerations

Because of the wide variety of ways you can use Vibe, the recommendations given in this section are
only guidelines.

The hardware configuration that you set up for your Micro Focus Vibe site should be based on the
following considerations:

+ Number of active users that the Vibe site must support: Users who have accounts in the Vibe
system but do not log in to the system should not be considered in this number. For example, if
there are 1,000 users in the Vibe system but only 300 access the system on a regular basis, the
number of active users is 300.

+ Content the users will add: The type of content that is shared and stored on your Vibe site. The
number of active users in the system is a good indicator of what the hardware configuration of
your system should be, but you should also keep in mind that the type of content that is shared
and stored on your Vibe site has a significant effect on the amount of disk space and memory
that is required.

For example, your users might add the following types of content:

¢ Multimedia documents, such as CAD and PowerPoint documents (requires the most
system resources)

¢ Other documents, such as text documents and photos
¢ Vibe entries that do not contain attachments, such as blog entries and discussion entries
(requires the least amount of system resources)

For example, if you have a Vibe installation with only 400 active users, but those users often upload
and share CAD files, you might want to configure a dedicated SQL server where those files can be
stored. In addition, provide a larger CPU, increased memory, and a larger Java heap to more
efficiently upload and search for the files.

Server machines can be physical or virtual.

+ “Configuration Based on Installation Size” on page 222
+ “Test Installation” on page 223

+ “Small Installation” on page 223

+ “Medium Installation” on page 224

+ “Large Installation” on page 225

+ “Very Large Installation” on page 227
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Configuration Based on Installation Size

The following table shows the recommended hardware configuration based on the size of the Vibe
installation. For more detailed information about each type of installation, click the installation size
in the column header.

Test Installation Small Medium Large Very Large
Installation Installation Installation Installation

Single Server X X
Only

Remote X
Database
Server

Remote Vibe X X
Desktop Server

Remote Vibe
Add-In or
WebDAV Server

Remote Lucene X
Index Server

Remote File X X
Repository

Multiple Vibe X X
(Tomcat)
Servers

Multiple X
Remote Lucene
Servers

Multiple X X
Remote

Database

Servers

Multiple X
Remote Vibe

Desktop

Servers

Multiple X
Remote Vibe
Add-In Servers
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Test Installation

Tomcat
Lucene Index
SQL Database
File System
Vibe Desktop

This deployment is suitable for a single-person evaluation or minimal usage by a small group.

Vibe Components CPU Memory Java Heap

1 dedicated Vibe (Tomcat) server with: ~ 3Ghz x64, single-core or  4-8 GB 2-6 GB

dual-core
¢ Lucene

¢ saL

*

File System

*

Vibe Desktop
Vibe Add-In

*

For more information about installing a basic, single-server Vibe site, see Part I, “Basic Installation,”
on page 33.

You can perform a Basic installation to set up a single-server configuration, as described in
Chapter 8, “Planning a Basic Vibe Installation,” on page 41 and Chapter 11, “Installing and Setting Up
a Basic Vibe Site,” on page 69.

Small Installation

Tomcat Tomcat

Lucene Index (for Vibe Desktop
SQL Database if more than 100
File System active users)
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This deployment is suitable for a workgroup, department, or small company. All components are on
a single server but are running typical memory allocations. If Vibe Desktop is being used with more
than 100 active users, it must be running on one or more separate Vibe (Tomcat) servers.

Vibe Components CPU Memory Java Heap
Multiple Vibe servers: 3Ghz x64, dual-core or 4-8 GB 2—-6 GB
quad-core

¢ 1 dedicated Vibe (Tomcat) server
with SQL and file system

¢ 1 dedicated Vibe (Tomcat) server
with Vibe Desktop for 100 or fewer
active users; 2 dedicated Vibe
(Tomcat) servers with Vibe Desktop
for more than 100 active users

For more information about installing a basic, single-server Vibe site, see Part Ill, “Basic Installation,”
on page 33.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how
to distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Providing File
Access and Editing for Vibe Users” in “Site Setup” in the Micro Focus Vibe 4.0.5 Administration
Guide.

You can perform a Basic installation to set up a single-server configuration, as described in
Chapter 8, “Planning a Basic Vibe Installation,” on page 41 and Chapter 11, “Installing and Setting Up
a Basic Vibe Site,” on page 69.

Medium Installation

<5} ‘ ’

Tomcat Tomcat Tomcat
(for Vibe Desktop) Lucene Index (for Vibe Desktop
File System if more than 100

active users)

This deployment is suitable for a medium-to-large business. The database server is separate, to
increase the amount of parallel processing in the system. The database can be a single server or a
cluster of database servers. More memory is also allocated to the Vibe server. If Vibe Desktop is
being used with more than 100 active users, it must be running on multiple separate Vibe (Tomcat)
servers.
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Vibe Components CPU Memory Java Heap

Multiple Vibe servers: 3Ghz x64 quad-core 4-8 GB 6 GB

¢ 1 dedicated Vibe (Tomcat) server
with file system
¢ 1 or more dedicated SQL servers

¢+ 2 dedicated Lucene servers

¢ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 19, “Creating the Vibe Database on a Remote Server,” on
page 129.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how
to distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Providing File
Access and Editing for Vibe Users” in “Site Setup” in the Micro Focus Vibe 4.0.5 Administration
Guide.

You can perform a Basic installation to set up a multiple-server configuration (as described in
Chapter 8, “Planning a Basic Vibe Installation,” on page 41 and Chapter 11, “Installing and Setting Up
a Basic Vibe Site,” on page 69); however, the remote database must be created manually and in
advance of performing the installation, as described in Chapter 19, “Creating the Vibe Database on a
Remote Server,” on page 129.

Large Installation

5y, RN CTHY

Tomcat Tomcat SQL database

(for Vibe Desktop) / \

File System Lucene Index

This deployment is suitable for a large business. This deployment uses load balancing across all
servers. The database server is separate, to increase the amount of parallel processing in the system.
The index server is separate, to allow the application to better utilize the physical memory that is
allocated. The file system is separate, and a SAN file system is recommended. The memory
utilization of the index server is proportional to the index size, which is directly related to the
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number and size of documents and entries that are stored. As the number and size of documents
and entries that are stored increases, you should increase the amount of memory accordingly. If
Vibe Desktop is being used with more than 100 active users, it must be running on multiple separate
Vibe (Tomcat) servers.

Vibe Components CPU Memory Java Heap
Multiple Vibe servers: 3Ghz x64 quad-core or 8- 4-8 GB 6 GB
core

¢ 3-5 dedicated Vibe (Tomcat)
servers

¢ 2 dedicated Lucene servers
¢ 2 dedicated SQL servers

¢ 1 dedicated file system server (SAN
is recommended)

¢ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For more information on load balancing, see “Configuring a Web Application to Provide High
Availability Functionality for Your Vibe Site” on page 145.

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 19, “Creating the Vibe Database on a Remote Server,” on
page 129.

For information on how to create a separate index server, see Chapter 20, “Installing the Lucene
Index Server on a Remote Server,” on page 137.

For more information on how to create a separate file system server, see “Vibe File Repository
Considerations” on page 141.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how
to distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Providing File
Access and Editing for Vibe Users” in “Site Setup” in the Micro Focus Vibe 4.0.5 Administration
Guide.

You must perform an Advanced installation to achieve this type of deployment. For more
information, see Part IV, “Advanced Installation and Reconfiguration,” on page 93.
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Very Large Installation

<5} 5@5@ -

Tomcat Tomcat SQL database

(for Vibe Desktop) / \

File System Lucene Index

This deployment is suitable for a large business. This deployment uses load balancing across all
servers. The database server is separate, to increase the amount of parallel processing in the system.
The index server is separate, to allow the application to better utilize the physical memory that is
allocated. The file system is separate, and a SAN file system is recommended. The memory
utilization of the index server is proportional to the index size, which is directly related to the
number and size of documents and entries that are stored. As the number and size of documents
and entries that are stored increases, you should increase the amount of memory accordingly. If
Vibe Desktop is being used with more than 100 active users, it must be running on multiple separate
Vibe (Tomcat) servers.

Vibe Components CPU Memory Java Heap
Multiple Vibe servers: 3Ghz x64 quad-core or 8- 4-8 GB 6 GB
core

¢ 4-8 dedicated Vibe (Tomcat)
servers

¢ 2 dedicated Lucene servers
+ 2 dedicated SQL servers

¢ 1 dedicated file system server (SAN
is recommended)

¢ 2 or more dedicated Vibe (Tomcat)
servers with Vibe Desktop

For more information on load balancing, see “Configuring a Web Application to Provide High
Availability Functionality for Your Vibe Site” on page 145.

For information on how to create a separate Vibe database, follow the instructions specific to your
database type, as described in Chapter 19, “Creating the Vibe Database on a Remote Server,” on
page 129.
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For information on how to create a separate index server, see Chapter 20, “Installing the Lucene
Index Server on a Remote Server,” on page 137.

For more information on how to create a separate file system server, see “Vibe File Repository
Considerations” on page 141.

For more information on how to configure Vibe Desktop to run on your Vibe server, as well as how
to distribute Vibe Desktop synchronization traffic to a dedicated Vibe server, see “Providing File
Access and Editing for Vibe Users” in “Site Setup” in the Micro Focus Vibe 4.0.5 Administration
Guide.

You must perform an Advanced installation to achieve this type of deployment. For more
information, see Part IV, “Advanced Installation and Reconfiguration,” on page 93.
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Memcached Caching with Micro Focus
Vibe

Micro Focus Vibe contains two caching options for the hibernate caching provider: ehcache and
memcached. For more information about ehcache, see Ehcache (http://ehcache.sourceforge.net).
¢ “About Memcached” on page 229
¢ “Downloading and Installing Memcached” on page 229
+ “Configuring Memcached” on page 230
+ “Securing Memcached” on page 232
+ “Configuring Memcached in the Vibe Installation Program” on page 232

+ “Memcached Logging” on page 232

About Memcached

Memcached is a high-performance, distributed memory object caching system used by a number of
large Internet sites such as Wikipedia, Flickr, Twitter, and Youtube, as well as enterprise systems.

+ “Advantages for Using Memcached” on page 229

+ “Hardware Requirements and Configurations” on page 229

Advantages for Using Memcached

Memcached offers the following advantages over other caching systems:

+ Better utilization of memory resources from the server farm.

+ No replication (and therefore no overhead involved in replication). This results in a reduction of
60 or more threads per Vibe node in a two-node cluster.

+ The number of servers and the size of data scale together.
+ Scales out much better than replication-based cluster cache.

Hardware Requirements and Configurations

Micro Focus Vibe supports memcached only on the SUSE Linux operating system.

Downloading and Installing Memcached

NOTE: You should run memcached only on a SUSE Linux operating system. 64-bit is recommended.
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Memcached is included with the SUSE Linux Enterprise High Availability Extension. You simply need
to install it on the server where the Lucene search index is running as you would any other Linux
package.

If you do not have the SUSE Linux Enterprise High Availability Extension, you can download and
install memcached by completing the following steps on the Lucene search index server:
Navigate to the openSUSE Software Download page (http://software.opensuse.org).

In the Search field, type nentached, then click Search.

Download the RPMfile after it is returned in the search results.

Install the downloaded RPMfile.

Repeat Step 1 through Step 4 on the Lucene search index server.

A U A WN =

Continue with “Configuring Memcached” on page 230.

Configuring Memcached

After you have downloaded and installed memcached on the server where the Lucene search index
is running, as described in “Downloading and Installing Memcached” on page 229, you need to
configure it on each node.

You configure memcached by adding the desired switches to the MEMCACHED PARANS variable.

1 Navigate to the et ¢/ sysconfi g directory.
2 Open the nentached file in a text editor.

3 Uncomment the MEMCACHED PARANE variable and add any switches that you feel are
appropriate. When you uncomment the MEMCACHED PARANS variable, the following switches
are already present:

* -d: Runs as a daemon. This is recommended.

+ -|: Determines the interface to listen on. The default value is the localhost. You should
either delete this switch with its default address (this is recommended for a simple setup)
or change the default address to the address that you want memcached to listen on. For
example, -1 172.17. 2. 3.

To see a complete list of switches that are available with memcached, type nentached -h
from the command line of a machine where memcached is installed.

4 (Recommended) Increase the maximum memory to use for items to 1024 MB. You do this by
adding the - mswitch to the MEMCACHED PARANS variable. For example:

-m 1024

5 (Recommended) You should configure memcached to start automatically each time you reboot
the server where the Lucene search index is running. To configure memcached to start
automatically, enter the following command from the command line:

chkconfig --add nmenctached

To verify that automatic startup is enabled, enter the following command from the command
line:

chkconfig mencached
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6 Validate that memcached is running from the local server by typing the following command:

netstat -ap|grep mencached

7 After you have verified that memcached is running on the local server, log in to a remote server,
then validate that memcached is running to ensure that no networking problems exist:

7a From the command line of a remote server, make a network connection to the server

where memcached is running. For example, you can use the t el net command.

telnet 172.17.2.3 11211

7b Type a simple memcached command, such as st at s and stats settings.

7c After you have verified that memcached is running as expected, type qui t to exitt el net.

Following is an example of what you see:

07309: ~/ Desktop # tel net xxX.Xxxx.xxx.xx 11211
Tryi ng XXX. XXX. XXX. XX. . .

Connected to XXX.XXX. XXX. XX.

Escape character is '"]".

stats

STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
STAT
END

quit

pi d 2486

uptime 313

time 1334337169
version 1.2.6

poi nter_size 64
rusage_user 0.028001
rusage_system 0. 000000
curr_itens 10

total itens 17

bytes 7971
curr_connections 4
total _connections 6
connection_structures 5
cmd_get 79

cmd_set 17

get_hits 62

get _m sses 17
evictions 0

bytes_read 14249

bytes witten 67674
limt_nmaxbytes 67108864
threads 1

Connection cl osed by foreign host.
07309: ~/ Desktop #

8 Continue with “Configuring Memcached in the Vibe Installation Program” on page 232.
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Securing Memcached

Memcached was not designed for authentication and is protected only by firewalls and similar
mechanisms.

Viable options include the following:

¢ Set up an SSL tunnel between memcached and instances of Tomcat.
¢ Use SASL for authentication.

+ Use the Lucene server’s firewall to allow access only from the Vibe servers that run Vibe
Tomcat.

For example:

1. Atthe terminal prompt on the Lucene server, run the following command for each Vibe
server that needs access:

iptables -A INPUT -s ip_of allowed server -p tcp --dport 11211 -j
ACCEPT Where ip_of allowed_server is the IP address of one of the Vibe servers needing
access.

For example:
iptables -A INPUT -s 192.168.1.61 -p tcp --dport 11211 -j ACCEPT

2. Repeat Step 1 until all of the Vibe servers that need access are allowed to communicate
through the Lucene server’s firewall.

3. Run the following command to block access by all other servers:
iptables -AINPUT -s 0.0.0.0/0 -p tcp --dport 11211 -j DRCP

Configuring Memcached in the Vibe Installation Program

After you have installed and configured memcached, you need to configure the Vibe installation
program to use memcached as the hibernate caching provider. For more information, see “Running
the Linux Vibe Installation Program” on page 70.

Memcached Logging

To trace activities on the Vibe server that are related to memcached:

1 Navigate to the following directory: / opt / novel | / t eam ng/ apache-t ontat / conf
2 Openthel og4j . properti es file in a text editor.
3 Uncomment the following lines in the | og4j . properti es file:

# Traci ng of nmenctached

#l og4j . cat egory. net . spy. nencached=DEBUG

#l og4j . cat egory. net. r ubyeye. xmenctached=DEBUG

#l og4j . cat egory. com googl ecode. hi ber nat e. nentached=DEBUG

#| og4j . cat egory. com novel | . t eam ng. mencached=DEBUG

#| og4j . cat egory. com novel | . t eanmi ng. hi ber nat e. nenctached=DEBUG
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4 Save and close the | 0g4j . properti es file.

5 Restart the Vibe server.
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Using MySQL 8 and Later with Vibe

MySQL 8 and later has password complexity enabled by default, which Vibe doesn’t support.

The sections that follow replace Step 7 in “Configuring MySQL/MariaDB” on page 64 and provide
basic help for disabling password complexity and setting a non-complex password.

For complete MySQL information, including download and installation instructions, see the MySQL
web site (https://www.mysqgl.com/).

Disabling Password Complexity in MySQL 8
On the server running MySQL 8, do the following:

1 Access a terminal prompt as the r oot user and enter the commands in the following steps.

2 View the temporary MySQL root password that the installation process set in the nysql d. | og
file, by entering the following command:

grep 'tenporary password' /var/log/ nysql/nysqld.|log
3 Login to MySQL.

nysql -uroot -ptemporary-password

where t enpor ar y- passwor d is the password obtained in Step 2.

4 Change the system-generated temporary password to another password that satisfies the
password-complexity requirements, such as MyNewPass4! .

ALTER USER 'root' @I ocal host' | DENTIFIED BY ' MyNewPass4!"' ;
5 Remove the password-complexity requirement.

UNI NSTALL COVPONENT 'file://conponent validate password';
6 Change the password to a non-complex password.

ALTER USER 'root' @I ocal host' | DENTIFIED BY ' new password';
7 Change the MySQL Native Password as well.

ALTER USER 'root' @I ocal host' | DENTIFIED W TH nysqgl nati ve_password BY
' new password’;

Adding Remote Access to the MySQL 8 Database
If your MySQL 8 database is on a separate server from Vibe, you must also do the following:

1 Add Remote access to the Database using the following commands:
CREATE USER 'root' @% | DENTI FI ED BY ' new password';
GRANT ALL PRIVILEGES ON *.* TO 'root' @% W TH GRANT OPTI ON,

ALTER USER 'root' @% | DENTI FI ED W TH nysqgl _native_password BY ' new
password' ;
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Where to Go from Here

When you complete the application instructions in this section, continue with “Learning More about
MySQL/MariaDB” on page 65.
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D Third-Party Materials

+¢ “ANTLR 3 License” on page 237

+ “Colt License Agreement” on page 238

+ “Domdj License” on page 238

+ “iCal4j License” on page 239

+ “ICU4] license (ICU4J 1.3.1 and later)” on page 239
+ “JAXEN License” on page 240

+ “Jung” on page 241

+ “ASM” on page 241

+ “Firebug Lite” on page 242

ANTLR 3 License

Copyright (c) 2003-2008, Terence Parr
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the author nor the names of its contributors may be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Colt License Agreement

Packages cern.colt*, cern.jet*, cern.clhep

Copyright (c) 1999 CERN - European Organization for Nuclear Research.

Permission to use, copy, modify, distribute and sell this software and its documentation for any
purpose is hereby granted without fee, provided that the above copyright notice appear in all
copies and that both that copyright notice and this permission notice appear in supporting
documentation. CERN makes no representations about the suitability of this software for any
purpose. It is provided “as is” without expressed or implied warranty.

Packages hep.aida.*

Written by Pavel Binko, Dino Ferrero Merlino, Wolfgang Hoschek, Tony Johnson, Andreas
Pfeiffer, and others. Check the FreeHEP home page for more info. Permission to use and/or
redistribute this work is granted under the terms of the LGPL License, with the exception that
any usage related to military applications is expressly forbidden. The software and
documentation made available under the terms of this license are provided with no warranty.

Domdj License

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

Redistribution and use of this software and associated documentation (“Software”), with or without
modification, are permitted provided that the following conditions are met:

1.

6.

1.Redistributions of source code must retain copyright statements and notices. Redistributions
must also contain a copy of this document.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

. The name “DOMA4J” must not be used to endorse or promote products derived from this

Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact dom4j-info@metastuff.com.

. The name “DOM4J” must not be used to endorse or promote products derived from this

Software without prior written permission of MetaStuff, Ltd. For written permission, please
contact domdj-info@metastuff.com.

Products derived from this Software may not be called “DOM4J” nor may “DOM4J” appear in
their names without prior written permission of MetaStuff, Ltd. DOM4 is a registered
trademark of MetaStuff, Ltd.

Due credit should be given to the DOM4J Project (http://www.dom4j.org).

THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS “AS IS”* AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN
NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
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BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

iCal4j License

Copyright (c) 2008, Ben Fortuna
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of Ben Fortuna nor the names of any other contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ICU4I license (ICU4J 1.3.1 and later)

COPYRIGHT AND PERMISSION NOTICE
Copyright (c) 1995-2001 International Business Machines Corporation and others
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and
associated documentation files (the "Software"), to deal in the Software without restriction,
including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell
copies of the Software, and to permit persons to whom the Software is furnished to do so, provided
that the above copyright notice(s) and this permission notice appear in all copies of the Software
and that both the above copyright notice(s) and this permission notice appear in supporting
documentation.
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE
COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY
SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING
FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE
OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall not be used in advertising or
otherwise to promote the sale, use or other dealings in this Software without prior written
authorization of the copyright holder.

JAXEN License

Copyright (C) 2000-2002 Bob McWhirter & James Strachan.
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions,
and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of
conditions, and the disclaimer that follows these conditions in the documentation and/or other
materials provided with the distribution.

3. The name “Jaxen” must not be used to endorse or promote products derived from this software
without prior written permission. For written permission, please contact license@jaxen.org.

4. Products derived from this software may not be called “Jaxen,” nor may “Jaxen” appear in their
name, without prior written permission from the Jaxen Project Management (pm@jaxen.org).

In addition, we request (but do not require) that you include in the end-user documentation
provided with the redistribution and/or in the software itself an acknowledgement equivalent to the
following:

“This product includes software developed by the Jaxen Project (http://www.jaxen.org).”

Alternatively, the acknowledgment may be graphical using the logos available at http://
WWWw.jaxen.org.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE Jaxen AUTHORS OR THE PROJECT
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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This software consists of voluntary contributions made by many individuals on behalf of the Jaxen
Project and was originally created by bob mcwhirter (bob@werken.com) and James Strachan
(jstrachan@apache.org). For more information on the Jaxen Project, please see http://
WWwWw.jaxen.org.

Jung

THE JUNG LICENSE
Copyright (c) 2003-2004, Regents of the University of California and the JUNG Project
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the University of California nor the names of its contributors may be used
to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

ASM

Copyright (c) 2000-2005, INRIA, France Telecom
All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.
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+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written

permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Firebug Lite

Copyright (c) 2006-2007, Joe Hewitt

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

+ Redistributions of source code must retain the above copyright notice, this list of conditions and
the following disclaimer.

+ Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution.

+ Neither the name of the copyright holders nor the names of its contributors may be used to
endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE
GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Third-Party Materials



	Vibe 4.0.5 Installation Guide
	About This Guide
	I What Is Micro Focus Vibe?
	1 Vibe Capabilities
	2 Vibe Components
	3 Vibe Configurations

	II System Requirements and Support
	4 Vibe System Requirements
	Server Hardware Requirements
	Server Operating System Requirements
	Database Server Requirements
	Directory Service Requirements
	Disk Space Requirements
	Other Requirements

	5 Vibe User Platform Support
	Browser Support
	Office Application Support
	Collaboration Client Support
	Desktop Support
	Mobile Support
	App Availability
	Browser Requirements

	File Viewer Support

	6 Environment Support
	IPV6 Support
	Clustering Support
	Virtualization Support
	Single Sign-On Support
	Linux File System Support


	III Basic Installation
	7 Basic Installation Planning Worksheet
	8 Planning a Basic Vibe Installation
	What Is a Basic Vibe Installation?
	Planning the Operating Environment of Your Vibe Server
	Vibe Server Platform
	Server Memory
	Install Location

	Planning the Default Locale and Logging Time Zone
	Default Locale
	Logfile Timezone

	Identifying Vibe’s Linux User and Group
	Planning a Secure Administrator Name and Password
	Gathering Network Information for Your Vibe Site
	Host Identification
	Port Numbers

	Planning the WebDAV Authentication Method
	Understanding WebDAV
	Choosing the WebDAV Authentication Method

	Planning the Vibe Database
	Database Type
	Database Setup Method
	Database Location
	Database Credentials
	Database Encryption Algorithm

	Planning for Outbound Email
	Outbound Email Protocol
	Outbound Email Host
	Outbound Email Authentication
	Outbound Email Send Restriction
	Outbound Email From Address

	Planning to Enable Inbound Email
	Internal Mail Host for Inbound Email
	Inbound Email Port Number
	Inbound Email IP Address
	Inbound Email Security

	Planning File Types for HTML Conversions
	Gathering Directory Services Information

	9 Obtaining the Vibe Software
	10 Installing and Running the Database Server
	MySQL (or MariaDB) on Linux
	Installing MySQL/MariaDB
	Configuring MySQL/MariaDB
	Learning More about MySQL/MariaDB

	MySQL or MariaDB on Windows
	PostgreSQL on Linux
	Installing PostgreSQL and Setting the postgres User Password
	Configuring the Socket Connection Method 
	Learning More about PostgreSQL

	PostgreSQL on Windows
	Securing PostgreSQL and Vibe Communications

	11 Installing and Setting Up a Basic Vibe Site
	Linux: Installing and Setting Up a Basic Vibe Site
	Performing Pre-Installation Tasks on Linux
	Running the Linux Vibe Installation Program
	Creating the Vibe Database
	Performing Post-Installation Tasks on Linux

	Windows: Installing and Setting Up a Basic Vibe Site
	Performing Pre-Installation Tasks on Windows
	Running the Windows Vibe Installation Program
	Creating the Vibe Database
	Performing Post-Installation Tasks on Windows


	12 Adding Users to Your Vibe Site
	Accessing Your Basic Vibe Site as the Site Administrator
	Creating a User
	Adding Vibe Users from Your LDAP Directory

	13 Updating Your Vibe License
	14 Setting Up Vibe

	IV Advanced Installation and Reconfiguration
	15 Planning an Advanced Vibe Installation
	What Is an Advanced Installation?
	Distributing Different Data Types to Different Locations
	Using Advanced Network Information Settings
	Changing the Vibe Session Timeout
	Providing a Secure Keystore File

	Configuring Requests and Connections Configuration
	Configuring Web Services
	Changing Your Lucene Index Server Configuration
	Understanding Indexing
	Changing Lucene Configuration Settings
	Running the Lucene Index Server in Its Own JVM
	Running the Lucene Index Server on a Remote Server
	Running Multiple Lucene Index Servers

	Managing RSS Feeds
	Configuring RSS Feeds
	Disabling RSS Feeds

	Configuring Presence
	Configuring Single Sign-On with Novell Access Manager
	Configuring Single Sign-On with Internet Information Services for Windows
	System Requirements
	Planning Your IIS Installation and Configuration
	Configuring the Vibe Server to Support Windows Authentication
	Running the Vibe Installation Program
	Configuring Your Browser to Allow Access to the Vibe Site
	Bypassing Windows Authentication to Configure LDAP and Perform Other Tasks
	Logging In to the Vibe Site through Windows Authentication
	Editing Files through WebDAV with Windows Authentication
	Configuring IIS to Allow Uploading of Large Files to the Vibe Site
	Configuring IIS to Load Balance in a Clustered Environment

	Configuring Mirrored Folder Resource Drivers
	File System Type
	File System Directory
	File System Access
	Mirrored Folder Setup

	Installing the Vibe Software in a Clustered Environment

	16 Performing an Advanced Vibe Installation
	17 Setting Configuration Options after Installation
	18 Advanced Vibe Installation Summary Sheet

	V Multi-Server Configurations and Clustering
	19 Creating the Vibe Database on a Remote Server
	JDK 9 or Later Required to Run manage-database Script
	Creating a MySQL/MariaDB Database
	Creating a Microsoft SQL Database
	Creating an Oracle Database
	Creating a PostgreSQL Database

	20 Installing the Lucene Index Server on a Remote Server
	Installing the Lucene Software
	Updating Your Vibe Site
	Managing a Remote Lucene Index Server
	Linux: Managing a Remote Lucene Index Server
	Windows: Managing a Remote Lucene Index Server


	21 Running Vibe on Multiple Servers
	Planning a Multi-Server Vibe Configuration
	Lucene Index Server Considerations
	Vibe File Repository Considerations
	Configuring Routing for Multicast IP on the Vibe Server

	Installing the Vibe Software on Multiple Servers
	Configuring a Web Application to Provide High Availability Functionality for Your Vibe Site
	Configuring Apache as a Load Balancer
	Configuring Linux Virtual Server as a Load Balancer

	Configuring Internet Information Services to Support Multiple Vibe Servers

	22 Running Multiple Lucene Index Servers
	Planning a High Availability Lucene Configuration
	Setting Up a High Availability Lucene Configuration
	Changing from a Local Lucene Index Server
	Changing from a Single Remote Lucene Index Server
	Expanding an Existing High Availability Lucene Configuration
	Changing Your Lucene Configuration without Vibe Site Down Time

	Testing Your Lucene High Availability Configuration
	Configuring Vibe to Log Lucene Node Activity
	Observing Lucene Node Activity

	Synchronizing a High Availability Lucene Configuration

	23 Running Multiple Database Servers

	VI Upgrade
	24 Upgrading From Novell Vibe 4.x to Micro Focus Vibe 4.0.5
	Obtaining and Preparing the Vibe 4.0.5 Software
	Understanding the Upgrade Process
	Backing Up Vibe Data
	Remote Lucene Index Server Upgrade
	Creating a New Search Index
	Upgrading an Existing Search Index

	Preserving Self-Signed Certificates During the Upgrade
	Upgrading the Vibe Software
	If the Installer Reports an Error
	Upgrading the Vibe Database from 4.x to 4.0.5
	Performing Post-Upgrade Tasks
	Re-Installing the Windows Service
	Resetting the Search Index
	Resetting the Standard Templates
	Resetting Your Definitions
	Updating the Server.xml File When Using Secure HTTP


	25 Upgrading From Novell Vibe 3.4 to Micro Focus Vibe 4.0.5
	Backing Up Vibe Data
	A Vibe Backup Is Automatically Created
	Upgrading Vibe on Linux
	Overview–The Linux Upgrade Process
	Preparing the New Target Server
	Remote Lucene Index Server Upgrade
	Upgrading the Linux Vibe Software
	Upgrading the Vibe Database from 3.4 to 4.0.4
	Performing Post-Upgrade Tasks

	Continuing the Vibe 3.4 to Vibe 4.0.5 on Linux
	Upgrading Vibe on Windows from 3.4 to 4.0.5
	Remote Lucene Index Server Upgrade
	Upgrading the Windows Vibe Software
	Upgrading the Vibe Database from 3.4 to 4
	Performing Post-Upgrade Tasks


	26 Upgrading to Novell Vibe 3.4 from Previous Versions
	27 Updating the Operating System Where Vibe Is Running

	VII Migrate
	28 Migrating Existing Micro Focus Vibe 4 Data into a New Vibe 4 System
	Using Data Migration in Conjunction with an Upgrade to Vibe 4
	Migrating Vibe on Linux
	Preparing the Target Linux Server
	Preparing the Source Linux Server
	Transferring Data from the Source Server to the Target Server
	Importing the Vibe Database to the Target Server
	Finalizing Your New Vibe 4 Site

	Migrating Vibe on Windows
	Preparing the Target Windows Server
	Preparing the Source Windows Server
	Transferring Data from the Source Server to the Target Server
	Importing the Database to the Target Server
	Finalizing Your New Vibe 4 Site


	29 Migrating from SiteScape Forum or Other Collaboration Software

	VIII Appendixes
	A Sizing and Performance Considerations
	Configuration Based on Installation Size
	Test Installation
	Small Installation
	Medium Installation
	Large Installation
	Very Large Installation

	B Memcached Caching with Micro Focus Vibe
	About Memcached
	Advantages for Using Memcached
	Hardware Requirements and Configurations

	Downloading and Installing Memcached
	Configuring Memcached
	Securing Memcached
	Configuring Memcached in the Vibe Installation Program
	Memcached Logging

	C Using MySQL 8 and Later with Vibe
	D Third-Party Materials
	ANTLR 3 License
	Colt License Agreement
	Dom4j License
	iCal4j License
	ICU4J license (ICU4J 1.3.1 and later)
	JAXEN License
	Jung
	ASM
	Firebug Lite



